Date:
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TraceCompass-2.3.0
2017/03/23

Content

Integration

Junit Tests

TMF - Project View

TMF - EventsEditor

TMF - BookmarksView

TMF - Filters View

TMF - Colors View

TMF - Histogram View

TMF - Sequence Diagram
TMF - Statistics View

TMF - Time Chart View

TMF - Custom Parsers

TMF - State System Explorer
TMF - Call Stack View

TMF - Remote Fetching
LTTng 2.0 - Control Flow View
LTTng 2.0 - Resources View
LTTng 2.0 - Control View
GDB Tracing

Tracing RCP

LTTng 2.0 - Memory Analysis

2.3.0-TraceCompassTestCases - Summary

To do

Pass
23
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Fail

Total
23
18

148
25

17
12
6
50
37
18
26
28
14
24
52
52
40
131
25
32
22

Comments

With comments
With comments
With comments
With comments
With comments
With comments
With comments
With comments

With comments

With comments

With comments
With comments
With comments
With comments
With comments
With comments

SWTBot
0

18

73
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22
23
24
25
26
27
28
29
30

LTTng 2.0 - CPU Analysis
Trace Synchronization
XML analysis

Network Trace analysis
Critical path

LTTng 2.0 - I/O Analysis
LTTng 2.0 - VM Analysis
LAMI

Flame Graph

Bug Reports

2.3.0-TraceCompassTestCases - Summary

Total:

0 23 25
0 13 13
0 39 40
0 11 11
0 44 45
0 18 21
0 38 39
0 17 18
0 19 19
1 1019 11 1012
Open Fixed Total
13 1 14
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With comments
With comments

With comments
With comments

With comments

With comments
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Target:

Section
Integration

Step Test Case

1
1.1

1.2
1.3
1.4
1.5

1.6
2

2.1

22
2.3
2.4
2.5

2.6

w

3.1

3.2
33
3.4
35

3.6

H

4.1

4.2
43
4.4
4.5

4.6
5

5.1

5.2

5.3

Verify C/C++ EPP Package RC1

Download EPP Package
Version of Tracing Features

TMF presence
LTTng presence

GDB Tracepoint Analysis presence

Neon Update Site
Verify C/C++ EPP Package RC2

Download EPP Package
Version of Tracing Features

TMF presence
LTTng presence

GDB Tracepoint Analysis presence

Neon Update Site

Verify C/C++ EPP Package RC3
Download EPP Package

Version of Tracing Features

TMF presence
LTTng presence
GDB Tracepoint Analysis presence

Neon Update Site
Verify C/C++ EPP Package RC4
Download EPP Package

Version of Tracing Features

TMF presence
LTTng presence
GDB Tracepoint Analysis presence

Neon Update Site
Verify Update Site

Neon Update Site

Trace Compass Update Site

Upgrade using Neon Update Site

2.3.0-TraceCompassTestCases - Integration

Action

Download, extract and start EPP package

Go to Help -> About Eclipse -> Installion Details
Open Tracing perspective

Open LTTng Kernel perspective

Open GDB Trace perspective

Go to Help -> Install New Software... -> Update site "Neon - http://download.

eclipse.org/staging/neon/"

Download, extract and start EPP package. Check the mailing list for the packe

https://dev.eclipse.org/mailman/listinfo/epp-dev

Go to Help -> About Eclipse -> Installation Details
Open Tracing perspective

Open LTTng Kernel perspective

Open GDB Trace perspective

Go to Help -> Install New Software... -> Use the testing update site "Neon -

http://download.eclipse.org/staging/neon/"

Download, extract and start EPP package

Go to Help -> About Eclipse -> Installation Details
Open Tracing perspective

Open LTTng Kernel perspective

Open GDB Trace perspective

Go to Help -> Install New Software... -> Use the testing update site "Neon -

http://download.eclipse.org/staging/neon/"

Download, extract and start EPP package

Go to Help -> About Eclipse -> Installation Details
Open Tracing perspective

Open LTTng Kernel perspective

Open GDB Trace perspective

Go to Help -> Install New Software... -> Use the testing update site "Neon -

http://download.eclipse.org/staging/neon/"

Download Eclipse for Committers and install LTTng Kernel, LTTng UST,

GDBTrace and PCAP Network Analysis from main simrel testing Update site

"Neon - http://download.eclipse.org/staging/neon/"

Download Eclipse for Committers and install LTTng Kernel, LTTng Control,
LTTng UST, GDBTrace and PCAP Network Analysis from the Linux Tools

Update site
http://download.eclipse.org/tracecompass/neon/milestones

Download Eclipse for Committers from Neon SR1 and install LTTng, LTTng

Kernel, GDBTrace and PCAP Network Analysis from main simrel Update
site.

http://download.eclipse.org/releases/neon

Try to update the installation using the testing simrel update site.

Neon - http://download.eclipse.org/staging/neon/

EPP Package starts

Verify that all tracing features and plug-ins are present and have the
correct version (TMF, LTTng, CTF, GDBTrace)

Tracing perspective opens
LTTng Kernel perspective

GDB Tracepoint analysis perspective
Verify that all LTTng Kernel, LTTng UST and GDB Trace are available

EPP Package starts

Verify that all tracing features and plug-ins are present and have the
correct version (TMF, LTTng, CTF, GDBTrace)

Tracing perspective opens
LTTng Kernel perspective

GDB Tracepoint analysis perspective
Verify that all LTTng Kernel, LTTng UST and GDB Trace are available

EPP Package starts

Verify that all tracing features and plug-ins are present and have the
correct version (TMF, LTTng, CTF, GDBTrace)

Tracing perspective opens

LTTng Kernel perspective

GDB Tracepoint analysis perspective

Verify that all LTTng Kernel, LTTng UST and GDB Trace are available

EPP Package starts

Verify that all tracing features and plug-ins are present and have the
correct version (TMF, LTTng Control, LTTng Kernel, LTTng UST,
CTF, GDBTrace)

Tracing perspective opens

LTTng Kernel perspective

GDB Tracepoint analysis perspective

Verify that all LTTng Kernel, LTTng UST and GDB Trace are available

Verify that installation was successful

Verify that installation was successful

Verify that installation was successful

Manual

Manual
Manual
Manual
Manual

Manual

Manual

Manual
Manual
Manual
Manual

Manual

Manual

Manual
Manual
Manual
Manual

Manual

Manual

Manual
Manual
Manual
Manual

Manual

Manual

Manual

Manual

To Do

N/A

N/A
N/A
N/A
N/A

N/A

Pass

Pass
Pass
Pass
Pass

Pass

Pass

Pass
Pass
Pass
Pass

Pass

Pass

Pass
Pass
Pass
Pass

Pass

Pass

Pass

Pass

Comment

Comment

Not all tests were done this time for this milestone

Not all tests were done this time for this milestone




2.3.0-TraceCompassTestCases - Integration

Download Eclipse for Committers from Neon SR1 and install LTTng, LTTng
Kernel, LTTng UST, GDBTrace and PCAP Network Analysis from the Trace
Compass release Update site.
Upgrade using Trace Compass Update  http://download.eclipse.org/tracecompass/releases/2.1.0/repository
Site Try to update the installation using the Trace Compass update site http:
/ldownload.eclipse.org/tracecompass/neon/milestones Verify that installation was successful Manual

Download Eclipse previous C/C++ EPP package. Try to upgrade using both
update sites:
(TODO find correct job: https://hudson.eclipse.org/packaging/job/luna.epp-
tycho-build/128/artifact/org.eclipse.epp.packages/archive/repository/)
"Mars - http://download.eclipse.org/releases/maintenance”
Upragde from previous EPP
The information about the update sites to use is usually posted on epp-dev  Verify that installation was successful Manual

Verify Update Site Release outside release train
Download Eclipse standard and install LTTng Kernel, LTTng Control, LTTng
UST, GDBTrace and PCAP Network Analysis from main

Trace Compass update site Update site: http://download.eclipse.org/tracecompass/stable/repository/ Verify that installation was successful Manual N/A On train
Download Eclipse standard from Luna SRO and install LTTng, LTTng Kernel,
LTTng UST, GDBTrace and PCAP Network Analysis from the Luna SRO
Linux Tools Update site.

. http://download.eclipse.org/linuxtools/update-3.1
Upgrade using Trace Compass Try to update the installation using the Trace Compass update site.
update site http://download.eclipse.org/tracecompass/stable/repository/ Verify that installation was successful Manual N/A




Section
Junit Tests
Ubuntu 12.04 64 bit and on

Target: Hudson

Step Test Case

1
1.1
1.2
1.3
1.4
1.5
1.6

1.7

1.8

1.9

1.10
1.1

1.12

1.13

1.14

1.15

1.16

1.17

1.18

Junit Test Cases

CTF Core Tests Plug-in

CTF Parser Tests Plug-in

State System Core Tests Plug-in
TMF Core Tests Plug-in

TMF Ul Tests Plug-in

TMF Ul SWTBot Tests Plug-in

CTF Support for TMF SWTBot
Tests Plug-in

TMF Xml Analysis Core Tests
Plug-in

TMF Xml Analysis Ul Tests Plug-in

LTTng Control Core Tests Plug-in
LTTng Control Ul Tests Plug-in
LTTng Kernel Analysis Core Tests
Plug-in

LTTng Kernel Analysis Ul Tests
Plug-in

LTTng Kernel Ul SWTBot Tests
Plug-in

LTTng Userspace Tracer Analysis
Core Test Plug-in

LTTng Userspace Tracer Analysis
Ul Test Plug-in

GDB Tracepoint Analysis Core
Tests Plug-in

GDB Tracepoint Analysis Ul Tests
Plug-in

Pass

2.3.0-TraceCompassTestCases - JUnits

Fail

Action

Run manually or with Jenkins
Run manually or with Jenkins
Run manually or with Jenkins
Run manually or with Jenkins
Run manually or with Jenkins
Run manually or with Jenkins

Run manually or with Jenkins
Run manually or with Jenkins
Run manually or with Jenkins

Run manually or with Jenkins
Run manually or with Jenkins

Run manually or with Jenkins
Run manually or with Jenkins
Run manually or with Jenkins
Run manually or with Jenkins
Run manually or with Jenkins
Run manually or with Jenkins

Run manually or with Jenkins

Verification

All test cases passed
All test cases passed
All test cases passed
All test cases passed
All test cases passed
All test cases passed

All test cases passed
All test cases passed
All test cases passed

All test cases passed
All test cases passed

All test cases passed
All test cases passed
All test cases passed
All test cases passed
All test cases passed
All test cases passed

All test cases passed

To Do

Comment

[ 0 o

Pass
Pass
Pass
Pass
Pass
Pass

Pass

Pass

Pass

Pass
Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Comment



Section
TMF - Project View

Target: Ubuntu 16.04 64 bit

Step

1.1
1.2

2.1
2.2
2.3

31
3.2

3.10

3.1

3.12

Test Case
Preparation
Step 1

Step 2

Project Creation
New Project Wizard
Create project
Project structure

Traces Folder

Preparation
Traces Folder menu
Trace Import Wizard

Import single custom text trace
(link to workspace)

Import Single custom XML trace
(link to workspace)

Import LTTng Kernel CTF trace
(link to workspace)

Rename + copy import

Overwrite + copy import

Skip

Default overwrite

Import unrecognized
Import unrecognized (ignore)
Preparation

Import CTF trace by selection
metadata file only

2.3.0-TraceCompassTestCases - ProjectView

Pass
148

Action

Open LTTng Kernel perspective
Open Navigator View (used for independent verification)

Open New Tracing Project Wizard
Specify a project name and finish
Open the new Tracing project

1) Download traces.zip (if necessary) and unzip into a local
directory ${local}

2) Import Custom Text and XML parsers
(ExampleCustomXmlParser.xml, ExampleCustomTxtParser.
xml) from directory traces/customParsers into your
workspace from the Manage Custom Parsers dialog.

Select the Traces folder and open its context menu
Select Import

1) Browse to directory ${local}/traces/import/

2) Select trace ExampleCustomTxt.log

3) Keep <Auto Detection>, Select "Import unrecognized
traces", unselect "Overwrite existing without warning" and
select "Create Links to workspace" and

4) press Finish

redo 3.1-3.3 but this time select ExampleCustomXml.xml

redo 3.1-3.3 but this time select directory kernel-overlap-
testing/

redo 3.3, 3.4, 3.5. However, Unselect "Create Links to
workspace"

When dialog box appear select Rename

redo 3.3, 3.4, 3.5. However, Unselect "Create Links to
workspace"

When dialog box appear select Overwrite

redo 3.3, 3.4, 3.5. However, Unselect "Create Links to
workspace"

When dialog box appear select Skip

redo 3.3, 3.4, 3.5. However, Unselect "Create Links to
workspace" and select "Overwrite existing without warning"

1) Open Import wizard (see 3.1-3.2)

2) Browse to directory ${local}/traces/import

3) Select trace unrecognized.log

4) Keep <Auto Detection>, Select "Import unrecognized
traces", unselect "Overwrite existing without warning" and
select "Create Links to workspace" and

5) press Finish

redo 3.10, however unselect "Import unrecognized traces"

Delete all traces in project - Right mouse click on Traces
folder and select "Clear"

Redo 3.5, However only select metadata file instead of
directory trace

Fail

Verification

LTTng perspective opens with correct views
Navigator View opens

Tracing Project Wizard opens
Tracing project appears in Project Explorer/Navigator
Project contains Experiments and Traces folders

Correct menu opens (Import, Refresh)
Trace Import Wizard appears

Imported trace appear in Traces Folder and the Trace
Type TmFf Generic is set. Make sure trace can be opened

Imported trace appear in Traces Folder and the Trace
Type "Custom XML log" is set. Make sure that trace can
be opened

Imported trace appear in Traces Folder and the Trace
Type "LTTng Kernel" is set. Make sure that trace can be
opened

Traces are imported with new name that has a suffix (2)
at the end. Make sure that imported traces are copied to
the project.

Existing traces are deleted and new traces are imported.
Make sure that imported traces are copied to the
project and can be opened

Make sure that no new trace is imported

Make sure that no dialog box appears (for renaming,
overwriting, skipping) and existing traces are
overwritten). Make sure trace can be opened

unrecognized.log is imported with trace type unknown.
The default text file icon is displayed. The trace, when
opened, is displayed in the text editor.

unrecognized.log is not imported
Imported trace appear in Traces Folder and the Trace

Type "LTTng Kernel" is set. Make sure that trace can be
opened

Type
73

SWTBot
SWTBot

SWTBot
SWTBot
SWTBot

SWTBot
SWTBot
SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

To Do

Pass
Pass

Pass
Pass
Pass

Pass
Pass
Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Comment
11

Comment



3.13

3.14

3.15

3.16

3.17

3.18

3.19

Preparation

Recursive import with auto-
detection (Rename All)

Preparation

Recursive import with auto-
detection (Overwrite All)

Preparation

Recursive import with auto-
detection (Skip All)

Preparation

Recursive import with auto-

detection (test rename, overwrite

and skip)
Preparation

Recursive import with specific
trace type 1 (Skip All)

Preparation

Recursive import with specific
trace type 2 (Skip All)

Preparation

Recursive import with specific
trace type 3 (Skip All)

Preparation

2.3.0-TraceCompassTestCases - ProjectView

Delete all traces in project

1) Open Import wizard (see 3.1-3.2)

2) Browse to directory ${local}/traces/import

3) select directory import

4) Keep <Auto Detection>, Select "Import unrecognized
traces", unselect "Overwrite existing without warning", select
"Create Links to workspace" and unselect "Preserve Folder
Structure”

5) press Finish

6) When dialog appears select "Rename All"

Delete all traces in project

1) Open Import wizard (see 3.1-3.2)

2) Browse to directory ${local}/traces/import/

3) select directory import

4) Keep <Auto Detection>, Select "Import unrecognized
traces”, unselect "Overwrite existing without warning", select
"Create Links to workspace" and unselect "Preserve Folder
Structure”

5) press Finish

6) When dialog appears select Overwrite All"

Delete all traces in project

1) Open Import wizard (see 3.1-3.2)

2) Browse to directory ${local}/traces/import/

3) select directory import

4) Keep <Auto Detection>, Select "Import unrecognized
traces", unselect "Overwrite existing without warning" and
select "Create Links to workspace" and uncheck "preserve
folder structure"

5) press Finish

6) When dialog appears select Skip All"

Delete all traces in project

1) Open Import wizard (see 3.1-3.2)

2) Browse to directory ${local}/traces/import/

3) select directory import

4) Keep <Auto Detection>, Select "Import unrecognized
traces”, unselect "Overwrite existing without warning", select
"Create Links to workspace" and unselect "Preserve Folder
Structure”

5) press Finish

6) When dialog appears select "Rename”

7) When dialog appears select "Overwrite"

8) When dialog appears select "Skip"

Delete all traces in project

1) Open Import wizard

2) Browse to directory ${local}/traces/import/

3) select directory import

4) Select trace type "Generic CTF Trace", Select "Import
unrecognized traces", unselect "Overwrite existing without
warning", select "Create Links to workspace" and unselect
"Preserve Folder Structure"and

5) press Finish

6) When dialog appears select Skip All"

Delete all traces in project

1) Open Import wizard (see 3.1-3.2)

2) Browse to directory ${local}/traces/import/

3) select directory import

4) Select trace type "LTTng Kernel Trace", Select "Import
unrecognized traces", unselect "Overwrite existing without
warning", select "Create Links to workspace" and unselect
"Preserve Folder Structure"

5) press Finish

6) When dialog appears select Skip All"

Delete all traces in project

1) Open Import wizard

2) Browse to directory ${local}/traces/import/

3) select directory import

4) Select trace type "LTTng UST Trace", Select "Import
unrecognized traces", unselect "Overwrite existing without
warning", select "Create Links to workspace" and unselect
"Preserve Folder Structure"

5) press Finish

6) When dialog appears select Skip All"

Delete all traces in project

All Traces are imported with respective trace type set.
Traces with name clashes are imported with suffix (2). 1
trace (unrecognized.log) is imported with trace type
unknown. Make sure that traces can be opened which
have a trace type set. The unknown trace type should
open with the text editor.

All Traces are imported with respective trace type set.
Traces with name clashes are overwritten . 1 trace
(unrecognized.log) is imported with trace type unknown.
Make sure that traces can be opened which have a trace
type set. The unknown trace type should open with the
text editor.

All Traces are imported with respective trace type set.
Traces with name clashes are not imported. 1 trace
(unrecognized.log) is imported with trace type unknown.
The unknown trace type should open with the text
editor.

All Traces are imported with respective trace type set.
Traces with name clashes are either renamed,
overwritten or skipped as per dialog action. Make sure
that traces can be opened which have trace type set.
The unknown trace type should open with the text
editor.

After selecting trace type, verify that button "Import
unrecognized traces" is disabled.

4 CTF traces are imported with trace type "Generic CTF
Trace" . Make sure that these traces can be opened

After selecting trace type, verify that button "Import
unrecognized traces" is disabled.

One LTTng Kernel trace is imported with trace type
"LTTng Kernel Trace". Make sure that this trace can be
opened.

After selecting trace type, verify that button "Import
unrecognized traces" is disabled.

3 LTTng UST traces are imported with trace type "LTTng
UST Trace". Make sure that these traces can be opened.

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot



3.20

3.21

3.22

3.23

3.24

3.25

3.26

3.27
3.28

3.29

3.30

3.31

Recursive import with specific
trace type 4 (Skip All)

Preparation

Import wizard from workbench
menu with project selected

Import wizard from workbench
menu with no project selected

Preparation
Drag and Drop from other Tracing

Drag and Drop from non-Tracing

Drag and Drop from external

Drag and Drop of trace with
existing name

Drag and Drop of trace with
existing name (2nd time)

Import destination
Preparation

Recursive import with preserved
folder structure

Recursive import with preserved
folder structure (Skip All)

Recursive import with preserved
folder structure (Rename All)

Preparation

2.3.0-TraceCompassTestCases - ProjectView

1) Open Import wizard (see 3.1-3.2)

2) Browse to directory ${local}/traces/import/

3) select directory import

4) Select trace type "Tmf Generic", Select "Import
unrecognized traces", unselect "Overwrite existing without
warning", select "Create Links to workspace" and unselect
"Preserve Folder Structure”

5) press Finish

6) When dialog appears select Skip All"

Delete all traces in project

1) Select project "Test" in Project Explorer view

2) Open import wizard from menu File > Import... > Tracing >
Trace Import

3) Browse to directory ${local}/traces/import/

4) Select trace ExampleCustomTxt.log

5) Keep <Auto Detection>, select "Create Links to workspace"
and

6) press Finish

1) Clear selection in Project Explorer view

2) Open import wizard from menu File > Import... > Tracing >
Trace Import

3) Browse to directory ${local}/traces/import/

4) Select trace ExampleCustomTxt.log

5) Keep <Auto Detection>, select "Create Links to workspace"
and

6) press Finish

Delete all traces in project

D&D a few LTTng traces from another Tracing project's Traces
folder

D&D a few files from a non-Tracing project

D&D a few files from an external file manager

1) D&D a trace with name of an existing trace into traces
folder

2) Confirm the renaming of traces

Redo test 3.26 with the same trace and same destination
folder

Open Import wizard
Delete all traces in project

1) Open Import wizard (see 3.1-3.2)

2) Browse to directory ${local}/traces/import/

3) select directory import

4) Select trace type "Tmf Generic", unselect "Overwrite
existing without warning", select "Create Links to workspace"
and select "Preserve Folder Structure"

5) press Finish

1) Open Import wizard (see 3.1-3.2)

2) Browse to directory ${local}/traces/import/

3) select directory import

4) Select trace type "Tmf Generic", unselect "Overwrite
existing without warning", select "Create Links to workspace"
and select "Preserve Folder Structure"

5) press Finish

6) When dialog appears select "Skip All"

1) Open Import wizard (see 3.1-3.2)

2) Browse to directory ${local}/traces/import/

3) select directory import

4) Select trace type "Tmf Generic", unselect "Overwrite
existing without warning", select "Create Links to workspace"
and select "Preserve Folder Structure"

5) press Finish

6) When dialog appears select "Rename All"

Delete all traces in project

All text files in directories are imported as trace and
trace type "Tmf Generic" is set. Note that trace type
validation only checks for file exists and that file is not a
directory. Make sure that these traces can be opened.
However traces with wrong trace type won't show any

events in the table. SWTBot

Verify that trace is imported to "Test" project and can be

opened. SWTBot

Verify that trace is imported to default "Tracing" project

and can be opened. SWTBot

Selected traces are added to the Traces folder with
proper icon. Trace can be opened.

Selected traces are added to the Traces folder with
default icon. Files can be opened wit the default editor.

Manual

Manual

Selected traces are added to the Traces folder with
default icon. For actual traces Trace type is detected
automatically. Trace can be opened, For non traces the
files are added with default icon and they can be opened

with the default editor. Manual

Verify that trace is added into the traces folder with the
trace name of the orignal trace plus a suffix 2

Verify that trace is added into the traces folder with the
trace name of the orignal trace plus a suffix 3

Verify that "Into Folder" text box cannot be updated

Manual

Manual
Manual

All Traces are imported with respective trace type set.
The folder "clashes" is imported with its traces inside.
Make sure that traces can be opened which have a trace

type set. SWTBot

The wizard should finish quickly as no trace will be
imported. Make sure that traces can be opened which

have a trace type set. SWTBot

All Traces are imported with respective trace type set
with suffix (2). The Folder "clashes" is imported with its
traces inside. Make sure that traces can be opened
which have a trace type set.

SWTBot



3.32

3.33

3.34

3.35

3.36

3.37

3.38

3.39

3.40

3.4

Delete with mixed selection of
traces and folders

Delete multiple folders

Clear single Traces folder

Clear multiple Traces folder

Preparation

Import from zip archive, preserve
folder structure

Preparation

Import from zip archive, no
preserve folder structure

Preparation

Import from zip archive specific
traces

Preparation

Import from tar.gz archive,
preserve folder structure

Preparation

Import from tar.gz archive, no
preserve folder structure

Preparation

2.3.0-TraceCompassTestCases - ProjectView

1) Create two trace folders under the "Traces" folder

2) Import 2 traces under each folder

3) Open all 4 traces

4) Select one trace in the first folder and the second folder in
the Project Explorer view

5) Right-click, Delete. Click Yes.

1) Create 2 trace folders under the "Traces" folder

2) Import a trace under each folder

3) Open both traces

4) Select both folders in the Project Explorer view

5) Right-click, Delete. Click Yes

1) Import 2 traces from different folders preserving folder
structure

2 Open both traces.

3 Select the Traces folder

4) Right-click, Clear. Click Yes.

1) Import 2 traces to different projects

2 Open both traces.

3 Select both Traces folders

4) Right-click, Clear. Click Yes.

Delete all traces in project

1) Open Import wizard (see 3.1-3.2)

2) Select archive file: traces.zip

3) select directory the root directory

4) Select trace type "Automatic”, unselect "Overwrite existing
without warning" and select "Preserve Folder Structure"
5) press Finish

Delete all traces in project

1) Open Import wizard (see 3.1-3.2)

2) Select archive file: traces.zip

3) select directory the root directory

4) Select trace type "Automatic”, unselect "Overwrite existing
without warning" and unselect "Preserve Folder Structure"
5) press Finish

6) Select Rename All when dialog comes up.

Delete all traces in project

1) Open Import wizard (see 3.1-3.2)

2) Select archive file: traces.zip

3) select file "z-clashes/ExampleCustomTxt.txt" and folder
"kernel-overlap-testing"

4) Select trace type "Automatic”, and select "Preserve Folder
Structure”

5) press Finish

Delete all traces in project

1) Open Import wizard (see 3.1-3.2)

2) Select archive file: traces.tar.gz

3) select directory the root directory

4) Select trace type "Automatic”, unselect "Overwrite existing
without warning" and select "Preserve Folder Structure"

5) press Finish

Delete all traces in project

1) Open Import wizard (see 3.1-3.2)

2) Select archive file: traces.tar.gz

3) select directory the root directory

4) Select trace type "Automatic”, unselect "Overwrite existing
without warning" and unselect "Preserve Folder Structure”
5) press Finish

6) Select Rename All when dialog comes up.

Delete all traces in project

1) Open Import wizard (see 3.1-3.2)

2) Select archive file: traces.tar.gz

3) select file "z-clashes/ExampleCustomTxt.txt" and folder
"kernel-overlap-testing"

4) Select trace type "Automatic”, and select "Preserve Folder
Structure”

Import from tar.gz archive specific 5) press Finish

traces

Trace

A dialog should ask the user to confirm deletion of the
selected elements. Clicking OK should remove all that
was selected. The editor of the 3 deleted traces should
be closed automatically with one remaining editor
opened.

A dialog should ask the user to confirm deletion of the
selected elements. Clicking OK should remove all that
was selected. The editor of both traces should be closed
automatically.

A dialog should ask the user to confirm clearing of the
folder. Clicking Yes should remove everything under the
selected folder and close the traces

A dialog should ask the user to confirm clearing of the
folders. Clicking Yes should remove everything under
the selected folders and close the traces

All the files get imported under their respective folders.
The CTF traces can be opened (kernel-overlap-testing,
simple_server...)

All traces are imported with trace type set. The traces
from folder "clashes" are renamed with suffix (2). Make
sure that the traces can be opened

The specified traces are imported with trace type set.
Make sure that the traces can be opened.

All the files get imported under their respective folders.
The CTF traces can be opened (kernel-overlap-testing,
simple_server...)

All traces are imported with trace type set. The traces
from folder "clashes" are renamed with suffix (2). Make
sure that the traces can be opened

The specified traces are imported with trace type set.
Make sure that the traces can be opened.
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4.1
4.2
4.3
4.4
4.5
4.6
4.7

4.8

4.9

7.3

7.4

7.5

7.6

7.7

7.8

7.9

7.10

711

8.1
8.2
8.3
8.4

8.5

Trace menu Select an LTTng trace and open its context menu Correct menu opens (Open , Copy, Rename, ...) SWTBot
Open trace Select the Open menu Trace is opened and views are populated SWTBot
Copy trace Select the Copy menu and provide a new name. Open. Trace is replicated under the new name SWTBot
Rename trace Select the Rename menu and provide a new name. Reopen. Trace is renamed. The trace editor is closed. SWTBot
Delete trace Select the Delete menu and confirm deletion Trace is deleted. The trace editor is closed. SWTBot
Open Trace (Accelerator) Select trace and press Enter Trace is opened SWTBot Numpad-enter doesn't work
Delete Trace (Accelerator) Select trace and press Delete and confirm deletion Trace is deleted. The trace editor is closed. SWTBot
Open Trace (double click) Double-click a trace Trace is opened SWTBot
Open Trace (already open) Open two traces. Open the first trace again. The first trace editor is simply brought to front. SWTBot
Experiments Folder
Correct menu opens (New, Import XML Analysis,
Experiments menu Select the Experiments folder and open it context menu Refresh) Manual
Create experiment Select the New menu and provide experiment name Experiment appears under folder, no traces yet Manual
Experiment
Experiment menu Select an experiment and open its context menu Correct menu opens (Select, Open, Copy, Rename, ...) Manual
Select Traces dialog Select the Select Traces menu Select Traces dialog is open and populated w/ traces Manual
Select traces Select a few LTTng traces and finish Selected traces are imported in the experiment Manual
Open experiment Select the Open menu Experiment is opened and views are populated Manual
Failed in 3.0, 3.1, 3.2, TC 0.1, 2.0 When copying a renamed experiment the orignal named experiment is
https://bugs.eclipse. 1ow_bug.cgi?id=436888
Copy experiment Select the Copy menu and provide a new name. Open. Experiment is replicated under the new name Manual
Rename experiment Select the Rename menu and provide a new name. Open. Experiment is renamed Manual
Delete experiment Select the Delete menu and confirm deletion Experiment is deleted Manual
Open Experiment (Accelerator) Select an Experiment and press Enter Experiment is opened Manual Numpad-enter doesn't work
Delete Experiment (Accelerator)  Select an Experiment and press Delete and confirm deletion  Experiment is deleted Manual
Delete Experiment (open Open an experiment, select expereiment and press Delete and
experiment) confirm deletion Experiment is closed and deleted Manual
Select Traces while Experiment is Experiment is closed and selected traces is imported to
open Open an experiment and select an additional trace (see 6.3) the experiment Manual
Experiment Traces
Trace menu Select an LTTng trace and open its context menu Correct menu opens w/ Copy disabled + Remove Manual
Open trace Select the Open menu Trace is opened and views are populated Manual
Open Experiment, select the Remove menu and confirm
Remove trace removal Experiment is closed, trace is removed from experiment ~ Manual
Selected traces are added to the experiment with
Drag and Drop from Traces D&D a few LTTng traces from the Traces directory proper icon. Experiment can be opened. Manual
D&D a few LTTng traces from another Tracing project's Traces Selected traces are added to the experiment + Traces
Drag and Drop from other Tracing folder with proper icon. Experiment can be opened. Manual
Selected traces are added to the experiment + Traces
Drag and Drop from non-Tracing  D&D a few traces from a non-Tracing project with proper icon. Experiment can be opened. Manual
Selected traces are added to the experiment + Traces
Drag and Drop from external D&D a few traces from an external file manager with proper icon. Experiment can be opened. Manual
Selected traces are added to the experiment + Traces
Drag and Drop from external (non- with proper icon (system icon). Experiment cannot be
traces) D&D a few files (non-traces) from an external file manager opened. Manual
1) D&D a trace with name of an existing trace into experiment Verify that trace is added into the traces folder and
Drag and Drop of trace with folder experiment folder with the trace name of the orignal
existing name 2) Confirm the renaming of traces trace plus a suffix 2 Manual
Verify that trace is added into the traces folder and
Drag and Drop of trace with experiemnt folder with the trace name of the orignal
existing name (2nd time) Redo test 7.8 with the same trace and same destination folder trace plus a suffix 3 Manual
Drag and Drop of trace while Open an experiment and D&D a trace from the Traces Experiment is closed and selected traces is imported to
Experiment is open directory (see 7.4) the experiment Manual
Propagation
Preparation Copy experiment Selected experiment is replicated Manual
Rename propagation In Traces folder, rename a trace showing in both experiments New name is propagated to both experiments Manual
Delete propagation In Traces folder, delete a trace showing in both experiments  Selected trace is removed from both experiments Manual
Propagate trace type 1 Add a trace to 2 experiments. Change its type from Traces All occurences of that trace are updated Manual
Add a trace to 2 experiments. Change its type from one of the
Propagate trace type 2 experiments All occurences of that trace are updated Manual

2.3.0-TraceCompassTestCases - ProjectView

10




9.1

9.2

9.3

9.4

10

10.1
10.2
10.3

1

11.1

11.2

1.3

11.4

11.5

11.6

1.7

11.8

11.9

11.10

1.1

11.12

11.13

12

121

Properties View Synchronization

Trace synchronization

Other trace nodes synchronization
Check trace properties

Check trace properties -
experiment

Trace Type Selection
Preparation

Trace properties
Trace filtering

Supplementary Files

Preparation

Create Supplementary File (State
History File) from trace

Trace Context sensitive menu
Delete Supplementary Files Action

Select and delete State History
File

Create Supplementary File (State
History File) from experiment

Delete Supplementary Files Action

Select and delete State History
File

Select and delete multiple State
History files

Delete Trace

Delete Experiment

Delete Experiment Trace
Delete Supplementary Files Action
while trace is open

Link With Editor

Preparation

2.3.0-TraceCompassTestCases - ProjectView

Select a trace under a Traces folder in Project Explorer view.

Repeat with trace under an Experiment.

Select a Traces folder, Experiments folder, or an experiment in

Project Explorer view.

Open an LTTng kernel trace, click on the trace, check the new

properties view.

Open an experiment which contains LTTng kernel traces, click

on the experiment, check the new properties view.

Import an file with unrecognized trace type (${local}
/Jtraces/import/unrecognized.log)

Select the trace and open the Properties View
Select an experiment and open Select Traces dialog

1) In Project Explorer remove filter For hidden resources
(Coolbar menu > Customize View... > unselect '.* resources)
2) Create Experiment with 2 LTTng CTF traces in it

Open a LTTng CTF trace and wait for indexing to finish

a) Select trace under Folder Traces and click right mouse
button

b) Redo test: Select trace under Experiment Folder

) Redo test: Select Experiment

1) Select trace and click right mouse button

2) Select 'Delete Supplementary Files..."

Select <trace name>/StateHistory.ht file and click on 'Ok’

Open Experiment with 2 LTTng CTF traces

1) Select Experiment and click right mouse button
2) Select 'Delete Supplementary Files..."

Select one history file (<trace name>/StateHistory.ht) and click
oK'

on 'Ol

1) Redo 11.2and 11.6
2) Select both history files and click on 'Ok’

a) Redo 11.2 to create Supplementary File
b) Delete trace

a) redo 11.6 to create experiment and Supplementary File
b) delete Experiment

a) redo 11.6 to create experiment and Supplementary File
b) remove traces under Experiment

Open trace and then redo 11.4

1) In Project Explorer make sure that "Link with Editor" button

is selected
2) Open multiple traces and experiments

The Properties view is updated with the selected trace's
"Resource properties” Property and Value. The "Info >
type" property shows the selected trace category and
trace type name.

The Properties view is updated with the selected item's
Property and Value. For Experiment verify the "type"
property is set.

The "Trace properties" should be populated

The "Trace properties" should be populated for every
subtrace

Imported trace appear in Traces with default icon. File is
can be opened by default Editor (either Eclipse text or
system editor depending on plug-ins installed)

Selected trace type is blank

Untyped trace does not appear in list

Verify that .tracing directory is shown under the project

Verify that StateHistory.ht is created under .
tracing/<trace name>/.

Verify that menu item 'Delete Supplementary Files..." is
shown in the context-sensitve menu

Verify that confirmation dialog box is opend and <trace
name>/StateHistory.ht is listed

Make sure that file .tracing/<trace name>/StateHistory.
ht is deleted from the project explorer view

Verify that two StateHistory.ht files are created under .
tracing/<trace1 name>/ and ./tracing/<trace2 name>/
respectively. Also verify, that supplementatry folder for
the experiment ./tracing/<exp name>_exp is created.

Verify that confirmation dialog box is opend and shows
3 root entries:

<exp name>, <trace1 name> and <trace2 name>, with
their respective supplementary files below

Make sure that the selected file .tracing/<trace
name>/StateHistory.ht is deleted from the project
explorer view

Make sure that both history files are deleted under .
tracing/<trace1 name>/ and .tracing/<trace2 name>/
respectively

Verify that supplementary directory .tracing/<trace
name>/ is deleted.

Verify that supplementary File StateHistory.ht .
tracing/<trace1 name>/ and ./tracing/<trace2 name>/
are NOT deleted. Also verify that the supplementary
folder for the experiment ./tracing/exp_name_exp is
deleted.

Verify that supplementary File StateHistory.ht .
tracing/<trace1 name>/ and ./tracing/<trace2 name>/
are NOT deleted

Verify that trace is closed and supplementary files are
deleted

1"

Manual

Manual

Manual

Manual

SWTBot
Manual
SWTBot

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

N/A

New feature ... not implemented yet

SWTBot tries invalid type for a given valid trace, same thing.



12.2

123

12.4

12.5

12.6
13

131

13.2

13.3

13.4

13.5

13.7

13.8

13.9

13.10

13.11

13.12

13.13

13.14

13.15

13.16
14

Select trace/experiment in Editors
area

Select opened traces/experiments
in Project Explorer

Preparation

Select trace/experiment in Editors
area

Select opened traces/experiments
in Project Explorer

Trace Package Export Wizard

Preparation

Open the trace package export
wizard

Select Traces

Deselect/Select All

Trace element selection

Trace sub-element selection

Select/Deselect All

Archive file selection

Change export options, change
compression

Change export options, change
format

Change export options, change
format and compression

Finish the wizard

Overwrite

Verify formats

Verify content

Partial selection
Trace Package Import Wizard

2.3.0-TraceCompassTestCases - ProjectView

Select several traces and experiments one after each other in
Editors area

Select several open traces and experiments one after each
other in Project Explorer

1) In Project Explorer make sure that "Link with Editor" button
is not selected

2) Open multiple traces and experiments (if not open)

Select several traces and experiments one after each other in
Editors area

Select several open traces and experiments one after each
other in Project Explorer

1) Import 2 traces that generate supplementay files (trace2,
kernel_vm)

2) Open both traces, wait for the indexing to finish

2) Add bookmarks in the two traces

Click on “File”, “Export..."”, “Tracing”,
and click Next

‘Trace Package Export”

On the left side, select the project in which the traces were
imported. Then on the right side, selected both traces.

With traces selected, press the Deselect All button. Then press
on the Select All button. Click Next.

Unselect the trace2 element

Unselect the kernel_vm > Trace element

Wwith nothing selected, click Select All. Then click Deselect All.
Then click Select All again.

1) Click on the Browse button.
2) Select a location on the filesystem
3) Enter the file name export.tar

Unselect the “Compress” checkbox.
Change to Zip format

Change to Tar format then select the Compress checkbox.

Click Finish

Open the wizard again and select the traces (step 13.2, 13.3).
Click Finish.

Open the wizard again and select the traces (step 13.2, 13.3).
This time, choose Zip format. Click Finish.

Open the tar.gz and the zip files in an archive manager.

Open the wizard again and select the traces (step 13.2, 13.3).
This time, unselect both Supplementary files subtrees. Click
Finish.

Verify that after each selection the corresponding trace
or experiment element is selected in the Project
Explorer

Verify that after each selection the corresponding trace
or experiment is brought to the top in the Editors area

Verify that selection in Project Explorer doesn't change

Verify that Editor in focus is not changed

A wizard should appear with a list of projects and traces
to select. Next button should be disabled.

Next should be become enabled when the first trace is
selected. If all traces are unselected, the Next button is
disabled.

Next should become disabled after Deselect All,
enabled after Select All.

All elements in the trace tree are unselected, the
Approximate uncompressed size field changes to a
lower number.

All elements in the trace tree are unselected, the
Approximate uncompressed size field changes to 0. The
Next button is disabled.

When Select All is clicked, all the tree elements are
selected, the approximate size increases. When Deselect
Allis clicked, all the tree elements are deselected and
the approximate size decreases.

A file chooser dialog comes up. When the destination
file is entered, the “To archive file” is filed with export.
tar.gz. The Finish button should be enabled.

The name of the archive file changes to export.tar
The name of the archive file changes to export.zip

The name of the archive file changes to export.tar.gz

A progress bar should appear at the bottom the the
dialog and it should disappear upon completion. The
export.tar.gz file should be created on the file system.

The Archive file name should be remembered and
already filled. A dialog should prompt the user to
overwrite. Answering No should keep the wizard
opened. Answering Yes should re-export the archive and
close the wizard.

The export.zip file should be created on the file system
In both archives, verify that it contains:

1) A trace folder for each trace containing all the trace
files (excluding supplementary files)

2) A .tracing folder containing all the supplementary
files

3) An export-manifest.xml file listing the trace files,
supplementary files and bookmarks

Verify that the exported archive contains:

In both archives, verify that it contains:

1) A Traces folder containing all the trace files
(excluding supplementary files)

2) No .tracing folder

3) An export-manifest.xml file listing the trace files and
bookmarks
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14.1

14.2

14.3

14.4

14.5
14.6
14.7

14.8

14.9
14.10
14.11

14.12

14.13

15

15.1

15.2

15.3

15.4

15.6

15.7

Preparation
Open the trace package import
wizard

Project Selection

Archive file selection

Deselect/Select All
Trace element selection
Trace sub-element selection

Select/Deselect All

Finish the wizard
Supplementary Files
Bookmarks

Open from bookmark

Overwrite
Time Offsetting

Preparation

Apply time offset dialog - trace
selection

Apply time offset dialog - folder
selection

Apply time offset dialog -
experiment selection

Apply time offset dialog - Basic
mode

Apply time offset dialog -
cumulative offset

Clear time offset

Apply time offset dialog -
Advanced mode

2.3.0-TraceCompassTestCases - ProjectView

Create an empty tracing project. Make sure you have export.

tar.gz available from the Trace Package Export Wizard (13)

test case, which should include everything including trace files,

supplementary files and export-manifest.xml.

Click on “File”, “Import...”, “Tracing”, “Trace Package Import”

and click Next

Click the Select button. Choose the previously created project.

1) Click on the Browse button.
2) Browse for export.tar.gz on the file system

With traces selected, press the Deselect All button. Then press

on the Select All button.
Unselect the trace2 element
Unselect the kernel_vm > Trace element

With nothing selected, click Select All. Then click Deselect All.

Then click Select All again.

Click Finish
Right-click on trace2 in Project Explorer
Open the Bookmarks view

Double click on one of the bookmarks

Open the wizard again (step 13.2) and select the archive file

(step 13.4). Click Finish.

Open Project Explorer view and Properties view. Create an
empty tracing project. Import two different traces to the

project. Open the traces and note their start time. Close the

traces.

Select both trace elements in the Project Explorer view. Right-

click and select Apply Time Offset...

Select the Traces folder element in the Project Explorer view.

Right-click and select Apply Time Offset...

Create an experiment with both traces. Select the experiment

element in the Project Explorer view. Right-click and select
Apply Time Offset...

Select a trace element in the Project Explorer view. Right-click

and select Apply Time Offset... In the Offset in seconds
column, enter a time with seconds and decimals. Click OK.
Open the trace.

Select the same trace element in the Project Explorer view.
Right-click and select Apply Time Offset... In the Offset in

seconds column, enter a time with seconds and decimals. Click

OK. Open the trace.

Select the trace element in the Project Explorer view. Right-
click and select Clear time offset. Click OK to confirm. Open

the trace.

Open one trace and close the other trace. Select both trace

elements in the Project Explorer view. Right-click and select

Apply Time Offset... Choose the Advanced radio button.

The first page of the wizard should appear (Choose
content to import)

The Into project field gets filled with the selected
project name.

Finish should be become enabled when the first trace is
selected. If all traces are unselected, the Next button is
disabled.

Finish should become disabled after Deselect All,
enabled after Select All.

All elements in the trace tree are unselected.
All elements in the trace tree are unselected.

When Select All is clicked, all the tree elements are
selected. When Deselect All is clicked, all the tree
elements are deselected..

A progress bar should appear at the bottom the the
dialog and it should disappear upon completion. The
two traces should appear under the project in Project
Explorer

Delete Supplementary files appears in the content menu
Bookmarks appear in the list for the imported traces

The corresponding trace opens at the bookmarked
event. Bookmarks are displayed in the event table.

A dialog should prompt the user to overwrite for each
trace. Answering Yes to All should overwrite without
prompting again.

The Apply time offset dialog opens in Basic mode. The
Trace name show both traces and the Offset in seconds
is blank.

The Apply time offset dialog opens in Basic mode. The
Trace name show both traces and the Offset in seconds
is blank.

The Apply time offset dialog opens in Basic mode. The
Trace name show both traces and the Offset in seconds
is blank.

The timestamps in the trace are all offset by the entered
value. The Properties view shows the 'time offset’ with
the entered value.

The timestamps in the trace are all offset by the
cumulative sum of the previous and current entered
value. The Properties view shows the 'time offset’ with
the cumulative value.

The timestamps in the trace are back to their original
values. The Properties view shows the 'time offset' as
blank.

The Apply time offset dialog opens and is switched to
Advanced mode. The Trace name show both traces and
the Offset in seconds is blank. The Reference time for
the opened trace is set to its start time.
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15.9

15.10

15.11

Apply time offset dialog -
Advanced mode - compute from
selection

Apply time offset dialog -
Advanced mode - compute from
entered values

Clear time offset with opened
traces

2.3.0-TraceCompassTestCases - ProjectView

Double-click the second trace to open it. Select an event in its
trace editor. Select the first trace editor. Select an event in its
trace editor. Click the button in the dialog row of the second

trace. Click OK. Open both traces.

Select the First trace element in the Project Explorer view.

Right-click and select Apply Time Offset... Choose the

Advanced radio button. Double-click the trace name to open it.
Select the Reference time cell and copy the start time. Select

the Target time and paste the value. Edit both values to

different times. Click the button in the trace row. Click OK.

Open the trace.

Open both traces. Select both trace elements in the Project
Explorer view. Right-click and select Clear time offset. Click OK

to confirm. Open the traces.

Both traces are open. Selecting an event updates the
Reference time for the selected trace, and updates the
Target time for all traces. Pressing the button computes
the Offset in seconds as the difference between Target
time and Reference time for that row. The trace which
has a computed offset is closed when the OK button is
pressed. After reopening, the two previously selected
events now have the same timestamp. The Properties
view shows the 'time offset’ with the computed value.
The trace is opened. The Reference time is set to the
trace start time. The Reference time and Target time
can be copied, pasted, and edited. Pressing the button
computes the Offset based on the current time values.
The trace is closed with the OK button is pressed. After
reopening, the timestamps in the trace are offset
according to the computed value. The Properties view
shows the 'time offset' with the computed value.

The opened traces are closed when the OK button is
pressed. After reopening, the timestamps in the traces
are back to their original values. The Properties view
shows the 'time offset' as blank.
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Section

Target: Ubuntu 14.04 64 bit

TMF - Histogram View

2.3.0-TraceCompassTestCases - HistogramView

ToDo Comment

Step Test Case Action Verification Comment
1 Preparation
1.1 Step 1 Open and reset LTTng Kernel perspective LTTng Kernel perspective opens with correct views SWTBot Pass
1.2 Step 2 Open an LTTng trace Views are populated SWTBot Pass
2 Manage View
2.1 Close view Close the Histogram View Histogram View is removed from perspective SWTBot Pass 84710
2.2 Open view Window > Show View > Tracing > Histogram Histogram View is displayed and re-populated SWTBot Pass 84710
2.3 Resize Resize the Histogram View width-wise Histograms are compressed/decompressed without loss ~ SWTBot Pass  Tested with HistogramDataModelTest
3 Full Trace Histogram
3.1 Single selection Select timestamp with left-click Selection Start/End + blue bars are updated Manual Pass
Select time range with shift-left-click, shift-left-drag or left-
3.2 Range selection drag Selection Start/End + blue bars are updated Manual Pass
Drag the zoom window left/right with ctrl-left-drag or middle-
33 Drag zoom window drag Zoom window is dragged, won't go beyond full range Manual Pass
Zoom window is centered on click, won't go beyond full
34 Move zoom window Move the zoom window with ctrl-left-click or middle-click range Manual Pass
Zoom window is set, Window Span is updated, won't go
3.5 Set zoom window Set a new zoom window with right-drag beyond histogram range Manual Pass
Zoom window is updated, Window Span is updated, won't
3.6 Zoom infout Zoom in/out with mouse wheel up/down go below 2 ns, won't exceed full trace range Manual Pass
Selection (blue bar) moves to the previous/next non-
3.7 Arrow keys Move the current event using left/right arrow keys empty bucket Manual Pass
Selection Start/End moves to beginning/end of trace (i.e.
3.8 Home/End keys Press Home/End key start time of last bucket is selected) Manual Pass
With a trace containing lost events, click the "Hide lost events"
3.9 Lost events toolbar icon. Click it again. The lost events (red bars) are toggled on and off. Manual Pass
Zoom window is updated, Window Span is updated, won't
3.10  Zoom in/out (key) Zoom infout with +/- key go below 2 ns, won't exceed full trace range Manual Pass  Matthew: Interesting, | forgot about this feature
4 Time Range Histogram
4.1 Single selection Select timestamp with left-click Selection Start/End + blue bars are updated Manual Pass
Select time range with shift-left-click, shift-left-drag or left-
4.2 Range selection drag Selection Start/End + blue bars are updated Manual Pass
Drag the zoom window left/right with ctrl-left-drag or middle-
4.3 Drag zoom window drag Zoom window is dragged, won't go beyond full range Manual Pass
Zoom window is updated, Window Span is updated, won't
4.4 Zoom infout Zoom in/out with mouse wheel up/down go below 2 ns, won't exceed full trace range Manual Pass
Selection (blue bar) moves to the previous/next non-
4.5 Arrow keys Move the current event using left/right arrow keys empty bucket Manual Pass
Selection Start/End moves to beginning/end of time
4.6 Home/End keys Press Home/End key range (i.e. start time of last bucket is selected) Manual Pass | Matthew: We need to publish this feature more
With a trace containing lost events, click the "Hide lost events"
4.7 Lost events toolbar icon. Click it again. The lost events (red bars) are toggled on and off. Manual Pass
Zoom window is updated, Window Span is updated, won't
3.10  Zoom in/out (key) Zoom infout with +/- key go below 2 ns, won't exceed full trace range Manual Pass
5 Selection Start/End
5.1 Set selection start Enter a TS within the full range in Selection Start widget Selection Start + blue bars are updated Manual Pass selection range
5.2 Set selection end Enter a TS within the full range in Selection End widget Selection End + blue bars are updated Manual Pass
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5.3
5.4
5.5

6.1
6.2

6.3

71

7.2

7.3

7.4

8.1

8.2

8.3

8.4

9.1

9.2

9.3

9.4

10

10.1

Set selection (linked)
Set invalid selection start
Set invalid selection end

Window Span
Set window span
Set large window span

Set invalid window span

Selected Timestamp
Synchronization
Time Range mouse
synchronization

Full Trace mouse
synchronization

Selection synchronization
(linked)

External synchronization

Selected Time Range
Synchronization

Time Range mouse
synchronization

Full Trace mouse
synchronization

Selection Start/End
synchronization

External synchronization

Zoom Window
synchronization

Time Range mouse
synchronization

Full Trace mouse
synchronization

Window Span
synchronization

External synchronization

Multiple Trace
Synchronization

Preparation

Open multiple traces (no
overlap)

2.3.0-TraceCompassTestCases - HistogramView

Select the link icon. Enter a TS within the full range in
Selection Start widget

Enter a TS before the full range start in Selection Start widget
Enter a TS after the full range end in Selection End widget

Enter a span in Window Span widget
Enter an invalid span (too large) in Window Span widget

Enter an invalid span (too small, negative, not a number) in
Window Span widget

Click on the time range histogram. The time of the bucket at
the mouse position is selected.

Click on the full trace histogram. The time of the bucket at the
mouse position is selected.

Select the link icon. Enter a time within the full range in
Selection Start widget

In any other view that supports time synchronization, select a
time.

Select a time range in the small histogram (shift-left click, left-
drag or shift-left drag).

Select a time range in the full histogram (shift-left click, left-
drag, shift-left drag).

Enter a time within the full range in Selection Start/End widget

In any other view that supports time range synchronization,
select a time range.

Select a zoom window in the small histogram (ctrl-left drag,
middle-drag, right-drag, mouse wheel up/down).

Select a zoom window in the full histogram (ctrl-left drag,
middle-click, middle-drag, right-drag, mouse wheel up/down).

Enter a new span in Window Span widget

In any other view that supports range synchronization, select a
new zoom window.

1) Download traces.zip (if necessary) and unzip into a local
directory ${local}

2) Import kernel trace ${local}/traces/import/kernel-
overlap-testing

3) Import UST ${local}/traces/import/trace ust-overlap-
testing

4) Create experiment with trace of 2) in it

Open multiple traces that don't overlap in time

Selection Start/End + blue bars are updated
Selection Start + blue bar set to first event
Selection End + blue bar set to last event

Both Histograms are updated accordingly
Span set to full range

Span set to previous value

Other views are synchronized to the selected time

Other views are synchronized to the selected time

Other views are synchronized to the selected time

Selection Start/End + blue bars in both histograms are
updated to the selected time

Verify that the selected time range shows in both
histograms, and in other views.

Verify that the selected time range shows in both
histograms, and in other views.

Other views are synchronized to the selected time range

Selection Start/End + blue bars in both histograms are
updated to the selected time range

Other views are synchronized to the new range
Other views are synchronized to the new range
Other views are synchronized to the new range

Window Span and both histograms are updated to the
new range

View shows the last opened trace
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Manual
Manual
Manual

Manual
Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

What is to small? 1ns seems to work

Zoom Window is moved if selection is outside the current zoom
window and a time graph window is open (e.g. CFV). Otherwise
zoom window stays.

Zoom Window is moved if selection is outside the current zoom
window and a time graph window is open (e.g. CFV). Otherwise
zoom window stays.



2.3.0-TraceCompassTestCases - HistogramView

Change selected time and Selection Start/End, Window Span and both histograms

10.2  range (no overlap) Select a time and new range are updated to selected time and new range. Manual
Open multiple traces

10.3  (overlap) Open multiple traces that overlap in time View shows the last opened trace Manual
Change selected time and Selection Start/End, Window Span and both histograms

10.4  range (overlap) Select a time and new range are updated to selected time and new range. Manual

View is updated to show selected trace. Selection

Select other trace Start/End, Window Span and both histograms are set to

10.5  (overlap) Select different trace by clicking its editor tab the newly selected time and range. Manual

The colors in both Histograms and toggled on and off.
With an experiment containing multiple traces opened, click ~ When it is toggled off, the legend disappears at the
10.6  Trace coloring the "Activate trace coloring” toolbar icon. Click it again. bottom and only one color is used for non-lost events. Manual

10.7  Close all traces Close all trace editor tabs View is cleared. Manual
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2.3.0-TraceCompassTestCases - EventsEditor

To Do

Section Type Comment

TMF - EventsEditor 6
Target:
Step Test Case Action Verification Comment
1 Preparation
1.1 Preparation step 1 Open and reset LTTng Kernel perspective LTTng Kernel perspective opens with correct views. SWTBot Pass
2 Trace bookmarks Moved to sheet "BookmarksView"
3 Experiment bookmarks Moved to sheet "BookmarksView"
4 Filter
Only events matching regex are displayed. Top and
bottom fFilter status rows update while filtering is
ongoing. When filtering is done, status rows show
4.1 Filter In the header row, enter some regex and press Ctrl+Enter number of matching events. SWTBot Pass
Only some events matching regex are displayed. Status
In the header row, enter some regex and press Ctrl+Enter, rows show partial number of matching events, with
4.2 Cancel filter then quickly press ESC before filtering is done different 'stop' icon. Manual Pass
All events are displayed. Selected event remains
4.3 Un-filter In the header bar, click the icon to delete a filter selected and visible. Status rows are removed. SWTBot Pass
4.4 Filter & Search In the filter bar, enter some regex; likewise in the search bar  Events are filtered and highlighted accordingly SWTBot Pass
4.5 Search & Filter In the search bar, enter some regex; likewise in the filter bar  Events are filtered and highlighted accordingly SWTBot Pass
5 Time Synchronization
Other views are synchronized to the selected event's
5.1 Mouse synchronization Select any event in the table with the mouse button time Manual Pass
Select any event in the table using Up, Down, PageUp, Other views are synchronized to the selected event's
5.2 Key synchronization PageDown, Home, End time Manual Pass
In the search bar, enter some regex, then search again with Other views are synchronized to the selected event's
53 Search synchronization Enter/Shift-Enter time Manual Pass
In any other view that supports time synchronization, select a The first event at or following the selected time is
5.4 External synchronization time. selected and visible. Manual Pass
Select an event with left button, press shift key and click select Range of events are highlighted. Selection range is
5.5 Range selection another event updated in other views that support range selection Manual Pass
6 Event Synchronization

Verify that an editor is opened showing LTTng Kernel
6.1 Open trace Open an LTTng CTF Kernel trace specific columns. Views are updated with the new trace. SWTBot Pass

The Properties view is updated with the selected event's
Property and Value. Timestamp and Content are

6.2 Mouse synchronization Select any event in the table with the mouse button expandable. Manual Pass
The Properties view is updated with the selected event's
Select any event in the table using Up, Down, PageUp, Property and Value. Timestamp and Content are
6.3 Key synchronization PageDown, Home, End expandable. Manual Pass

The Properties view is updated with the selected event's
In the search bar, enter some regex, then search again with Property and Value. Timestamp and Content are
6.4 Search synchronization Enter/Shift-Enter expandable. Manual Pass

In any other view that supports time synchronization, select a The Properties view is updated with the selected event's
time. The selected event in the editor is updated. Then give Property and Value. Timestamp and Content are
6.5 External synchronization Ffocus back to the editor. expandable. Manual Pass
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7

71

7.2

7.3

7.4

8.1

8.2

83

9.1

8.2

Source Code / Model
Lookup

Preparation

Open call site

Open call site (no source
code)

Open model URI

Export to text

Export CTF trace

Export Other Trace

Copy to clipboard

Swap Columns and
Change Fonts

Swap columns in events
table

Change fonts

2.3.0-TraceCompassTestCases - EventsEditor

1) Download traces.zip (if necessary) and unzip into a local

directory ${local}

2) Unzip traces/c_project_callsite.zip and traces/callsite.zip

to your local disk.

3) Import demo C project to the Eclipse workspace of zip
file c_project_callsite.zip

4) Import the test trace of zip file callsite.zip to a tracing
project.

Select trace type "Generic CTF Trace" and open the trace

1) select event in table
2) click right mouse button
3) select "Open Source Code" menu item

1) Close source code project

2) select eventin table

3) click right mouse button

4) select "Open Source Code" menu item

1) select event in table (e.g. 1st event)
2) click right mouse button
3) select "Open Model Element" menu item

1) Open a CTF trace (e.g. LTTng Kernel)
2) Click right mouse button

3) Select "Export To Text" menu item
4) Enter a file name and location

5) Press OK

1) Open a trace other than CTF trace
2) Click right mouse button

3) Select "Export To Text" menu item
4) Enter a file name and location

5) Press OK

1) Open a CTF trace (e.g. LTTng Kernel)
2) Click right mouse button

3) Select "Copy to Clipboard" menu item
4) Paste it in a text file

1) Open a trace
2) Drag a column

1) Open the preferences
2) select new font for trace types

3) press apply
4) verify that the font changed

Verify that correct source code file and line number is
opened

Since the source code is not available the no source code
file is opened. Instead a error dialog is opened (with title
"FileNotFoundException")

Since the model is not available the model element is
not shown. Instead a error dialog is opened (with title
"FileNotFoundException")

Make sure that a progress monitor dialog is opened
during the export. After finishing make sure that the
text file exists and it contains the events stored in the
file. Verify that the columns are printed as shown in the
events table and that they are separated by tab
character.

Make sure that a progress monitor dialog is opened
during the export. After finishing make sure that the
text file exists and it contains the events stored in the
file. Verify that the columns are printed as shown in the
events table and that they are separated by tab
character.

Verify that the columns are printed as shown in the
events table and that they are separated by tab
character.

Covered by SWTBot tests

Covered by SWTBot tests
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Bruno : When trying to import the trace | get an initializing error. A
token mismatched exception. We can parse the trace using
Babeltrace, but maybe the parser used in trace compass has an
error.

JC: Failed to open the trace but it seems normal. The support for
CTF callsite was removed
Bernd: | used a different trace taken with LTTng UST 2.8 and it

Manual works.
JC: The support for CTF callsite was removed
Bernd: | used a different trace taken with LTTng UST 2.8 and it
Manual works.
JC: The support for CTF callsite was removed
Manual To Do
Manual
Manual JC:Export worked with a pcap trace. But there were no progress moni
SWTBot
SWTBot
SWTBot



2.3.0-TraceCompassTestCases - EventsEditor

1) Open the preferences
2) Reset the font settings
3) Press apply

4) verify that the font changed
Covered by SWTBot tests SWTBot

8.3 Reset fonts
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Target:

2.1

22

2.3

2.4

2.5

2.6

2.7

2.8

29

3.1

32

33

34

35

3.6

3.7

Section
TMF - BookmarksView
Ubuntu 14.10 64 bit

Test Case

Preparation

Preparation step 1

Trace bookmarks
Show Bookmarks View

Open trace

Add Trace Bookmark

Open Trace Bookmark (1)
Open Trace Bookmark (2)
Open Trace Bookmark (3)

Delete Bookmark (from
table)

Delete Bookmark (from
table)

Delete Bookmark (from
Bookmarks view)

Experiment bookmarks

Create and open experiment

Add Experiment Bookmark

Open Experiment Bookmark

(O]

Open Experiment Bookmark
@
Open Experiment Bookmark

(3)

Delete Bookmark (from
table)

Delete Bookmark (from
Bookmarks view)

2.3.0-TraceCompassTestCases - BookmarksView

Open and reset LTTng Kernel perspective

Select Bookmarks view (bottom folder)

Open an LTTng CTF Kernel trace

Add a bookmark, by

a) double-clicking on the left margin next to an event

b) right-clicking the margin and select Add bookmark....
c¢) using the Edit > Add bookmark... menu.

Enter the bookmark description in dialog box

Scroll within event table so that bookmark is not visible anymore and
then double-click on bookmark in Bookmarks View

Open another trace #2 and then double-click on bookmark in
Bookmarks view

Close the trace #1 and then double-click on bookmark in Bookmarks
view

Select bookmarks icon in event table right-click on icon and select
"Remove Bookmark"

Double-clicking bookmarks icon in event table.

Add a bookmark (see 2.4), then select bookmark in Bookmarks view,
right mouse click and select "Delete". Confirm the deletion.

Create Experiment with 2 LTTng CTF Kernel traces in it and open
experiment

Add a bookmark, by

a) double-clicking on the left margin next to an event

b) right-clicking the margin and select Add bookmark....
c¢) using the Edit > Add bookmark... menu.

Enter the bookmark description in dialog box

Scroll within event table so that bookmark is not visible anymore and
then double-click on bookmark in Bookmarks View

Open another trace #2 and then double-click on bookmark in
Bookmarks view

Close the experiment #1 and then double-click on bookmark in
Bookmarks view

Select bookmarks icon in Events view, right-click on icon and select
"Remove Bookmark"

Add a bookmark (see 6.4), then select bookmark in Bookmarks view,
right mouse click and select "Delete". Confirm the deletion.

Fail

Verification

LTTng Kernel perspective opens with correct views.

Bookmaks view is shown

Views are populated. Verify that a Kernel events editor is
opened showing LTTng Kernel specific columns

Make sure that bookmark icon is shown on left site of the event
row and is added to the Bookmarks view with relevant
information (i.e. Description entered and correct trace resource)

Make sure that event with bookmark is selected and visible in
event table

Make sure that correct trace #1 is brought to top and correct
event with bookmark is selected in events table

Make sure that correct trace #1 is opened and correct event with
bookmark is selected in events table

Make sure that bookmark icon is removed from event table and
corresponding bookmark is removed from the Bookmarks view

Make sure that bookmark icon is removed from event table and
corresponding bookmark is removed from the Bookmarks view

Make sure that bookmark icon is removed from event table and
corresponding Bookmark is removed from the Bookmarks view

Verify that an Events editor is opened showing LTTng Kernel
specific columns

Make sure that bookmark icon is shown on left site of the event
row and is added to the Bookmarks view with relevant
information (i.e. Description entered and correct experiment
resource)

Make sure that event with bookmark is selected and visible in
event table

Make sure that correct experiment #1 is brought to top and
correct event with bookmark is selected in events table

Make sure that correct experiment #1 is opened and correct
event with bookmark is selected in events table

Make sure that bookmark icon is removed from event table and
corresponding bookmark is removed from the Bookmarks view

Make sure that bookmark icon is removed from event table and
corresponding Bookmark is removed from the Bookmarks view
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Type To Do

IERE

SWTBot Pass
Manual Pass
SWTBot Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass

Comment

Comment

No Edit menu in Trace Compass RCP



2.3.0-TraceCompassTestCases - FiltersView

To Do

Section
TMF - Filters View
Target: Ubuntu 14.10 64 bit

Comment

Step Test Case Action Verification Comment

Open a trace to be

1 filtered Trace is opened SWTBot SWTBot Pass

2 Open filter view Filter view is opened SWTBot SWTBot Pass
Create a filter on event  The filterview contains a filter on the event type and the

3 type and timestamp timestamp SWTBot SWTBot Pass

3.1 Apply that Ffilter A subset of the events pass SWTBot SWTBot Pass

Create a filter on the
timestamp oring field

4 values Create the filter SWTBot SWTBot Pass
4.1 Apply that filter A subset of the events pass SWTBot SWTBot Pass
Create a filter with equals
5 node Create the filter SWTBot SWTBot Pass
5.1 Apply that filter A subset of the events pass SWTBot SWTBot Pass
Create a filter with
6 matches node Create the filter SWTBot SWTBot Pass
6.1 Apply that filter A subset of the events pass SWTBot SWTBot Pass
Create a filter with
7 contains node Create the filter SWTBot SWTBot Pass
7.1 Apply that filter A subset of the events pass SWTBot SWTBot Pass

22



2.3.0-TraceCompassTestCases - ColorsView

Section Pass Fail ToDo Comment

TMF - Colors View 6 n“ 0

Target: Ubuntu 14.10 64 bit

Step Test Case Action Verification Comment

1 Open a test trace a trace is visible in the events editor SWTBot SWTBot Pass

2 Open the colors view the view is visible SWTBot SWTBot Pass
Select a color and a filter, the matching events should update

3 Select a color and a filter  their colors (background and foreground) to the new ones SWTBot SWTBot Pass

4 Add multiple colors Click on add 4 times, four colors should be displayed SWTBot SWTBot Pass
Change the color By clicking on up and down, the order of the displayed colors

5 priorities should change SWTBot SWTBot Pass

6 Delete all the colors The color filters should disappear. SWTBot SWTBot Pass



2.3.0-TraceCompassTestCases - SequenceDiagram

Section Pass Fail ToDo Comment

TMF - Sequence Diagram 37 n“ 13

Target: Ubuntu 14.04 64 bit

Step Test Case Action Verification Type Comment
1 Preparation
1) Download traces.zip (if necessary) and unzip into a local
directory ${local} Note: Ul tests are not SWTBot, but JUnit tests. Tests
2 )Use traces simple-server-thread1 and simple-server- are triggered programmatically right below the dialogs
thread2 under traces/import/ for test cases below level

LTTng Kernel perspective opens with correct views:
Project Explorer, Control, Control Flow, Resources,

1.1 Open perspective Open and reset LTTng Kernel perspective Statistics, Histogram, Properties, Bookmarks SWTBot Pass
Open TMF Sequence Use menu Window — Show View — Other ... — Tracing —
1.2 Diagram View Sequence Diagram Verify that 'Sequence Diagram' view is shown SWTBot Pass

1) Create Tracing Project
2) Create Experiment (SeqExp)
3) Import 2 traces simple-server-thread1 and simple-server-

thread2 Verify that sequence diagram was loaded. The
4) Select trace type "Generic CTF Trace" interaction show the signal numbers (Note that trace
Create and open 5) Add these 2 traces to experiment doesn't contain strings for the interactions. A special
experiment with 6) Open (double-click on) the experiment parser would be necessary to map signal number to
1.3 sequence diagram data trace) Manual Pass
2 Manage View
2.1 Close view Close Sequence Diagram view Sequence Diagram View is removed from perspective Manual Pass
Open view when 1) Close 'Sequence Diagram' View
experiment/traces is 2) load sequence diagram experiment Verify that sequence diagram was loaded. Verify that all
2.2 already loaded 3) Open Sequence Diagram view 17 pages are loaded. Manual Pass  difficult to get the numb of pages
3 Tooltip
Tooltip backgound is very dark and text is hard to read
on Ubuntu 13.10, 14.10 with default theme
1) Goto to first page (no selection of any interaction or lifeline) Verify that tooltip appears with content with interaction https://bugs.eclipse.org/bugs/show_bug.cgi?
3.1 Hover over interaction 2) Hover over first interaction (arrow or number) name and time stamp (10000 14:58:00.740995147) Manual Pass id=455523. The value is not the same
Verify that tooltip appears with content with interaction
1) Goto to first page names and time stamp delta between selected
Hover over interaction 2) select first interaction interaction and interaction that was hovered over
3.2 after selection 3) Hover over 3rd interaction (10001 — 10000 delta: 000.000 157 023) Manual Pass
Verify that tooltip appears with delta and graph to show
Hover over time Hover over first element in time compression bar on the left ~ where delta is in relation to current configured min max
33 compression bar of the view values. (delta: 000.000 3 480) Manual Pass
4 View Synchronization
Verify that interaction is highlighted in 'Sequence
Diagram' view. Verify that in the events table the
corresponding event is selected. Verify that time stamps
4.1 Selection of interaction Select an interaction in the 'Sequence Diagram' matches Manual Pass
Selection of eventin Select an sequence diagram event in the events table (type Verify that corresponding interaction is selected in the
4.2 events table SEND or RECEIVE) 'Sequence Diagram' view Manual Pass
It's a bit unclear to me what this is supposed to do. |
think it means when the start of the range changes, it
should update the events shown in the sequence
Verify that the content of the 'Sequence diagram' diagram
Selection of new time changes and the interactions are part of the new Bernd: | updated the description to clarify for the next
4.3 range Change time range in 'Histogram View'. window range Manual Pass  release.
5 View Actions



5.1

52

5.3

5.4

5.5

5.6

5.7

5.8

59

5.10

5.1

5.12

5.13

5.14

Test page navigation

Test menu item 'Pages..."

Find of interaction

Find of lifeline
Find criteria persistence

Find short-cut

Filter of interactions

Filter of lifelines

Deselect filter

Filter criteria persistence

Zoom-in

Selection after zooming

Zoom-out

Reset zoom

2.3.0-TraceCompassTestCases - SequenceDiagram

Use buttons and menu items 'Go to next page’, 'Go to previous
page', 'Go to last page' and 'Go to first page' to navigate
through trace. Use also menu item 'Pages..." to jump to specific
page

1) Select menu item 'Pages..."
2) In text box type “9”
3) Click on 'OK’

Goto to page 1 —

1) Use button and menu item “Find”

2) select Interactions and deselect lifeline
3) type regular expression 10.*00

4) press find

5) press find

6) press find

7) press find

8) press find

Goto to page 1 —

1) Use button and menu item “Find”

2) select lifeline and deselect interaction
3) type player2

4) press find

5) press find

1) Restart eclipse

2) open find dialog

1) Select 'Sequence Diagram' view
2) pres CTRL+F

Goto to page 1 —

1) Use menu item 'Hide Patterns...'

2) Press Add

3.1) select Interactions and deselect Lifeline
3.2) type regular expression 10.*03

4) Press 'Create’

5) Press 'Ok’

Goto to page 9 —

1) Use menu item 'Hide Patterns...'

2) Press Add

3.1) select Lifelines and deselect Interactions
3.2) type regular player2

4) Press 'Create’

5) Press 'Ok’

1) Apply one filter

2) Use menu item 'Hide Patterns..."

3) deselect filter

4) click 'Ok’

1) Restart eclipse

2) open hide dialog

1) Use button and menu item for zoom-in to activate zooming
in

2) click into sequence diagram view

1) Click on button and menu item 'Select' to go back to
selection mode

2) select an interaction

1) Use button and menu item for zoom-out to activate
zooming out

2) click into sequence diagram view

1) Use button and menu item for 'Reset zoom Factor' to reset
the zoom level

Verify that different time ranges are selected when
changing page by looking at Histogram View. Histogram
View window will show the start of the page. Note that
there are 10000 interactions per page. In this traces
there are in total 160032 interactions. Verify that last
page has 32 interactions between 2 lifelines.

Verify that a dialog box will show. Verify that for this
trace it shows 'Total: 17 pages is shown” and the current
page is displayed in the text box. After step 3) verify
that page where changed to page 9. For this trace page
9 is the page with 3 lifelines.

After 4) verify that interaction 10000 (player1 — master)
is selected. After 5) verify that interaction 10100
(master — player1) is selected. After 6) verify that
10000 (player2 — master) is selected. After 7) verify
that interaction 10100 (master — player2). After 8
nothing else will be found

After 4) verify that lifeline with name player2 is selected
(page 9 with 3 lifelines). After 5) player2 is selected on
page 10

Verify that previous used find criteria are still in the list

Verify that find dialog opens

After 5) verify that Interactions with name 10003 and
10103 are not shown

After 5) verify that player2 is not shown

Verify that all lifelines and interactions are shown
Verify that previous used hide criteria are still in the list

Verify that 'Sequence Diagram' view zooms in. Note that
no selection is possible.

Verify that selection is possible.

Verify that 'Sequence Diagram' view zoom out. Note
that no selection is possible.

Verify that 'Sequence Diagram' view goes back to
default zoom
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Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Where is the total number of interaction by page. Do we have to
verify that also?

It should have a string status in the search that specify
that the nothing was found. In the test 34, if the user
search for "10.*03" the find dialog will show "String not
found". It should be shown for this test too.

It reaches the right pages but the selection does not
highlight anything when the find box is still opened. It
only highlight the lifeline when we close the find dialog.
Bernd: It supposed to highlight the lifeline on the
correct page. So, test is successful. JC: The selection
highlight the lifeline but it is difficult to see.



5.15

5.16

517

5.18

5.19

5.20

5.21

5.22

5.23

5.24

5.25

Configure min/max

Configure min/max
(default)

Show node end

Show node start

Show node end short-cut

Show node start short-cut

Scroll down short cut

Scroll up short cut

Overview feature

Print

Remove filter (Bug
391714)

2.3.0-TraceCompassTestCases - SequenceDiagram

1) Select menu item 'Configure Min Max'

2) Change min to 100 and max to 2000 (keep scale and
precision)

3) press 'Ok’

After changing min and max

1) select menu 'Configure Min Max'

2) press 'Default' 3) press 'Ok’

Goto to page 1 —

1) Resize view so that the arrow of the interaction is not
shown

2) select on interaction

3) Use menu item Navigation — Show node end

Goto to page 1 —

1) Resize view so that the beginning of the interactions are not

shown
2) select on interaction
3) Use menu item Navigation — Show node start

Goto to page 1 —

1) Resize view so that the arrow of the interaction is not
shown

2) select on interaction

3) Press SHIFT+ALT+END

Goto to page 1 —

1) Resize view so that the arrow of the interaction is not
shown

2) select on interaction

3) Press SHIFT+ALT+HOME

Press SHIFT+ALT+ARROW_DOWN

Press SHIFT+ALT+ARROW_UP

Goto page 9 — Keep pressing + icon at the lowest right corner
of the view and drag down, up, left or right

Select 'Sequence Diagram' view and press printer icon in the
Eclipse's tool bar (or use CTRL+P). Select one pager page to
print

1) Create 1filter if necessary (see 5.8)

2) Open Error Log view if necessary

3) Open filter dialog box and remove all filters
4) Press 'Ok’

5) Open filter dialog box again

After 1) verify that a dialog box shows with default
values. After 3) verify that time compression bar
changes some colors. It will show more deeper red
because the max value is lower.

After step 2) the default values are shown. After step 3)
the time compression bar will change colors. Note that
the default values are computed based on all deltas of 2
consecutive interactions.

Verify that end lifeline of the interaction (the arrow) is
shown

Verify that start lifeline of the interaction is shown

Verify that end lifeline of the interaction (the arrow) is
shown

Verify that start lifeline of the interaction is shown

Verify that within a page the display scrolls down per
view size

Verify that within a page the display scrolls up per view
size

Verify that it's possible to navigate through a page of
the sequence diagram view

Verify that it is possible to print

Verify that no exceptions occurred and after 5) no filter
are listed
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Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

The shortcut is not working when the mouse is
hovering the interaction

The shortcut is not working when the mouse is
hovering the interaction

Key combination on Ubuntu 12.04 is used for
something else. This can be disabled using the
combiz-setti (http://askubuntu.
com/questions/171489/how-to-unbind-shift-alt-up-
shortkey-in-12-04)
After disabling this c
passes

K,

tion this test case

On Ubuntu 14.04, 14.10, this is not an issue, by
default the keys are not mapped.

On Ubuntu, the movement is hectic and the overview
box is very narrow.

On Mac OS X 10.8, the button is not visible but there is
a visible empty space that is clickable in its place.
Clicking on it brings up the overview box which has a
reasonable size but movement is still hectic.

Bug 436442

Getting printer data on my Ubuntu 14.04 hangs
(Printer.getDefaultPrinterData() in SDPrintDialogUl)

The dialog is confusing on Ubuntu. The "from pages"
option do not update directly the values you enter

Works on windows (including CTRL+P) Pass on 16.0«



2.3.0-TraceCompassTestCases - SequenceDiagram

1) Open trace without any sequence diagram information
2) Open SD view if necessary
3) Open Error Log view if necessary
Time Sync. without 4) change time range in Histogram view
5.27  interactions (Bug 391716) 5) Change time current selected time in Histogram View Make sure that no exceptions occurred Manual
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2.3.0-TraceCompassTestCases - StatisticsView

Section ToDo Comment
TMF - Statistics View

Target: Ubuntu 14.04 64 bit

Step Test Case Action Verification Type Comment
1 Preparation
Download traces simple-server-thread1 and simple-server-
Preparation thread1 from traces/import/
1.1 Open Perspective Open and reset LTTng Kernel perspective LTTng Kernel perspective opens with correct views SWTBot Pass
Use menu Window — Show View — Other ... — Tracing —
1.2 Open TMF Statistics View  Statistics Verify that 'Statistics' view is shown SWTBot Pass Path is actually Window -> Show view -> Tracing -> Statistics

1) Create Tracing Project
2) Create Experiment (SegExp)

3) Import 2 traces simple-server-thread1 and simple-server- Verify that statistics are shown per trace and per event
thread2 type. Each trace has 80021 events. Verify that event
4) Select trace type "Generic CTF Trace" types
5) Add these 2 traces to experiment ENTER/RETURN/SEND/RECEIVE/INFO/after_fork_child
1.3 Open experiment are counted. Manual Pass
2 Manage View
2.1 Delete view Close the 'Statistics' View Statistics' view is removed from perspective Manual Pass
2.2 Open view Use menu Window — Show View — Tracing — Statistics Statistics' view View is displayed and re-populated Manual Pass
Verify that statistics are shown per trace and per event
type. Each trace has 80021 events. Verify that event
Open view when types
experiment/trace is 1) Close 'Statistics View' 2) load trace above trace 3) Open ENTER/RETURN/SEND/RECEIVE/INFO/after_fork_child
23 already loaded 'Statistics' view are counted Manual Pass
3 Other

Verify that 'Statistics' view is populated gradually during
3.1 Build of statistic index Open trace indexation Manual Pass

Verify that when opening the trace the x-times (x > 1),
Open same trace multiple times after indexing of trace was that the statistics appear right away without parsing the

3.2 Persistence of statistics  finished the Ffirst time trace again Manual Pass
4 Range Synchronization
External synchronization In any other view that supports range synchronization, select  Events in 'Events in selection' is updated and equals
4.1 (Full) the full range of the trace. 'Events total' values Manual Pass
External synchronization In any other view that supports range synchronization, select a Events in 'Events in selection' is updated according to
4.2 (range) new range. new range Manual Pass
Mutltiple Trace

5 Synchronization
1) Download traces.zip (if necessary) and unzip into a local
directory ${local}
2) Import kernel trace ${local}/traces/import/kernel-
overlap-testing
3) Import UST ${local}/traces/import/trace ust-overlap-

testing
4) Create experiment with trace of 2) in it
Preparation Manual Pass
Open multiple traces (no
5.1 overlap) Open multiple traces that don't overlap in time View shows the last opened trace Manual Pass
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5.2

5.3

5.4

55

5.6
57

2.3.0-TraceCompassTestCases - StatisticsView

Change selected time and In any other view that supports range synchronization, select a Events in 'Events in selection' is updated according to

range (no overlap) new range new range
View is updated to show selected trace. 'Events in
Select other trace (no selection' is updated according to the selected trace's
overlap) Select different trace by clicking its Events editor tab previously selected range.
Open multiple traces
(overlap) Open multiple traces that overlap in time View shows the last opened trace
Change selected time and In any other view that supports range synchronization, select a
range (overlap) new range Events in selection' is updated according to new range
View is updated to show selected trace. 'Events in
Select other trace selection' is updated according to the newly selected
(overlap) Select different trace by clicking its Events editor tab time and range.
Close all traces Close all Events editor tabs View is cleared.
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Manual

Manual

Manual

Manual

Manual
Manual

Patrick: The pie chart doesn't know from which trace
the event comes from. Maybe we could skip events in
the tree that have zero count though?



2.3.0-TraceCompassTestCases - TimeChartView

To Do

Section Comment
TMF - Time Chart View

Target: Ubuntu 14.04 64 bit

Type

Step Test Case Action Verification Type Comment
1 Preparation
1.1 Preparation step 1 Open and reset LTTng Kernel perspective LTTng Kernel perspective opens with correct views. SWTBot Pass
1.2 Preparation step 2 Show Time Chart View Time Chart view is shown Manual Pass
2 Trace handling

Trace #1 entry added to Time Chart view. Trace #1 is
2.1 Open trace Open an LTTng CTF Kernel trace #1 selected entry. Range of view is full trace range. Manual Pass

Trace #2 entry added to Time Chart view. Trace #2 is
selected entry. Range of view is union of full trace
2.2 Open other trace Open an LTTng CTF Kernel trace #2 ranges. Manual Pass

Experiment entry added to Time Chart view. Experiment
is selected entry. Range of view is union of full trace

2.3 Open experiment Open an experiment ranges. Manual Pass
Trace #1 is selected entry. View range does not change.
2.4 Select other trace Select trace #1 by clicking its trace entry in Time Chart view Trace #1 editor tab is brought to top. Manual Pass
Select other trace
2.5 (external) Select trace #2 by clicking its editor tab Trace #2 is selected entry. View range does not change.  Manual Pass
2.6 Close view Close the Time Chart view Time Chart view is removed from perspective Manual Pass
Time Chart view is displayed and re-populated with
2.7 Open view Show Time Chart view opened traces data Manual Pass
Trace entry is removed from Time Chart view. Range is
2.8 Close trace/experiment  Close trace #2 editor tab. Repeat with experiment editor tab.  view is union of remaining full trace ranges. Manual Pass
2.9 Close last trace Close trace #1 editor tab View is cleared. Manual Pass
3 Time Synchronization
Other views are synchronized to the selected time.
Mouse synchronization Event at or following the selected time is selected in the
3.1 (single time) Left-click on the time chart. The selected time line is updated. event table. Manual Pass

Other views are synchronized to the selected range.
Mouse synchronization Shift-left-click or left-drag on the time chart. The selected time Event at or following the selected time is selected in the

3.2 (time range) range is updated. event table. Manual Pass
External synchronization Selected time line is updated to the event time. If

3.3 (single time) In event table, select an event. necessary, range is updated to show selected time. Manual Pass
External synchronization

3.4 (time range) In event table, select an event range with shift-left-click. Selected time line is updated to the time range. Manual Pass
Zoom Range

4 Synchronization

Mouse wheel

4.1 synchronization Zoom in/out with mouse wheel while holding Ctrl. Other views are synchronized to the new range Manual Pass
Mouse drag zoom

4.2 synchronization Drag zoom with right-button on time chart. Other views are synchronized to the new range Manual Pass
Mouse drag move

43 synchronization Drag move with ctrl-left or middle button on time chart. Other views are synchronized to the new range Manual Pass
Mouse full range

4.4 synchronization Double-click with left button on time chart's time scale. Other views are synchronized to the full range Manual Pass

In any other view that supports range synchronization, select a
4.5 External synchronization new zoom range. View range is updated to the new range Manual Pass
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5.1
5.2
53
5.4

55
5.6

Event Table
Synchronization

Search synchronization
Search cleared

Filter synchronization
Filter cleared

Bookmark
synchronization

Bookmark cleared

Enter a search regex in event table
Clear the search regex in event table
Enter a filter regex in event table
Clear the filter regex in event table

Add a bookmark in event table
Remove the bookmark in event table

2.3.0-TraceCompassTestCases - TimeChartView

Matching events are marked in time chart

Marks are removed in time chart

Non-matching events are removed from time chart
All events are shown in time chart

Bookmarked event is marked in time chart
Mark is removed in time chart
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Manual
Manual
Manual
Manual

Manual
Manual



Section
TMF - Custom Parsers
Target: Linux 64

Step Test Case

0 Prerequisites

0.1  Get custom parser definition and logs

-

View management

1.1 Open perspective

1.2 Import custom parser definitions

1.3 Import custom traces
2 Custom parser management

2.3.0-TraceCompassTestCases - Custom Parsers

Pass

Action

Find text and XML parser definitions in
Traces.zip/traces/customParsers and logs
in /import

Open and reset Tracing perspective, and
open Time Chart view

Create a tracing project, open Manage
Custom Parsers dialog and import text
and XML custom parser definitions

Create a tracing project and import a text
and XML custom trace

Open Manage Custom Parsers dialog in

2.1 Open Manage Custom Parsers dialog Traces folder context menu

2.2 New (text)
2.3 Edit (text)

2.4  Export (text)
2.5 Delete (text)

2.6  Import (text)

2.7 New (XML)

2.8 Edit (XML)

2.9 Export (XML)
2.10  Delete (XML)

Select "Text" radio button, click New...
button, enter Trace type, change stuff,
click Next, click Finish

Select custom parser, click Edit..., change
stuff, click Next, click Finish

Select custom parser, click Export, enter
name, click Save

Select custom parser, click Delete

Click Import, find custom parser definition,
click Open

Select "XML" radio button, click New...
button, enter Log Type, write an xml log in
the input,
<a><b><c>1</c><d>1</d></b><b><c>2</
c><d>1</d></b></a> then click on the
"feeling lucky" button. Set b to log entry,
set ¢ to timestamp logged and d to
message logged, set timestamp format to
ss in both text boxes, click Next, click
Finish

Select custom parser, click Edit..., change
stuff, click Next, click Finish

Select custom parser, click Export, enter
name, click Save

Select custom parser, click Delete

Fail

Verification

Time Chart view opens.

Custom parsers imported (TmfGeneric,
Custom XML Log)

Traces imported in Traces folder of project
(ExampleCustomTxt.log,
ExampleCustomXml.xml) and have their trace
type auto-selected.

Dialog opens.

Custom parser appears in list.

Previously entered data appears, can be
edited.

Exported custom parser stored in file system.
Custom parser is deleted.

Imported custom parser appears in list.

Custom parser appears in list.

Previously entered data appears, can be
edited.

Exported custom parser stored in file system.
Custom parser is deleted.

Type To Do
6 0

Type
SWTBot Pass
Manual Pass
Manual Pass
SWTBot Pass
SWTBot Pass
SWTBot Pass
Manual Pass
SWTBot Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
SWTBot Pass

Comment
4

Comment

If you export to an existing .xml that is not an XML
custom parser file, the export is ignored without
warning to the user. Patrick: Bug 49054 opened.



2.1

3.1

3.2
3.3

3.4

3.5

3.6
3.7

3.8
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4.2

4.3

4.4

4.5

4.6

Import (XML)
Custom parser trace handling
Select trace type (text)

Open trace (text)
Raw view (text)

Time synchronization (text)

Select trace type (XML)

Open trace (XML)
Raw view (XML)

Time synchronization (XML)

Raw viewer

Show Raw Viewer
Hide Table

Show Table

Select Event (Bug 457852)

Select Event using arrow keys
(457852)

Hide Raw viewer

2.3.0-TraceCompassTestCases - Custom Parsers

Click Import, find custom parser definition,
click Open

Select test file in Traces folder, right-click,
select "Select Trace Type > Custom Text
> (parser name)"

Double-click on test file in Traces folder
Right-click in editor, click Show Raw

Click in Time Chart view, select event in
editor table, select event in raw view

Select test file in Traces folder, right-click,
select "Select Trace Type > Custom XML
> (parser name)"

Double-click on test file in Traces folder
Right-click in editor, click Show Raw

Click in Time Chart view, select event in
editor table, select event in raw view

1) Open Custom text trace

2) Right-click in table and select "Show
Raw"

Right-click in table and select "Hide
Table"

Right-click in raw viewer and select "Show
Table"

Select event in raw viewer

1) select event in raw viewer with mouse
2) use arrow key down and up several
times

Right-click in table and select "Hide Raw"

Imported custom parser appears in list.

Trace type is assigned (re-open Select Trace
Type sub-menu to verify)

Editor opens with events table, Time Chart
view is populated.

Editor is split with raw view on right pane.

All three widgets synchronize to selected
time.

Trace type is assigned (re-open Select Trace
Type sub-menu to verify)

Editor opens with events table, Time Chart
view is populated.

Editor is split with raw view on right pane.

All three widgets synchronize to selected
time.

Raw viewer is shown beside the events table

Events table is hidden and only raw viewer is
shown

Events table is shown beside raw viewer

Correct event is select in table, timestamp is
propagated to other TMF views and
Properties view shows content of selected
event

Correct event is select in table, timestamp is
propagated to other TMF views and
Properties view shows content of selected
event

Raw viewer is hidden and only events table is
shown
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Or select the trace and verify the trace type in the
Manual

properties view

Manual
Manual

Manual selection in raw view is hard to see

Manual

Manual
Manual

Manual

should this be in events editor?

Manual
Manual

Manual
Manual

Manual

Manual




2.3.0-TraceCompassTestCases - State System Explorer

Section Pass Fail Type ToDo Comment
TMF - State System Explorer 14
Target: Ubuntu 14.04 64 bit

Step  Test Case Action Verification Comment Test that will make this swtbot

1 Preparation

Open TMF State System Explorer Use menu Window — Show View — Tracing — State System
1.1 View Explorer Verify that 'State System Explorer' view is shown SWTBot | Pass 84711

2 Manage View

2.1 Delete view Close the State System Explorer' View 'State System Explorer' view is removed from perspective SWTBot | Pass 84711
Use menu Window — Show View — Tracing — State System
2.2 Open view Explorer 'State System Explorer' view is displayed and re-populated SWTBot | Pass 84711
Verify that view is populated with kernel state system (o.e.t.analysis.os.linux.
2.3 Open Trace Open an LTTng Kernel Trace kernel) and statistics state systems (o.e.l.tmf.statistics.*) of opened trace SWTBot | Pass  Some state systems ID's should be renamed for Trace Compass 84711
1) Close State System Explorer View
Open view when trace is already 2) Load LTTng trace
24 loaded 3) Open 'State System Explorer' view Verify that view is populated with state systems from trace SWTBot | Pass  (if the state system were already built) 84711
The values are only available for time ranges where the trace
exists. Only after we've "visited" other timestamps, then the
attributes show up and print "Out of range". http:/eclip.se/443653
X L - Bruno : I find the separation weird, and sincce I never used this
Verify that view is populated with all kernel state system and statistics state view i'd like someone else to test this item. (Only the items in the
2.5  Open Experiment Open Experiment with 2 or more LTTng traces systems of opened experiment (separated by trace) Manual | Pass | second trace are expendable)
View is updated to show selected trace. State values, start time and end time are
2.7 Select other trace Select different trace by clicking its Events editor tab updated according to the selected trace's previously selected range. Manual | Pass
2.6 Restart Restart Eclipse Verify that view is populated with state systems from trace Manual | Pass
2.7 Close all traces Close traces and experiment one by one from the editor tab Verify that state system explorer view is cleared after closing the last trace Manual | Pass

3 Timestamp / Time Range Selection
Select time in another view (e.g Histogram view) that supports
3.1 Select timestamp time synchronization Verify that state values are updated Manual | Pass
Select a time range in another view that supports time Verify that only the start of the range is taken in consideration (changing the end
3.2 Select time range synchronization time of the range should not affect the displayed values) Manual | Pass
4 Displaying of Changed Values
Attributes whose value changed in the last timestamp selection should be
4.1  Highlighting of changed values Select many different timestamps one after the other highlighted in yellow. Manual | Pass
“Only Display Changes at Selected ~ Enable the “Only Display Changes at Selected Timestamp™
Timestamp™ option with event option with the toolbar button. Select different Events from the
42 selection Event Table. Verify that only the state values that changed because of that event are displayed. Manual | Pass

Enable the “Only Display Changes at Selected Timestamp”
“Only Display Changes at Selected  option. Select *timestamps* corresponding to state changes (for
Timestamp” with timestamp example, using the previous/next buttons in the Control Flow
selection View). Verify that only the state values that changed at that timestamp are displayed. Manual | Pass
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Section
TMF - Call Stack View

Target: Windows 7 64 bit

Step

Test Case

2.3.0-TraceCompassTestCases - Call Stack View

Action

Fail

Verification

To Do Comment

Comment

1

12

1.3
1.4

2
2.1

22
23

24

25
2.7
2.6

2.7

3.1

32
33
3.4
35

4.1

42
43

5.1

Download the test resources
Preparation

Open TMF Call Stack View

Import generic trace

Import cyg-profile trace
Import cyg-profile-fast trace

Manage View
Delete view

Open view
Open Trace

Open view when trace is already loaded

Open Experiment
Select other trace
Restart

Close all traces

Navigation

Select time

Select Previous/Next Event
Zoom to function (table)
Zoom to function (time graph)
Go to first event in trace

Synchronization

Time synchronization

Event synchronization
Time range synchronization

Function name import - Text file

Invalid text file import

Download this

Use menu Window — Show View — Other ... — Tracing —
Call Stack

Import a trace that does not have any call stack information, like a
standard kernel trace

Import the trace in the "trace" directory of the downloaded zip
Import a trace in the "trace-fast" directory of the downloaded zip

Close the Call stack view' View

Use menu Window — Show View — Other ... — Tracing —
Call Stack

Open "trace(-fast)" trace

1) Close 'Call Stack' view

2) Open "glxgears-cyg-profile(-fast)" trace located in the git in ctf
test

3) Open 'Call Stack' view

Open Experiment with 2 or more Call Stack traces.

(You can use both traces)

Select different trace by clicking its Events editor tab

Restart Eclipse with Call Stack trace opened

Close traces and experiment one by one from the editor tab

Click on random time in the time graph pane

Click Previous/Next Event button

Double-click on a function in the table pane

Double-click on a function (interval) in the time graph pane
Go to events editor, press home

Select a random time in another view

Select a call stack-impacting event (function entry/exit) in events
table

Select a new time range in Histogram view.

Open 'trace' from Fibonacci.zip. Click the "Import a textfile..."
button in the view. Select a random file that does not contain any
debugging info.

Verify that 'Call Stack' view is shown

Verify that nothing is shown in the view, except “Stack info not available
(<tracename>)”

Verify that the Callstack View is populated with some callstack information.
Verify that the Callstack View is populated with some callstack information.

'Call Stack' view is removed from perspective

'Call Stack' view is displayed and re-populated
Verify that view is populated with call stack information

Verify that view is populated with call stack information

Verify that view is populated with all call stack information (separated by trace).
View is updated to show selected trace.
Verify that view is populated with call stack from trace

Verify that Call Stack view is cleared after closing the last trace

Selected time line is updated. Table is updated to show the full stack information
at the selected time. Selected time is updated in other views.

Previous or next call stack change is selected and corresponding active function
and stack depth is selected. Table is updated to show the full stack information at
the selected time. Selected time is updated in other views.

Time range is updated to the full duration of the selected function
Time range is updated to the full duration of the selected function
the call stack view is updated

Selected time line is updated. Table is updated to show the full stack information
at the selected time. If selected time is outside current range, time range is
updated to include it.

In addition to updating the selected time, the active function at the event time is
selected. Vertical scroll bar is updated if necessary.

Time range is updated.

The function addresses do not change.
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SWTBot

Manual

SWTBot
SWTBot

Manual

SWTBot
SWTBot

SWTBot

Manual
Manual
Manual

Manual

SWTBot

SWTBot
SWTBot
SWTBot
Manual

SWTBot

SWTBot
SWTBot

Manual

Pass

Pass

Pass
Pass

Pass

Pass
Pass

Pass

Pass
Pass
Pass

Pass

Pass

Pass
Pass
Pass
Pass

Pass

Pass
Pass

Pass

Path is actually Window -> Show view -> Tracing -> Call stack

See comment 1.1. about the path

Fixed in https://git.eclipse.org/t/#/c/80177/1

The vertical scroll bar is not updated(Sonia: only when you select
a rendom time in the histogram view).If you select an event (in
another view)before the start of the calls, the vertical scroll bar
goes down.


https://drive.google.com/file/d/0BxUCnNTRLr5pWUdXd0JJV3hyeEk/edit?usp=sharing
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6.1
6.2

Valid text file import

Function name import - CDT

Binary import
Binary import lttng 2.8+

2.3.0-TraceCompassTestCases - Call Stack View

The symbol mapping is applied on view level. If multiple traces
are opened, or if an experiment with multiple traces is opened,
they cannot each have their own mapping. Bug 459909.
. . . . . . France : I am not sure what to do here Sonia : The bug is resolved
The view now displays function names instead of function addresses (both in the ., you can specify a mapping file for each trace if you have a

Import a file "fibonacci.symbols" timegraph and the call stack areas). SWTBot multiple traces in one experiment.

Sonia :you have to specify the binary file for each trace.The view
won't display the function names for the both traces if we select

Click the. "Import Binary..." b“ltmn in the view, select the . . k the fibonacci executable for a trace in an experiment with multiple
fibonacci executable (fibonacci) The view now displays the function names for both traces Manual traces.
Open an lttng 2.8+ trace with the executable present The view now displays the function names for the trace Manual
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2.3.0-TraceCompassTestCases - GDBTracing

Section Pass Fail Type ToDo Comment

GDB Tracing 25 | s | o 1

Target: Ubuntu 16.04 64 bit

GDB 7.11.1
Step Test Case Action Verification Type Comment
1 Preparation
1.1 Step 1 Open and reset the GDB Trace perspective GDB Trace perspective opens with correct views Manual Pass
1.2 Step 2 Open Navigator View (used for independent verification) Navigator View opens Manual Pass
2 Project Creation
2.1 New Project Wizard Open New Tracing Project Wizard Tracing Project Wizard opens SWTBot Pass
2.2 Create project Specify a project name and finish Tracing project appears in Project Explorer SWTBot Pass
2.3 Project structure Close and open the new Tracing project Project contains the Traces folder SWTBot Pass
3 Traces Folder
3.1 Traces Folder menu Select the Traces folder and open its context menu Correct menu opens (Open Trace, Import, New Folder, ...) SWTBot Pass
3.2 Trace Import Wizard Select Import Trace Trace Import Wizard appears SWTBot Pass
3.3 Import traces Select a GDB Trace from samples directory and finish Imported traces appear in Folders with proper icon Manual Pass  Where was the trace located?
4 Trace Configuration

Verify that an Error Dialog opens that notfiies the user to select the
4.1 Project/executable selection  Double-click on an un-configured trace trace executable Manual Pass

1) Right mouse click on trace
2) Select menu item "Select Trace Executable"

4.2 Select Trace Executable 3) Fillin the proper values in dialog and finish Trace is configured (4.3 is successful, when 4.2 was successful) Manual Pass
4.3 Open configured trace Double-click on a configured trace Trace is opened, events table and views are populated Manual Pass
5 Source Code Lookup
The corresponding source code location is selected in the source
5.1 Select event With mouse select an event in events table code file. Manual Pass
The corresponding source code location is selected in the source
5.2 Select another event redo 5.1 code file. Manual Pass
6 Events Table Navigation

Each keystroke modifies the selected event and the corresponding
6.1 Arrow keys Update the current event using up/down keys within window  source code location is selected in the source code File. Manual Pass

Table is refreshed to display new current event and the
corresponding source code location is selected in the source code

6.2 Scrolling Update the current event using up/down keys outside window file Manual Pass
6.3 PgUp/PgDn Update the current event using PguUp/PgDn keys Table is scrolled accordingly Manual Pass
Table jumps from first to last event and the corresponding source

6.4 Home/End Update the current event using Home/End keys code location is selected in the source code file Manual Pass
7 Events Searching & Filtering

71 Search In the search bar, enter some RE Events corresponding to the RE are highlighted Manual Pass
7.2 Navigation Navigate through highlighted events using Enter/Shift-Enter  Next/previous highlighted event selected accordingly Manual Pass
7.3 Un-search In the search bar, clear the RE Events are displayed normally Manual Pass
7.4 Filter In the search bar, enter some RE and press Ctrl+Enter Only events matching RE are displayed Manual Pass
7.5 Filter & Search In the filter bar, enter some RE; likewise in the search bar Events are filtered and highlighted accordingly Manual Pass
7.6 Un-filter In the filter header, remove the filter Events are displayed normally Manual Pass
8 Events Synchronization

8.1 Synch from Events View Click on an event in the Events View Trace Control View is updated; Debug View is updated Manual Pass
8.2 Synch from Trace Control Go up/down from the Trace Control View Events View is updated accordingly Manual Pass



2.3.0-TraceCompassTestCases - TMF - Remote Fetching

Section To Do Comment

TMF - Remote Fetching
Target: Ubuntu 14.04 64 bit

Step Test Case Action Verification Type Comment
1 Preparation
1.1 Step 1 Open Trace Compass and reset Lttng perspective Lttng perspective opens with correct views
2 Opening
. . Bruno : Not this test, but the Fetch Remotes
Right-click on Traces Folder -> Fetch Remote Traces ... -> Traces dialog, has a help button that does
2.1 Open Profile Editor 1 Manage Profiles The Profile Editor of preference page opens SWTBot Pass nothing. Patrick: See Bug 440238.
2.2 Open Profile Editor 2 Window -> Preferences-> Tracing -> Remote Profiles The Profile Editor of preference page opens SWTBot Pass
3 Edit Profile - Add/Delete
Open Profile Editor > Click on 'Add' > Enter profile name,
3.1 Create Profile remote information, root path and trace pattern New Profile is created and template is provided SWTBot Pass
Select Profile node > right mouse click > select 'New New Connection Node is create under the profile and
3.2 Add Node Connection Node' template is provided SWTBot Pass
Select node node > righ mouse click > select 'New Trace New Trace Group is created under the node and template is
33 Add trace group Group' provided SWTBot Pass
New Trace is created under Trace Group and template is
3.4 Add trace Select trace group > right mouse click > select 'New Trace' provided SWTBot Pass
35 Delete Trace Select trace > right mouse click > select Delete Trace is deleted SWTBot Pass
3.6 Delete Trace Group Select Trace Group> right mouse click > select Delete Trace Group is deleted Manual Pass
3.7 Delete Connection Node Select Connection Node > right mouse click > select Delete Connection Node is deleted Manual Pass
3.8 Remove Profile Select Profile > click on 'Remove' button Profile is deleted SWTBot Pass
4 Edit Profile - Reorder
Create at 2-3 profiles > select 2nd profile and press buttons
4.1 Move profile up/down 'Move Up'/'Move Down' Profiles are moved up and down Manual Pass
Move connection node Make sure that there are 2 or 3 connection nodes > select 1
4.2 up/down connection node > click buttons 'Move Up'/'Move Down' Connection Nodes are moved up and down within a profile Manual Pass
Make sure that there are 2 or 3 trace gropus > select 1 trace  Trace Groups are moved up and down within a connection
4.3 Move Trace Group up/down group > click buttons 'Move Up'/'Move Down' node Manual Pass
Make sure that there are 2 or 3 trace groups > select 1 traces
4.4 Move Trace up/down > click buttons 'Move Up'/'Move Down' Traces are moved up and down within a Trace Group SWTBot Pass
5 Edit Profile - Copy, Cut, Paste

Select Profile > click right mouse button on a profile > Select
Copy -> click right mouse button on other profile > Select
5.1 Copy/Paste Profile Paste Profile is pasted under the selected profile Manual Pass
5.2 Copy/Paste Profile (Keys) Redo 5.1 with CTRL+C and CTRL+V keys Profile is pasted under the selected profile Manual Pass
Select Profile > click right mouse button on a Connection
Node > Select Copy -> click right mouse button on other

5.3 Copy/Paste Connection Node Connection Node > Select Paste Profile is pasted under the selected Connection Node Manual Pass
Copy/Paste Connection Node
5.4 (Keys) Redo 5.3 with CTRL+C and CTRL+V keys Profile is pasted under the selected Connection Node Manual Pass

Select Profile > click right mouse button on a Trace Group >
Select Copy -> click right mouse button on other Trace Group
5.5 Copy/Paste Trace Group > Select Paste Profile is pasted under the selected Trace Group Manual Pass
5.6 Copy/Paste Trace Group (Keys) Redo 5.5 with CTRL+C and CTRL+V keys Profile is pasted under the selected Trace Group Manual Pass
Select Profile > click right mouse button on a Trace > Select
Copy -> click right mouse button on other Trace > Select

5.7 Copy/Paste Trace Paste Profile is pasted under the selected Trace SWTBot Pass
5.8 Copy/Paste Trace (Key) Redo 5.5 with CTRL+C and CTRL+V keys Profile is pasted under the selected Trace Manual Pass
5.9 Cut/Paste Redo 5.1 - 5.8 with cut and paste Successful cut and paste Manual Pass Trace (5.7) is done with SWTBot
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6.1
6.2

6.3

6.4
6.5

6.6
6.7
6.8
6.9

71
7.2

73

8.1

8.2

8.3

8.4

Edit Profile - Adverserial
Error empty profile name
Duplicate profile name

Error empty Connection node
name

Duplicate Connection node
name

Missing username in URI

Invalid URI

Error empty Trace Group
Error empty Trace
Invalid File pattern

Export/Import Profile

Export Profile
Import Profile

Import Profile

Remote Fetch Wizard

Preparation

Create and run Profile "new
Profile" (syslog + synthetic CTF
trace in sub-directory)

Clear traces

Create and run Profile "new
Profile" (syslog + synthetic CTF
trace in sub-directory), only 1
trace selected

Clear traces

Run Profile "TestAllRecursive"

2.3.0-TraceCompassTestCases - TMF - Remote Fetching

Clear profile name
Add profile with name of existing profile

Clear Connection node name

Within a profile, add Connection node with name of existing
node

remove user name of a Connection Node

add invalid URI

Delete Trace Group root path

Delete File Pattern

Add trace with invalid regular expression

Select multipe profiles > Click Export Button > Select Folder
and enter file name > OK

Click on Import Button > select profile XML file > OK

Redo 7.2

1) Import Test Profiles (test-profiles.xml) from test spec.
template directory

2) Edit profiles in Fetch Remote Traces > Manage profiles
3) Change 'user' and '127.0.0.1" for all connection nodes if
necessary

3) Extract traces.zip from test spec. template directory in
/tmp

4) Load custom text parsers located in traces.zip
(traces/customParsers)

1) Create traces in /tmp/traces/syslog and
/tmp/traces/generated/synthetic-trace

2) Create Profile with Local connection, 1 trace group (root
/tmp/traces/) and 2 traces (.*syslog.* and .*synthetic.*) in this
group

3) Select profile in Fetch Remote Traces wizard (Remote
Profile page)

4) Click on 'Next' button

5) Click on 'Finish'

Delete all traces from Traces directory

1) Create traces in /tmp/traces/syslog and
/tmp/traces/generated/synthetic-trace

2) Create Profile with Local connection, 1 trace group (root
/tmp/traces/) and 2 traces (.*syslog.* and .*synthetic.*) in this
group

3) Select profile in Fetch Remote Traces wizard (Remote
Profile page)

4) Click on 'Next' button

5) deslect the synthetic CTF trace

5) Click on 'Finish'

Delete all traces from Traces directory

1) Select profile "TestAllRecursive" in Fetch Remote Traces
wizard (Remote Profile page)

2) Click on 'Next' button (enter password if needed)

3) Click on 'Finish'

Error message "Profile must not be empty"
Error message "<name>: Duplicate profile name"

Error message "Node name must not be empty"

Error message "Duplicate node names"
Error message "URI must include user information"

Error message "URI must include valid host and port
number" or "Unsupported URI scheme"

Error message "Root path must not be empty"
Error message "File pattern must not be empty"
Error message "Invalid file pattern"

Only selected profiles are exported
Profiles are imported

after second import an error message appears "Duplicate
profile names"

Verify that all test traces are imported with correct trace
types assigned. Verify that folder structure is preserved.

All traces deleted

Verify that only the selected traces are imported with
correct trace types assigned. Verify that folder structure is
preserved.

All traces deleted

Verify that all test traces are imported with correct trace
types assigned (LTTng kernel, LTTng UST, custom text,
custom XML). The file unrecognized.log is importeds with
unrecognized trace type. Make sure that directory structure
is preserved.
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Local connection is used in SWTBot

Local connection is used in SWTBot



8.5

8.6

8.7

8.8

8.9

8.10

8.11

8.12

8.14

Re-run Profile
"TestAllRecursive" (Rename)

Re-run Profile
"TestAllRecursive" (Overwrite)

Re-run Profile
"TestAllRecursive" (Skip)

Re-run Profile
"TestAllRecursive" (Overwrite
2)

Clear traces

Re-run Profile
"TestAllRecursive" (2)

Clear traces

Run Profile
"TestAllNonRecursive

Clear traces

Run Profile
"TestSpecificRecursive"

Clear traces

Run Profile
"TestSpecificNonRecursive"

Clear traces

Run Profile
"TestSpecificMutliGroupRecurs
ive"

Clear traces

Cancel Import
Clear traces

2.3.0-TraceCompassTestCases - TMF - Remote Fetching

1) Select profile "TestAllRecursive" in Fetch Remote Traces
wizard (Remote Profile page)

2) Click on 'Next' button (enter password if needed)

3) Click on 'Finish'

4) In dialog box select 'Rename’ for the first trace and
'Rename ALL' for the second traces

1) Select profile "TestAllRecursive" in Fetch Remote Traces
wizard (Remote Profile page)

2) Click on 'Next' button (enter password if needed)

3) Click on 'Finish'

4) In dialog box select 'Overwrite' for the first trace and
'Overwrite ALL' for the second traces

1) Select profile "TestAllRecursive" in Fetch Remote Traces
wizard (Remote Profile page)

2) Click on 'Next' button (enter password if needed)

3) Click on 'Finish'

4) In dialog box select 'Skip' for the first trace and *Skip ALL'
for the second traces

1) Select profile "TestAllRecursive" in Fetch Remote Traces
wizard (Remote Profile page)

2) Select checkbox 'Overwrite traces without warning'

3) Click on 'Next' button (enter password if needed)

4) Click on 'Finish'

Delete all traces from Traces directory

1) Select profile "TestAllRecursive" in Fetch Remote Traces
wizard (Remote Profile page)
2) Click on 'Finish' (enter password if needed)

Delete all traces from Traces directory

1) Select profile "TestAllNonRecursive" in Fetch Remote
Traces wizard (Remote Profile page)

2) Click on 'Next' button (enter password if needed)

3) Click on 'Finish'

Delete all traces from Traces directory

1) Select profile "TestSpecificRecursive" in Fetch Remote
Traces wizard (Remote Profile page)

2) Click on 'Next' button (enter password if needed)

3) Click on 'Finish'

Delete all traces from Traces directory

1) Select profile "TestSpecificNonRecursive" in Fetch Remote
Traces wizard (Remote Profile page)

2) Click on 'Next' button (enter password if needed)

3) Click on 'Finish'

Delete all traces from Traces directory

1) Select profile "TestSpecificMultiGroupRecursive" in Fetch
Remote Traces wizard (Remote Profile page)

2) Click on 'Next' button (enter password if needed)

3) Click on 'Finish'

Delete all traces from Traces directory

1) Select profile "TestAllRecursive" in Fetch Remote Traces
wizard (Remote Profile page)

2) Click on 'Next' button (enter password if needed)

3) Click on 'Finish'

4) Cancel import (red square or Cancel button)

Delete all traces from Traces directory

Verify that all test traces are imported with new name and
correct trace types assigned (LTTng kernel, LTTng UST,
custom text, custom XML). The file unrecognized.log is
importeds with unrecognized trace type. Make sure that
directory structure is preserved.

Verify that all test traces are imported with correct trace
types assigned where old traces are overwritten. (LTTng
kernel, LTTng UST, custom text, custom XML). The file
unrecognized.log is importeds with unrecognized trace
type. Make sure that directory structure is preserved.

Verify that all test traces are skipped and no trace is
imported

Verify that all test traces are imported with correct trace
types assigned where old traces are overwritten (no dialog
box opens). (LTTng kernel, LTTng UST, custom text, custom
XML). The file unrecognized.log is importeds with
unrecognized trace type. Make sure that directory
structure is preserved.

All traces deleted

Verify that all test traces are imported with correct trace
types assigned. The second page is omitted. (LTTng kernel,
LTTng UST, custom text, custom XML). The file
unrecognized.log is importeds with unrecognized trace
type. Make sure that directory structure is preserved.

All traces deleted

Verify that only traces from root path are imported (LTTng
kernel, LTTng UST, custom text, custom XML). The file
unrecognized.log is importeds with unrecognized trace
type. Make sure that directory structure is preserved.

All traces deleted

Verify that only kernel and custom text/XML logs are
imported from root and subdirectory. Make sure that
directory structure is preserved.

All traces deleted

Verify that only kernel and custom text/XML logs are
imported from root directory only. Make sure that
directory structure is preserved.

All traces deleted

Verify that only traces from root path are imported (LTTng
kernel, LTTng UST, custom text, custom XML). Make sure
that directory structure is preserved.

All traces deleted

Verify that import operation is cancelled
All traces deleted
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Profile has trace type 'Generic CTF Trace' but
trace imported as 'Linux Kernel Trace'. Patrick:
Looks intentional, see
RemoteGenerateManifestOperation:186.

Profile has trace type 'Generic CTF Trace' but
trace imported as 'Linux Kernel Trace'. Patrick:
Looks intentional, see
RemoteGenerateManifestOperation:186.

Profile has trace type 'Generic CTF Trace' but
trace imported as 'Linux Kernel Trace'. Patrick:
Looks intentional, see
RemoteGenerateManifestOperation:186.



8.15

9.1

9.2

10

10.2

Run Profile "TestMultiNodes"

Connection Handling

Error cannot connect to
remote host (node doesn't
exist)

Error cannot connect to
remote host (wrong password)

Other Remote Backends
Clear traces

Remote Fetch using Local

2.3.0-TraceCompassTestCases - TMF - Remote Fetching

1) Select profile "TestMultiNodes" in Fetch Remote Traces
wizard (Remote Profile page)

2) Click on 'Next' button (enter password if needed)

3) Click on 'Finish'

Create profile with IP address that cannot be connected to
and run profile

Create profile valid IP address. When asked for password
enter invalid password

Delete all traces from Traces directory

Create profile (see 7.3) with URI scheme file (instead of ssh)
and node name Local and redo test 7.3

Verify that only traces from root path are imported (LTTng
kernel, LTTng UST, custom text, custom XML). The file
unrecognized.log is importeds with unrecognized trace
type. Make sure that directory structure is preserved. 2
nodes directories are created with the above traces stored

Operation to connect to remote node fails and error dialog
is shown with detailed information (after time-out)

Operation to connect to remote node fails with time-out
and error dialog is shown with detailed information. Note
time-out is as per remote development preferences

All traces deleted

Verify that all test traces are imported with correct trace
types assigned (LTTng kernel, LTTng UST, custom text,
custom XML). The file unrecognized.log is importeds with
unrecognized trace type. Make sure that directory structure
is preserved.
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Bruno : Not really a bug, but you have to fail your
password 5 times before having the first error
dialog poput. Only then you see the Internal error
Cannot connect <node name>, message. Patrick:
This is the Remote Systems implementation with
retries.

See tests 7.2/7.3



Section
LTTng 2.0 - Control Flow View

Target: Windows

Step
0
0.1

0.2

1.1

1.2

1.2
1.3

14

21

22

23

3.1

3.2

3.3

3.4

Test Case

Prerequisites
Import traces

Create experiment

View management
Open perspective

Open trace

Open experiment
Close view

Open view
View selection
Select process in table

Select process in time graph

Select state in time graph

Mouse handling

Drag move chart area

Zoom time range (mouse wheel)

Zoom time range (mouse drag)

Mouse vertical scroll

2.3.0-TraceCompassTestCases - LTTng 2.0 - ControlFlowView

Action

Import LTTng Kernel traces in Tracing project

Create an experiment with LTTng Kernel
traces

Open and reset LTTng Kernel Perspective

Open LTTng Kernel trace in Project Explorer

Open experiment with LTTng Kernel traces in
Project Explorer

Close the Control Flow view

Open the Control Flow view

Select a process in the table

Select a process in the time graph (empty
region)

Select a state in the time graph

Ctrl-Drag move time graph left and right with
middle button

Zoom with mouse wheel up and down, cursor
inside time graph while holding the Ctl button

Drag in time graph scale left and right with
left button

Scroll with mouse wheel up and down

Verification

Control Flow view opens.

Control Flow view is populated with
processes, sorted by Trace then TID. Child
processes appear under their parent, sorted
by birth time. Range is set to initial offset.
Arrows are drawn between states of a CPU.

Control Flow view is populated with
processes, sorted by Trace then TID. Child
processes appear under their parent, sorted
by birth time. Range is set to initial offset.
Arrows are drawn between states of a CPU.

View is closed.

Control Flow view is opened and populated
with processes.

Same process is highlighted in time graph.

Same process is highlighted in table. Selected
time line is updated. Other views are
synchronized to selected time.

Same process is highlighted in table. State is
highlighted in time graph. Selected time line is
updated. Other views are synchronized to
selected time.

Visible range is dragged. When mouse button
is released, states are updated and new time
range is propagated to other views.

Time range is zoomed in and out, relative to
mouse cursor. When mouse wheel is stopped
for a short time, states are updated and new
time range is propagated to other views.

Time range is zoomed in and out. When
mouse button is released, states are updated
and new time range is propagated to other
views.

Table and time graph scroll up and down and
remain aligned. Selected process does not
change. Vertical scroll bar updated.
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Pass

Pass

Pass
Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Comment

Comment

what is called 'time range' here should actually be called 'windo



35

3.6

3.7

3.8

3.9

3.1

4.1

4.2

5.1

52

5.3

5.4

5.5
5.6

Vertical scroll bar

Drag zoom time range

Double-click reset time range

Mouse hover (empty region)

Mouse hover (state)

Drag mouse selection

Shift key selection

Keyboard handling

Keyboard navigation in time graph
(process selection)

Keyboard navigation in time graph

(state selection)

Tool bar handling

Show Legend

Reset Time Scale
Select Previous/Next Event

Select Previous/Next Process

Zoom In/Out
Filter Dialog

2.3.0-TraceCompassTestCases - LTTng 2.0 - ControlFlowView

Click and drag vertical scroll bar

Drag select time graph with right button

Double-click left button on time scale

Hover mouse in time graph over empty
region

Hover mouse in time graph over state

Drag select time graph with left button

Click select with left button (begin time),
press shift key and click select another time

(end time)

With focus on time graph, use UP, DOWN,
HOME, END keys

With focus on time graph, use LEFT, RIGHT

keys

Click Show Legend button

Click Reset Time Scale button
Click Previous/Next Event button

Click Previous/Next Process button

Click Zoom In/Out button
Open Filter Dialog

Table and time graph scroll up and down and
remain aligned. Selected process does not
change.

Selection highlighted. When mouse button is
released, time range is zoomed to selection,
states are updated and new time range is
propagated to other views.

Time range is reset to full range, states are
updated and new time range is propagated to
other views.

Tool tip shows process name only.

Tool tip shows process name, state name,
date, start time, end time, duration. For
USERMODE state, CPU is shown. For
SYSCALL state, CPU and System Call is
shown. For INTERRUPTED state, CPU is
shown.

Selection highlighted. Status bar of Eclipse is
updated with time information: T, T1, T2 and
delta, where T is the time of the mouse
position, T1 the first selected time, T2 the
second (dragged) selected time and delta the
time difference between T2-T1 (can be
negative)

Selection highlighted. Status bar of Eclipse is
updated with time information: T, T1, T2 and
delta, where T is the time of the mouse
position, T1 the first selected time, T2 the
second (dragged) selected time and delta the
time difference between T2-T1 (can be

“negative)

Selected process is changed. Table selection
is updated. Vertical scroll bar updated.

Previous or next state is selected. Selected

‘time is updated in other views.

The legend dialog is opened and can be
closed.

Time range is reset to full range, states are
updated and new time range is propagated to
other views.

Previous or next state is selected. Selected
time is updated in other views.

Selected process is changed in table and time
graph. Vertical scroll bar updated.

Time range is zoomed in and out, relative to
center of selection or window. States are
updated and new time range is propagated to
other views.

Verify that all buttons are working correctly
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Pro tip: "Uncheck selected" and "Uncheck subtree" do the same



5.7

5.8

5.9

5.12

6.1

6.2

6.3

6.4

71

7.2

Filter Processes

Hide Arrows

Follow CPU Forward

Follow CPU Backward

Optimize

Re-Optimize

Go to next event of selected thread

Go to previous event of selected
thread

Synchronization

Time synchronization

Event synchronization

Window range synchronization

Selection range synchronization

Multiple Trace Synchronization

Preparation

Open multiple traces (no overlap)

Change selected time and range
(no overlap)

2.3.0-TraceCompassTestCases - LTTng 2.0 - ControlFlowView

1) Open Filter Dialog
2) Deselect several processes
3) Press Ok

Click Hide Arrows button

With focus on time graph, click Follow CPU
Forward button

With focus on time graph, click Follow CPU
Backward button

Click on the optimize button

Click on the optimize button a few more times

Select a thread and click on go to next event
of selected thread

Select a thread and click on go to next event
of selected thread

Select a random time in another view

Select a state-impacting event
(sched_switch, syscall, ...) in events table or
in Resources view using Select
Previous/Next event.

Select a new window range in Resources
view or in Histogram view.

In any other view that supports selection
range synchronization, select a new range.

1) Download traces.zip (if necessary) and
unzip into a local directory ${local}

2) Import kernel trace ${local}
/traces/import/kernel-overlap-testing

3) Import UST ${local}
/traces/import/trace ust-overlap-testing
4) Create experiment with trace of 2) in it

Open multiple traces that don't overlap in
time

Select a time and new range

Verify that only selected processes are
displayed in the view

Verify that arrows are not drawn in the time
graph

Time graph is updated to show the next state
for this cpu following the arrow, the event is
selected in the Events editor.

Time graph is updated to show the previous

state for this cpu following the arrow, the
event is selected in the Events editor.

verify that the processes are closer together.

verify that the processes did not move, the
optimization is stable

Verify in the events table that the selected
thread is the same as the previous event

Verify in the events table that the selected
thread is the same as the previous event

Selected time line is updated. If selected time
is outside current range, time range is
updated to include it.

In addition to updating the selected time, the
process containing the state change is
selected and revealed. Vertical scroll bar is
updated if necessary.

Window range is updated.

Selection is highlighted. If the left time (T1) of
selected time range is outside the current
range, then window range is updated to
include it

View shows the last opened trace

Selected time line and time range is updated
to selected time and new range.
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2.3.0-TraceCompassTestCases - LTTng 2.0 - ControlFlowView

Select different trace by clicking its Events

View is updated to show selected trace.
Selected time line and time range are
restored to the selected trace's previously

7.3 Select other trace (no overlap) editor tab selected time and range. Manual
7.4 Open multiple traces (overlap) Open multiple traces that overlap in time View shows the last opened trace Manual
Change selected time and range Selected time line and time range is updated
7.5 (overlap) Select a time and new range to selected time and new range. Manual
View is updated to show selected trace.
Select different trace by clicking its Events  Selected time line and time range are set to
7.6 Select other trace (overlap) editor tab the newly selected time and range. Manual
7.7 Close all traces Close all Events editor tabs View is cleared. Manual
8.1 | Filtering
Preparation Open 2 LTTng Kernel Traces
1) Open filter dialog
2) Create filter Make sure that only selected processes of
8.1 Apply filter (1st trace) 3) Click on OK filter dialog are shown SWTBot
1) Switch to 2nd trace (keep 1st open)
2) Open filter dialog
3) Create filter Make sure that only selected processes of
8.2 Apply filter (2nd trace) 4) Click on OK filter dialog are shown Manual
Make sure that previously set filter are still
8.3 Persitent filter Switch between both open traces available Manual
9 Miscellaneous
1) Open LTTng Kernel Trace
2) Select Control Flow View
9.1 Restart (Bug 409345) 3) Restart Eclipse Verify that Control Flow View is populated Manual
1) Open LTTng UST trace while CFV is open Verify that current window range stays doesn't
9.2 Select single time (Bug 477009)  2) Select event in events table change Manual
1) Open Control Flow view, Resources view
and a kernel trace. Initial window range is
'range 1".
2) Go "right one page" on Control Flow view
by pressing right arrow in scroll bar.
3) Go "left one page" on Resources view by
Window range synchronization pressing left arrow in scroll bar. Verify that after each step the initial window
9.3 (Bug 477012) 4) Go "right one page" on Control Flow view. range doesn't change Manual
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Section
LTTng 2.0 - Resources View

Target: Windows 7

Step
0
0.1

0.2

1.1

1.2

1.2
1.3

14

22

23

3.1

3.2

3.3

3.4

3.5

Test Case
Prerequisites
Import traces
Create experiment
View management

Open perspective

Open trace

Open experiment
Close view

Open view
View selection

Select resource in time graph

Select state in time graph
Mouse handling

D rag move canvas

Zoom time range (mouse wheel)

Zoom time range (mouse drag)

Mouse vertical scroll

Vertical scroll bar

2.3.0-TraceCompassTestCases - LTTng 2.0 - ResourcesView

Action

Import LTTng Kernel traces in Tracing project

Create an experiment with LTTng Kernel
traces

Open and reset LTTng Kernel Perspective,
and select Resources view

Open LTTng Kernel trace in Project Explorer

Open experiment with LTTng Kernel traces in
Project Explorer

Close the Resources view

Open the Resources view

Select a resource in the time graph (empty
region)

Select a state in the time graph

Drag move time graph left and right with
middle button

Zoom with mouse wheel up and down on
header or Ctrl+mousewheel in the time graph

Drag in time graph scale left and right with
left button

Scroll with mouse wheel up and down, cursor
outside time graph (in name space)

Click and drag vertical scroll bar

Verification

Resource view opens.

Resource view is populated with traces
(sorted by name) and their resources as tree
children (sorted by resource type then
numerically) Range is set to initial offset.

Resource view is populated with traces
(sorted by name) and their resources as tree
children (sorted by resource type then
numerically) Range is set to initial offset.

View is closed.

Resources view is opened and populated with
processes.

Resource is highlighted. Selected time line is
updated. Other views are synchronized to
selected time.

State is highlighted in time graph. Selected
time line is updated. Other views are
synchronized to selected time.

Time range is dragged. When mouse button is
released, states are updated and new window
range is propagated to other views.

Time range is zoomed in and out, relative to
mouse cursor. When mouse wheel is stopped
for a short time, states are updated and new
time range is propagated to other views.

Time range is zoomed in and out. When
mouse button is released, states are updated
and new time range is propagated to other
views.

Time graph scrolls up and down. Selected
process does not change. Vertical scroll bar
updated.

Time graph scroll up and down and remain
aligned. Selected process does not change.
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3.6

3.7

3.8

3.9

3.1

4.1

4.2

5.1

52

53

54

5.5

5.6

6.1

Drag select time range

Double-click reset time range

Mouse hover (empty region)

Mouse hover (state)

Drag mouse selection

Shift key selection
Keyboard handling

Keyboard navigation in time graph
(process selection)

Keyboard navigation in time graph

(state selection)

Tool bar handling

Show Legend

Reset Time Scale

Select Previous/Next Event

Select Previous/Next Process

Zoom In/Out

Filter Dialog
Synchronization

Time synchronization

2.3.0-TraceCompassTestCases - LTTng 2.0 - ResourcesView

Drag select time graph with right button

Double-click left button on time scale

Hover mouse in time graph over empty
region

Hover mouse in time graph over state

Drag select time graph with left button

Click select with left button (begin time),
press shift key and click select another time
(end time)

With focus on time graph, use UP, DOWN,
HOME, END keys

With focus on time graph, use LEFT, RIGHT

keys

Click Show Legend button

Click Reset Time Scale button
Click Previous/Next State button

Click Previous/Next Process button

Click Zoom In/Out button

Open Filter Dialog

Select a random time in another view

Selection highlighted. When mouse button is
released, time range is zoomed to selection,
states are updated and new time range is
propagated to other views.

Time range is reset to full range, states are
updated and new time range is propagated to
other views.

Tool tip shows resource name only.

Tool tip shows resource name, state name,
date, start time, end time, duration. For IRQ
state, IRQ number is shown. For
IRQ_ACTIVE/SOFT_IRQ_ACTIVE state, CPU
is shown.On usermode and syscall tool tip
shows also shows hover time, tid and process
name.

Selection highlighted. Status bar of Eclipse is
updated with time information: T, T1, T2 and
delta, where T is the time of the mouse
position, T1 the first selected time, T2 the
second (dragged) selected time and delta the
time difference between T2-T1 (can be
negative)

Selection highlighted. Status bar of Eclipse is
updated with time information: T, T1, T2 and
delta, where T is the time of the mouse
position, T1 the first selected time, T2 the
second (dragged) selected time and delta the
time difference between T2-T1 (can be
negative)

Selected process is changed. Vertical scroll
bar updated.

Previous or next state is selected. Selected

‘time is updated in other views.

The legend dialog is opened and can be
closed.

Time range is reset to full range, states are
updated and new time range is propagated to
other views.

Previous or next state is selected. Selected
time is updated in other views.

Selected process is changed in time graph.
Vertical scroll bar updated.

Time range is zoomed in and out, relative to
center of selection or window. States are
updated and new time range is propagated to
other views.

Verify that all buttons are working correctly

Selected time line is updated. If selected time
is outside current range, time range is
updated to include it.
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Manual

Manual

Manual

Manual

Manual

Manual

Manual

SWTBot

Manual

Manual

Manual

Manual

Manual

Manual

When not zoomed enough, tool tip does not show CPU for
IRQ_ACTIVE/SOFT_IRQ_ACTIVE state.



2.3.0-TraceCompassTestCases - LTTng 2.0 - ResourcesView

Select a new time range in Control Flow view

6.2 Time range synchronization or in Histogram view. Time range is updated. Manual
Selection is highlighted. If begin time (T1) of
Time range selection In any other view that supports range selected time range is outside the current
6.3 synchronisation synchronization, select a new range. range, then time range is updated to include it Manual
7 Multiple Trace Synchronization
1) Download traces.zip (if necessary) and
unzip into a local directory ${local}
2) Import kernel trace ${local}
[traces/import/kernel-overlap-testing
3) Import UST ${local}
[traces/import/trace ust-overlap-testing
4) Create experiment with trace of 2) in it
Preparation
Open multiple traces that don't overlap in
71 Open multiple traces (no overlap) time View shows the last opened trace Manual
Change selected time and range Selected time line and time range is updated
7.2 (no overlap) Select a time and new range to selected time and new range. Manual
View is updated to show selected trace.
Selected time line and time range are
Select different trace by clicking its Events  restored to the selected trace's previously
7.3 Select other trace (no overlap) editor tab selected time and range. Manual
7.4 Open multiple traces (overlap) Open multiple traces that overlap in time View shows the last opened trace Manual
Change selected time and range Selected time line and time range is updated
7.5 (overlap) Select a time and new range to selected time and new range. Manual
View is updated to show selected trace.
Select different trace by clicking its Events  Selected time line and time range are set to
7.6 Select other trace (overlap) editor tab the newly selected time and range. Manual
7.7 Close all traces Close all Events editor tabs View is cleared. Manual
8.1 | Filtering | ‘
Preparation Open 2 LTTng Kernel Traces
1) Open filter dialog
2) Create filter Make sure that only selected processes of
8.1 Apply filter (1st trace) 3) Click on OK filter dialog are shown SWTBot
1) Switch to 2nd trace (keep 1st open)
2) Open filter dialog
3) Create filter Make sure that only selected processes of
8.2 Apply filter (2nd trace) 4) Click on OK filter dialog are shown Manual
Make sure that previously set filter are still
8.3 Persistent filter Switch between both open traces available Manual
9 Miscellaneous
1) Open LTTng Kernel Trace
2) Select Resource View
9.1 Restart (Bug 409345) 3) Restart Eclipse Verify that Resources View is populated Manual
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2.3.0-TraceCompassTestCases - LTTng 2.0 - Control

To Do

Section Type Comment

LTTng 2.0 - Control
View
Target: Ubuntu 14.04 64 bit

LTTng Tools 2.9.4, Built-in
SSH / Local for UST
LTTng Tools 2.6.0, Built-in
SSH for Kernel

Step  Test Case Action Type Comment
0 Prerequisites
For the tests below a Ubuntu machine with LTTng 2.0 installed
(with Ittng tools 2.5.x or later) is required. Make sure that the
root session daemon is running (sudo Ittng list -k) and have one
UST process running (e.g. from Ittng-tools git repository under
tests/hello.cxx) LTTng Tracer Control User Guide: http://wiki.eclipse.org/Li
a) Window — Preferences — General — Network Connections
0.1 Set Proxy b) Set “Active Provider” to “Direct”
1 General
LTTng Kernel perspective opens with correct Control view
1.1 Open perspective Open and reset LTTng Kernel Perspective on the left bottom corner SWTBot
2 Manage View
2.1 Close view Close Control View Control view is removed from perspective Manual
Use menu Window — Show View — Other ... — Lttng —
22 Open Control view Control Verify that Control view is shown SWTBot
3 Connection Handling
Make sure that after 4) the new connection is shown in
1) Click Button 'New Connection... the tree. Verify that the new host is shown in the Control
2) Select Tree item "Built-in SSH" and click on Create view (with 'Connection Name'. After Ssh connection has
3) Enter Connection Name (e.g. MyHost), enter Host Name (a  been established, make sure that Provider and Session
DNS name or IP address), username and password nodes are created in the Control view underneath the
4) Click 'Finish' host. Verify that all active Providers (Kernel and UST
3.1 Create Host Connection 5) In Tree select the newly create connection and click on 'Ok’  providers) are shown under the 'Provider' node. Manual
a) Select host to disconnect and click Button 'Disconnect' Verify that icon for the corresponding node changes to
3.2 Disconnect b) Redo test with context sensitive menu item 'Disconnect' the disconnect icon and all sub-nodes are removed. Manual
Verify that icon for the corresponding node changes to
the connected icon and after successful SSH connection
a) Select host to connect and click Button 'Connect' all data is retrieved form the remote host (Providers,
3.3 Connect b) Redo test with context sensitive menu item 'Connect' sessions etc). Manual
1) Restart Eclipse
2) Click Button 'New Connection...!
3) Select the host previously created Make sure that SSH connection is established and all
4) Select 'Ok'. (Afterwards enter user ID and Password if data is retrieved from the remote host ( (Providers,
3.4 Select Host Connection necessary) sessions etc). Manual
Verify that menu items are shown and enabled/disabled
depending on state:
‘Connect’ (disabled)
Disconnect (enabled)
Node contexts sensitive 1) Connect to remote host Refresh (enabled)
3.5 menu (host connected)  2) select connected node and click right mouse button Delete (disabled) Manual
Verify enable state of view buttons:
'New Connection..." (enabled)
'Connect' (disabled)
‘Disconnect’ (enabled)
'Refresh’ (enabled)
‘Delete’ (disabled)
‘Start' (disabled)
'Stop' (disabled)
'Destroy Session..." (disabled)
View button enable state 1) Connect to remote host (if necessary) 'Record Snapshot' (disabled)
3.6 (host connected) 2) select connected node 'Import..." (disabled) Manual
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LTTng_Tracer_Control

3.7

3.8

3.9

3.10

4.1

4.2

43

4.4

4.5

4.6

4.7

Node contexts sensitive
menu (host
disconnected)

View button enable state
(host connected)

Delete

Create Host Connection
with ssh port

Session Handling
Preparation

Sessions Context
Sensitive Menu

Create Session (default
location)

Create Session (custom
location)

Create Session —
session already exists in
GUI

Create Session —
session already exists
on node

Session Context
Sensitive menu (session
inactive)

2.3.0-TraceCompassTestCases - LTTng 2.0 - Control

1) Disconnect from node
2) select disconnnected node and click right mouse button

1) Disconnect to remote host (if necessary)

2) select disconnected node if necessary

a) Select node to delete (state disconnected) and click on
button 'Delete’

b) Redo test with context sensitive menu item 'Delete’

re-do 3.1 but this time specify a port number other than default
SSH port 22

1) Connect to remote host

Select 'Sessions' in tree and click right mouse button

1) Click right mouse button on 'Sessions'

2) Select 'Create Session..." in the context sensitive menu

3) Enter session name 'MySession', keep 'Session Path' empty
4) Select 'Ok’

1) Click right mouse button on 'Sessions'

2) Select 'Create Session..." in the context sensitive menu
3) Enter session name 'MyOtherSession'

4) enter custom path (/tmp/myTraces) for 'Session Path’
5) Select 'Ok’

1) Click right mouse button on 'Sessions'
2) Select 'Create Session..." in the context sensitive menu
3) Enter session name 'MySession', keep 'Session Path' empty

1) login to the remote host using a command shell

2) type Ittng create newSession and press enter. This will create
a session which is not know by the Control view.

3) Click right mouse button on 'Sessions'

4) Select 'Create Session..." in the context sensitive menu

5) Enter session name 'newSession', keep 'Session Path' empty
6) Select 'Ok’

Select newly created session and click right mouse button

Verify that menu items are shown and enabled/disabled
depending on state:

'Connect’ (enabled)

'‘Disconnect’ (disabled)

'Refresh’ (disabled)

'Delete’ (enabled)

Verify enable state of view buttons:
‘New Connection..." (enabled)
'Connect’ (enabled)
‘Disconnect’ (disabled)
‘Refresh’ (disabled)

‘Delete’ (enabled)

‘Start' (disabled)

'Stop' (disabled)

'Destroy Session..." (disabled)
'Record Snapshot' (disabled)
‘Import..." (disabled)

Verify that host is removed from the control view.

The connection should fail (unless remote is configured
for the specified port)

Verify that menu items are shown and enabled: 'Refresh’,
'Create Session...", Load..." and 'Execute Command Script

Verify that new session is added under the Session tree
node. Verify properties in Properties view (by selecting
the session in the Control view):

'Session name' (=MySession)

'Session Path' (=/home/<user>/traces/MySession_<date
and time>) and 'State' (=INACTIVE)

Verify that new session is added under the Session tree
node. Verify properties in Properties view (by selecting
the session in the Control view):

'Session name' (=MyOtherSession)

‘Session Path' (=/tmp/myTraces) and 'State’
(=INACTIVE)

Make sure that an error message appears in the
message area of the dialog box with information that
session 'MySession' already exists in the tree.

Verify that an error dialog box will show with information
that command to create a session failed. session already
exists on the node. Select 'Details": Verify that the
command error detail is shown (with return value (28))
Verify context sensitive menu items:

'Refresh’ (enabled)

'Start' (enabled)

'Stop' (disabled)

'Destroy Session..." (enabled)

‘Import..." (enabled)

'Save...' (enabled)

'Enable Channel...' (enabled)

'Enable Event (default channel)...' (enabled)

'Record Snapshot' (disabled)
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Manual

Manual

Manual

Manual

SWTBot

Manual

Manual

Manual

Manual



4.8

4.9

4.10

4.1

4.12

5.1

52

53

5.4

55

5.6

View button enable state
(session inactive)

Start Session

Session Context
Sensitive menu (session
active)

View button enable state
(session active)

Destroy Session

Kernel Channel
Handling

Preparation

Enable Channel on
session level (default
values)

Enable Channel on
domain level (changed
values)

Enable Channel —
channel already exists

Domain Context
Sensitive menu

Channel Context
Sensitive menu

2.3.0-TraceCompassTestCases - LTTng 2.0 - Control

Select newly created session (enable an event before)

a) Enable an event
b) Select session and click on button 'Start'
c) Redo test with context sensitive menu item 'Start'

Select started session and click right mouse button

Select started session

1) In the Control view select session 'MyOtherSession'
2) Click right mouse button

3) select 'Destroy Session..." in the context sensitive menu

4) Select 'Ok’ in the confirmation dialog box

1) Connect to remote host
2) Create new Session 'MyOtherSession’
1)

Select session and right mouse click
2) Select menu item 'Enable Channel...'

3) Enter Channel name (e.g. myChannel) and keep default

values
4) Select Kernel
5) Click on 'Ok’

1) Select domain 'Kernel' and right mouse click
2) Select menu item 'Enable Channel..."

3) Enter Channel name (e.g. MyOtherChannel)
4) Change values

5) Click on 'Ok’

1) Select domain 'Kernel' and right mouse click

2) Select menu item 'Enable Channel'

3) Enter Channel name (e.g. MyOtherChannel) and keep
default values

4) Click on 'Ok’

Select domain 'Kernel' and click right mouse button

Select channel 'MyChannel' and click right mouse button

Verify enable state of view buttons:
‘New Connection..." (enabled)
'Connect' (disabled)
‘Disconnect’ (disabled)
'Refresh’ (enabled)

‘Delete’ (disabled)

‘Start' (enabled)

'Stop' (disabled)

'Destroy Session..." (enabled)
'Import..." (enabled)

'Record Snapshot' (disabled)

Verify that Session icon changes to 'ACTIVE' icon. Verify
that property view shows 'ACTIVE' for the session state

Verify context sensitive menu items:
‘Refresh’ (enabled)

‘Start’ (disabled)

'Stop' (enabled)

'‘Destroy Session..." (disabled)

'Import..." (disabled)

'Enable Channel..." (disabled)

'Enable Event (default channel)...' (disabled)

Verify enable state of view buttons:
‘New Connection..." (enabled)
‘Connect’ (disabled)

‘Disconnect’ (disabled)

‘Refresh’ (enabled)

'Delete’ (disabled)

'Start' (disabled)

'Stop' (enabled)

'Destroy Session...' (disabled)
‘Import..." (disabled)

Verify that session is removed from the control view.

Verify that domain 'Kernel' is created under session and
channel is added under the domain. Verify that default
values for the channel are displayed in the Properties
view after selecting the channel in the tree.

Verify that channel is added under the domain. Verify that
correct values for the channel are displayed in the
Properties view after selecting the channel in the tree.

Verify that error dialog box is opened notifying that
channel already exists.

Verify context sensitive menu items:
'Refresh’ (enabled)

'Enable Channel...' (enabled)

'Enable Event (default channel)...' (enabled)
'Add Context...” (enabled)

Verify context sensitive menu items:
'Refresh’ (enabled)

'Enable Channel' (disabled)

'Disable Channel' (enabled)

'Enable Event (default channel)...' (enabled)
'Add Context...” (enabled)
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SWTBot

Manual
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57

5.8

6.1
6.2

71

72

7.3

7.4

7.5

76

7.7

7.8

Disable Channel

Enable Channel

UST Channel Handling

Enable Channel on
session level (default
values)

Enable/Disable Channel

Kernel Event Handling

Enable Event on session
level (all tracepoints)

Enable Event on domain
level (syscalls)

Enable Event on
Channel level (Dynamic
Probe)

Enable Event on
Channel level (Dynamic
Function Probe)

Disable Event

Enable Event (tracepoint
events)

Enable Event (probe
events)

Enable Tracepoint Event
using filter in tree (Bug
450526)

2.3.0-TraceCompassTestCases - LTTng 2.0 - Control

1) Select channel '"MyChannel' and click right mouse button
2) Select 'Disable' menu item

1) Select channel 'MyChannel' and click right mouse button 2)
Select 'Enable’ menu item

1) Select session and right mouse click
2) Select menu item 'Enable Channel...'
3) Enter Channel name 'MyChannel'

4) Select UST

5) Click on Button 'Default'

5) Click on 'Ok’

Redo tests 5.7 and 5.8 with UST channel

1) Select session and click right mouse button

2) Select menu item 'Enable Events (default channel)...'
3) Select 'Kernel'

4) Select Radio button for ‘Tracepoint Events'

5) Select top level tree node 'All'

6) Click on Ok

1) Select domain Kernel and click right mouse button
2) Select menu item 'Enable Events (default channel)...'
3) Select 'Kernel'

4) Select Radio button for 'All Syscalls'

5) Click on Ok

1) Select a channel (e.g. channel0) and click right mouse button
2) Select menu item 'Enable Events..."

3) Select Radio button for 'Dynamic Probe'

4) Enter Event Name 'MyEvent' and Probe (e.g. 0xc0101280,
see file /boot/System.map<kernel version>, valid symbols have
T or t as type, | used 'backtrace_stack' for example)

5) Click on Ok

1) Select a channel (e.g. channel0) and click right mouse button
2) Select menu item 'Enable Events..."

3) Select Radio button for 'Dynamic Function Entry/Return
Probe’

4) Enter Event Name 'MyOtherEvent' and Probe (e.g.
create_dev, see file /proc/kallsyms or /boot/System.map<kernel
version>)

5) Click on Ok

1) Select multiple events (tracepoint events) under a channel
(not syscalls) and click right mouse button
2) Select 'Disable’ menu item

1) Select multiple disabled events and click right mouse button
2) Select 'Enable’ menu item

1) Select a probe event (function or dynamic probe) disabled
events and click right mouse button

2) Select 'Enable’ menu item

1) Create Session

2) Select session, right-mouse click and select 'Enable Events
(default channel)'

3) Enter a filter (e.g. sched) for the tracepoint tree and then
select All

4) Click on Ok

Verify that channel is disabled (disabled channel icon
shown, state DISABLED shown in Properties view, menu
item 'Disable’ is disabled and menu item 'Enable’ is
enabled

Verify that channel is enabled (enabled channel icon
shown, state ENABLED shown in Properties view, menu
item 'Disable’ is enabled and menu item 'Enable’ is
disabled

Verify that domain 'UST global' is created under session
and channel is added under the domain. Verify that
default values for the channel are displayed in the
Properties view after selecting the channel in the tree.

See 5.7/5.8

Verify that default channel (channel0) is create under
domain 'Kernel' and that all tracepoint events are added
under the channel with state ENABLED. Verify properties
view show correct values when selecting a event in the
tree (Event Type=TRACEPOINT, State=ENABLED)

Verify that event with name syscalls is added under the
default channel (channel0) with state ENABLED. Verify
properties view show correct values when selecting a
event in the tree (Event Type=SYSCALL,
State=ENABLED)

Verify that event with name 'MyEvent' is added under the
respective channel with state ENABLED. Verify
properties view show correct values when selecting a
event in the tree (Event Type=Probe, State=ENABLED,
Address=0xc0101280, Event Name=MyEvent)

Verify that event with name 'MyOtherEvent' is added
under the respective channel with state ENABLED.
Verify properties view show correct values when selecting
a event in the tree (Event Type=Function,
State=ENABLED, Symbol=create_dev, Offset=0x0, Event
Name=MyOtherEvent)

Verify that all selected events are disabled (disabled
event icon is shown, state DISABLED is shown in
Properties view, menu item 'Disable’ is disabled and
menu item 'Enable’ is enabled

Verify that selected events are enabled (enabled event
icon is shown, state ENABLED is shown in Properties
view, menu item 'Disable’ is enabled and menu item
‘Enable' is disabled

Verify that selected events are enabled (enabled event
icon is shown, state ENABLED is shown in Properties
view, menu item 'Disable’ is enabled and menu item
‘Enable’ is disabled

Verify that only the selected tracepoints (filtered) are
enabled and not all kernel tracepoionts
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SWTBot
Manual

SWTBot

SWTBot

Manual

Manual

Manual

Manual

Manual

Manual

Command to change state of events failed Command
failed! Command: Ittng --mi xml enable-event irq_name -
k -s bestSessionEver -c dfd --probe aff0 , Error Output:
Error: Event irq_name: Enable kernel event failed
(channel dfd, session loserSession) Return Value: 43 <?
xml vel 1.0" encoding="UTF-8"?> <command
xmins="http://lttng.org/xml/ns/Ittng-mi" xmins:xsi="http:
Ilwww.w3.0rg/2001/XMLSchema-instance" xsi
schemaLocation="http://Ittng.org/xml/ns/Ittng-mi http:
/Nittng.org/xml/schemas/Ittng-mi/3/Ittng-mi-3.0.xsd"
schemaVersion="3.0"><name>enable-
event</name><output><events><event><name>irq_na
me</name><type>PROBE</type><enabled>false</enab
led><attributes><probe_attributes><offset>0</offset><sy
mbol_name>aff0</symbol_name></probe_attributes></a
ttributes><success>false</success></event></events></
output><success>false</success></command>

Same error as above

Note: Disable and Enable menu item is only enabled for
events of the same type, all tracepoints or all sys calls.
For function and dynamic probe the user has to enable
each separately.

Note: Disable and Enable menu item is only enabled for
events of the same type, all tracepoints or all sys calls.
For function and dynamic probe the user has to enable
each separately.

Couldn't make event probes work

Command to change state of events failed
Command failed! Command: Ittng --mi xml enable-
Error Output:

Error: Event MyEvent: Enable kernel event failed (c
Return Value: 43

<?xml version="1.0" encoding="UTF-8"?>
<command xmins="http://Ittng.org/xml/ns/Ittng-mi" »

Command to change state of events failed
Command failed! Command: Ittng --mi xml enable-¢
Error Ouptut:

Error: Event bob: Non-default channel exists within
Return Value: 83

<?xml version="1.0" encoding="UTF-8"?>




8.1

8.2

8.3

8.4

8.5

8.6

8.7

8.8

9.1

9.2

9.3

2.3.0-TraceCompassTestCases - LTTng 2.0 - Control

UST Event Handling

1) Select session and click right mouse button
2) Select menu item 'Enable Events (default channel)...'
3) Select 'UST'
4) Select Radio button for 'Tracepoint Events'
Enable Event on session 5) Select top level tree node 'All"
level (all tracepoints) 6) Click on Ok

1) Select domain 'UST global' and click right mouse button
2) Select menu item 'Enable Events (default channel)...'
3) Select Radio button for 'Wildcard'

Enable Event on domain 4) Enter a wildcard (e.g. ust*)

level (wildcards) 5) Click on Ok

1) Select a channel (create if necessary) and click right mouse
button
2) Select menu item 'Enable Events..."
3) Select Radio button for 'Log Level'
4) Enter Event Name 'MyEvent'
5) Select log level TRACE_ERR
Enable Event on 6) Select radio button for loglevel
Channel level (log level) 7) Click on Ok

1) Select a channel (create if necessary) and click right mouse
button
2) Select menu item 'Enable Events..."
3) Select Radio button for 'Log Level'
4) Enter Event Name 'MyOtherEvent'
Enable Event on 5) Select log level TRACE_INFO
Channel level (log level  6) Select radio button for loglevel-olny
oly) 7) Click on Ok
Enable/Disable Event
(tracepoint events)
Enable/Disable Event
(tracepoint events)

Redo tests 7.5 and 7.6 with UST tracepoint events

Redo tests 7.5 and 7.6 with UST (loglevel/loglevel-only) events

1) Create Session

2) Select session, right-mouse click and select 'Enable Events
Enable Tracepoint Event (default channel)'
using filter in tree (Bug  3) Enter filter for the tracepoint tree and then select All
450526) 4) Click on Ok

1) Create Session

2) Select session, right-mouse click and select 'Enable Events
(default channel)'

3) Select Tracepoints

4) Enter list of names (comma-separated) in text box

Enable Event by name 5) Click on Ok
Contexts Handling

1) Select kernel channel and click right mouse button

2) Select menu item 'Add Contexts..."

3) Expand tree and select some contexts (e.g prio, procname,
Add Context (to pid)
channel) 4) Click on 'Ok’

1) Select UST channel and click right mouse button

2) Select menu item 'Add Contexts..."

3) Expand tree and select contexts procname, pthread_id, vpid
Add Context (to and vtid
channel) 4) Click on 'Ok’

1) Select 1 Kernel tracepoint event and click right mouse button
2) Select menu item 'Add Contexts..."

3) Expand tree and select some contexts (e.g prio, procname,
pid)

4) Click on 'Ok’

Note: only when using LTTng Tools 2.0.x - 2.1.x. For v2.2 or

Add Context (to event) later this menu item has to be disabled

Enable Events (from
Provider)

Verify that default channel (channel0) is create under
domain 'UST global' and that a wildcard event “*" is
create under the channel with state ENABLED. Verify
properties view show correct values when selecting a
event in the tree (Event Type=TRACEPOINT,
State=ENABLED)

Verify that event with wildcarded name (e.g ust*) is added
under the default channel (channel0) with state
ENABLED. Verify properties view show correct values
when selecting a event in the tree (Event
Type=TRACEPOINT, State=ENABLED)

Manual

Manual

Verify that event with name 'MyEvent' is added under the
respective channel with state ENABLED. Verify properties
view show correct values when selecting a event in the
tree (Event Type=TRACEPOINT, State=ENABLED, Log
Level=<=TRACE_ERR, Event Name=MyEvent)

Note: In LTTng backend v2.4 and later provide
information if a loglevel is for a range (e.g. <=
TRACE_ERR) This will be displayed by the properties

SWTBot view now

Verify that event with name 'MyOtherEvent' is added
under the respective channel with state ENABLED. Verify
properties view show correct values when selecting a
event in the tree (Event Type=TRACEPOINT,
State=ENABLED, Log Level= ==TRACE_INFO, Event
Name=MyOtherEvent).

Note: In LTTng backend v2.4 and later provide
information if a loglevel is for a single level (e.g. ==
TRACE_INFO) This will be displayed by the properties

Manual view now

See 7.5/7.6 Manual

DisablingEnabling of loglevel/loglevel_only events causes

See 7.5/7.6 Manual tracepoints events (see Bug 486658)

Verify that only the selected trace points (filtered) are

enabled and not all UST trace poionts Manual

Verify that events entered in the comma-separated list are added to

the tree SWTBot

Verify that command is successful (no error).
NOTE: There is no way to retrieve added contexts from

the trace. Therefore GUI cannot display this information. Manual

Verify that command is successful (no error).

NOTE 1: There is no way to retrieve added contexts from
the trace. Therefore GUI cannot display this information.
NOTE2: For UST only contexts procname, pthread_id,
vpid and vtid are supported

Manual Will be fixed with https://bugs.eclipse.org/bugs/show_bug.cgi?id=491933

Verify that command is successful (no error).
NOTE: There is no way to retrieve added contexts from
the trace. Therefore GUI cannot display this information.

SWTBot DEPRECATED
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101

10.2

1"

1141

11.2

113

114

115

11.6

1.7

11.8

121

Enable Kernel Events

Enable UST Events

Importing to Project

Preparation

Import to project

Import to project
(Override)

Import to project
(Overwrite All)

Import to project
(Rename)

Import to project
(Rename All)

Import to project (Skip)
Import to project (Skip
All)

Refresh

Refresh

2.3.0-TraceCompassTestCases - LTTng 2.0 - Control

1) Create a new session

2) Select multiple Kernel Tracepoint events under Providers —
Kernel

3) click right mouse button

4) select menu item 'Enable Event...'

5) Select newly created session

6) Select 'Ok’

1) Make sure that UST application is running on remote host
(see step 0)

2) Create a new session

3) Create a channel under domain 'UST global'

4) Select multiple UST Tracepoint events under Providers ->
<UST Process>

5) click right mouse button

6) select menu item 'Enable Event...'

7) Select newly created session

8) Select newly created channel

9) Select 'Ok’

1) Create new session

2) Enable all Kernel Tracepoint events
3) Enable all Kernel sycalls

4) Enable all UST events

5) Start Tracing

6) Stop Tracing after a few seconds
7) Create new Tracing Project

1) Select session from 11.1 and click right mouse button
2) Select 'Import..."
3) Select Ok

1) Repeat step 1 — 3 of test case 11.2

2) In dialog box select 'Overwrite' (kernel trace)

3) In dialog box select 'Overwrite' (UST trace, re-do if more
than 1 UST trace)

1) Repeat step 1 — 3 of test case 11.2
2) In dialog box select 'Overwrite All'

1) Repeat step 1 — 3 of test case 11.2

2) In dialog box select 'Rename’ (kernel trace)

3) In dialog box select 'Rename’ (UST trace, re-do if more than
1 UST trace)

1) Repeat step 1 — 3 of test case 11.2

2) In dialog box select 'Rename All'

1) Repeat step 1 - 3 of test case 11.2

2) In dialog box select 'Skip' (kernel trace)

3) In dialog box select 'Skip' (UST trace, re-do if more than 1
UST trace)

1) Repeat step 1 — 3 of test case 11.2

2) In dialog box select 'Skip All'

Press refresh button and context sensitive menu item for
different selections

Verify that domain 'Kernel' is created under the new

session. Verify that default channel 'channel0' is created

under the domain. Verify that selected events are added

under the channel and are ENABLED. Manual

Verify that selected events are added under the selected
channel and are ENABLED. Manual

After 2 verify that all traces are selected by default and
also that the tracing project with name 'Remote’ is
selected.

Verify that during import a progress dialog is opened to
show the progress of the import operation.

Verify that traces are imported to the project wiith name
Remote and its Traces folder. Verify that for the kernel
trace the trace type "LTTng Kernel Trace" is set and for
the UST traces the trace type "LTTng UST Trace" is set.
Create Experiment, select all traces and open

Experiment. Make sure that all view are populated
correctly in the LTTng Kernel Perspective. Manual

Verify that traces are imported and existing traces are
overwritten Manual

Confirmation dialog only shows once. Verify that traces
are imported and existing traces are overwritten Manual

Verify that traces are imported with a different name Manual

Confirmation dialog only shows once. Verify that all traces
are imported with a different name Manual

Verify that each skipped trace is not imported Manual

Confirmation dialog only shows once. Verify that all traces
are skipped Manual

Verify that the Control View is refreshed. Manual -Should have an accelerator like f5
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14.1

14.2

14.3

14.4

14.5

15.1

15.2

15.3

Event Filtering (LTTng
2.1)

Preparation

Enable UST Event on
session level

Enable UST Event from
provider

Create trace

Create Session With
Advanced Options
LTTng v2.1)

Create Session Dialog -
Advanced Button

Create Session Dialog -
Check box "Use same
protocol and address for
data and control"

2.3.0-TraceCompassTestCases - LTTng 2.0 - Control

For the tests below a Ubuntu machine with LTTng 2.1 installed
(with Ittng tools 2.1.x) is required. Either create a VM machine
yourself (e.g. on Virtualbox) or install it locally on your native
Ubuntu (if correct version). Make sure that the root session
daemon is running (sudo lttng list -k) and have one UST
process running (e.g. from Ittng-tools git repository under
tests/hello.cxx)

1) Connect to remote host

2) Create new Session 'FilterSession'

Verify that default channel (channel0) is create under

1) Select session and click right mouse button domain 'UST global' and that the corresponding event is

2) Select menu item 'Enable Events (default channel)...' created under the channel with state ENABLED.

3) Select 'UST'

4) Select Radio button for 'Tracepoint Events' Verify that Properties view shows correct values for this

5) Select one tracepoint event (Event Type=TRACEPOINT, State=ENABLED,

6) Enter filter expression on a event field Filter=with filter, Filter=the actual expression in LTTng 2.8

7) Click on 'Ok’ +) Manual

1) Execute 14.3
2) Select one UST Tracepoint event under Providers -> <UST  Verify that selected event is added under the selected

Process> channel.

3) click right mouse button

4) select menu item 'Enable Event...! Verify that Properties view shows correct values for this

5) Select newly create session and channel event (Event Type=TRACEPOINT, State=ENABLED,

6) Enter filter expression on a event field Filter=with filter, Filter=the actual expression in LTTng 2.8

7) Click on 'Ok’ +) Manual
1) Start Tracing

2) Stop Tracing after a view seconds

3) Import Trace to Project

4) Open Trace Make sure that only events are shown in the events table

5) Destroy Session that met the condition in the filter expressions Manual

For the tests below a Ubuntu machine with LTTng 2.1 installed
(with Ittng tools 2.1.x) is required. Either create a VM machine
yourself (e.g. on Virtualbox) or install it locally on your native
Ubuntu (if correct version). Make sure that the root session
daemon is running (sudo Ittng list -k) and have one UST
process running (e.g. from Ittng-tools git repository under
tests/hello.cxx)

After 2) verify that advanced options are shown (e.g.
Trace Path, Protocol, Address and Port)

1) Open Create Session Dialog box After 3) verify that advanced option are not shown and
2) Select "Advanced >>>" only basic options are there (Session Name and Session
3) Select "<<< Basic" Path) Manual

After 2) verify that data Protocol and data Address is
enabled. Note that the ports cannot be configured for net
1) Open Create Session Dialog box and select "Advanced >>>" and net6 when this button is unchecked. -> port text fields
2) Uncheck checkbox"Use same protocol and address for data  are disabled
and control"
3) Check checkbox "Use same protocol and address for data After 3) Verify that data Protocol and data Address are
and control" disabled Manual
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2.3.0-TraceCompassTestCases - LTTng 2.0 - Control

1) Open Create Session Dialog box and select "Advanced >>>"
Create Session Dialog - Verify that the Control protocol dropdown menu shows
154  Protocol list net, net6 and file Manual

1) Open Create Session Dialog box and select "Advanced >>>"
2) Uncheck checkbox "Use same protocol and address for data
Create Session Dialog - and control” After 2) verify that the data protocol dropdown menu
15.5 Protocol list 2 shows net, net6, tcp and tcp6 Manual

After 2) verify that net6 is propagated to the data protocol
and and that the data and control port text fields are

1) Open Create Session Dialog box, select "Advanced >>>" enabled
Create Session Dialog - 2) Select net6 for Control Protocol After 3) verify that file is propagated to the data protocol
15.6  Protocol propagation 3) Select file for Control Protocol and that the data and control port text fields are disabled. ~ Manual
Create Session Dialog - 1) Open Create Session Dialog box, select "Advanced >>>" After 2) verify that the IP address is propagated to the
15.7 Address propagation 2) Enter IP address in Control address data address field Manual

1) Open Create Session Dialog box and select "Advanced >>>"
2) Uncheck checkbox "Use same protocol and address for data
and control"
3) Select tcp for control protocol and tcp6 for data protocol
4) Check checkbox "Use same protocol and address for data
Create Session Dialog - and control” After 4) make sure that both data and control protocol
15.8 Protocol propagation 2 show net Manual

Verify that the traces are stored on the remote host under
ItmpltestTraces/kernel and
ItmpltestTraces/ust/<application(s)> repectively.

1) Open Create Session Dialog box and select "Advanced >>>"

2) Enter session name, select file protocol and enter directory  After 2) make sure that the Session Path in the Property

/tmpl/testTraces/ in address field and press ok View shows the URL with the configured parameters
3) Enable events, start tracing, wait for a few seconds, stop
tracing Verify that the remote import dialog box opens at step 4
Create trace with file 4) Import traces to a existing tracing project (as described in test cases 11.x) and it is possible to
15.9 protocol 5) Destroy session transfer the traces to the tracing project. Manual

Verify that the traces are stored on the remote host under
ltmpltestTraces/newPath/kernel and
1) Open Create Session Dialog box and select "Advanced >>>" /tmp/testTraces/newPath/ust/<application(s)> repectively.
2) Enter session name, select file protocol and enter directory

Itmp/tmpTraces/ in address field, enter /newPath in "Trace After 3) make sure that the Session Path in the Property
Path" text field and press ok View shows the URL with the configured parameters
3) Enable events, start tracing, wait for a few seconds, stop
tracing Verify that the remote import dialog box opens at step 4
Create trace with file 4) Import traces to a existing tracing project (as described in test cases 11.x) and it is possible to
15.10  protocol and trace path  5) Destroy session transfer the traces to the tracing project. Manual

Verify that the traces are stored on the Eclipse local
machine under /home/<user name>/lttng-traces/<remote
machine name>/<session name + date>/kernel and
/home/<user name>/lttng-traces/<remote machine
name>/<session name + date>/ust/<application(s)>
repectively.

1) Start relayd on Eclipse local machine (default settings: Ittng-

relayd) After 3) make sure that the Session Path in the Property

2) Open Create Session Dialog box and select "Advanced >>>" View shows the URL with the configured parameters

3) Enter session name, select net protocol and enter IP address

of Eclipse local machine in address field and press ok After 5) Verify that dialog box for selecting a tracing
4) Enable events, start tracing, wait for a few seconds, stop project is openend that after selecting a project and
tracing pressing next the default trace import wizard opens. Then
Create trace with net 5) Import traces to a existing tracing project verify that it is possible to transfer the traces to the tracing
15.11  protocol 6) Destroy session project. Manual
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2.3.0-TraceCompassTestCases - LTTng 2.0 - Control

Verify that the traces are stored on the Eclipse local
machine under /home/<user name>/Ittng-traces/<remote
machine name>/<session name + date>/kernel and

1) Uncheck checkbox "Use same protocol and address for data /home/<user name>/lttng-traces/<remote machine

and control" name>/<session name + date>/ust/<application(s)>

2 ) Start relayd on Eclipse local machine with specified ports repectively.

(Ittng-relayd -C tcp://0.0.0.0:1234 -D tcp://0.0.0.0:5678)

3) Open Create Session Dialog box and select "Advanced >>>" After 4) make sure that the Session Path in the Property

4) Enter session name, select tcp protocol and enter IP address View shows the URL with the configured parameters

of Eclipse local machine in address field, specify data and

control ports and press ok

5) Enable events, start tracing, wait for a few seconds, stop

tracing

6) Import traces to a existing tracing project

After 6) Verify that dialog box for selecting a tracing
project is openend that after selecting a project and
pressing next the default trace import wizard opens. Then

Create trace with tcp verify that it is possible to transfer the traces to the tracing

15.12  protocol and port 7) Destroy session project. Manual
1) Start relayd on Eclipse local machine (default settings: Ittng-
relayd)
2) Select Live Mode
3) Open Create Session Dialog box and select "Advanced >>>"
4) Enter session name, select net protocol and enter IP address
of Eclipse local machine in address field, keep defaults for Live
Connection and Live Delay, and press ok
5) Enable UST events (per UID channel), start tracing, wait for a Verify that session is created successfully. Verify that
Live Streaming Session few seconds, stop tracing after 6) the trace appears in the Traces directory of
(UST) - Initial 6) Import traces to a existing tracing project Remoter project. Verify that relevants views are updated
15.13  implementation 7) Destroy session when new data arrives SWTBot Implementation disabled for 2.0
1) Start relayd on Eclipse local machine (default settings: Ittng-
relayd)
2) Select Live Mode
3) Open Create Session Dialog box and select "Advanced >>>"
4) Enter session name, select net protocol and enter IP address
of Eclipse local machine in address field, keep defaults for Live
Connection and Live Delay, and press ok
5) Enable Kernel events, start tracing, wait for a few seconds,  Verify that session is created successfully. Verify that
Live Streaming Session  stop tracing after 6) the trace appears in the Traces directory of
(Kernel) - Inititial 6) Import traces to a existing tracing project Remoter project. Verify that relevants views are updated
15.14  Implementation 7) Destroy session when new data arrives SWTBot Implementation disabled for 2.0
16 Preferences
Verify that tracer control preferences exists and shows
Open Preferences (Menu -> Preferences -> Tracing -> LTTng  Tracing Group, Logging, Log File (always disabled),
16.1 Open Preference Dialog Tracer Control Preferences) Append, Verbose Level (None, Level 1, Level2 Level 3) Manual
16.2  Enable Logging In Tracer Control Prferences, check checkbox Logging Verbose Level radio buttons will be enabled Manual
16.3 Disable Logging In Tracer Control Prferences, uncheck checkbox Logging Verbose Level radio buttons will be disabled Manual
Execute 16.2 and execute some commands (e.g. create Make sure that log file is created and contains the
16.4 Test Logging level none session, enable event) executed commands and command replies Manual
1) Execute 16.2 Make sure that log file contains the executed commands
Test Verbose Logging  2) select verbose level Level 1 with -v option (e.g. Ittng -v create session) and the
16.5 (Level 1) 3) Execute some commands (e.g. create session, enable event) command replies come with debug information Manual This makes no difference for Ml starting with Lttng 2.6
1) Execute 16.2 Make sure that log file contains the executed commands
Test Verbose Logging  2) select verbose level Level 2 with -vv option (e.g. Ittng -vv create session) and the
16.6 (Level 2) 3) Execute some commands (e.g. create session, enable event) command replies come with debug information Manual This makes no difference for Ml starting with Lttng 2.6
1) Execute 16.2 Make sure that log file contains the executed commands
Test Verbose Logging  2) select verbose level Level 3 with -vvv option (e.g. Ittng -vvv create session) and the
16.7 (Level 3) 3) Execute some commands (e.g. create session, enable event) command replies come with debug information Manual This makes no difference for Ml starting with Lttng 2.6
Verify that tracer control preferences are persisted and
Check checkbox Append, restart Eclipse and open Tracer the log file is opened in append mode (old file is not
16.8 Append Mode Control Preferences overwritten) Manual
Verify that Ittng command is executed with command line
Change Tracing group (e.g. tracing2) and execute a command  option -g <group>. Ignore any command reply errors (if
16.9 Change Tracing Group  (while logging enabled) any) Manual
Change execution After verify that values smaller than 5 and bigger than 600
16.10  timeout Go to Remote Connection Preferences, Change Timeout are rejected Manual
Verify: Group=tracing, Logging is deselected, Append is
deselected, Verbose Level=None), and Command Timout
16.11  Reset Reset to defaults is 15 Manual
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171

17.2

17.3

17.4

175

17.6

17.7

17.8

Create Channel with
advance features
(LTTng 2.2 features)

Configure Metadata
channel (kernel)

Configure Metadata
channel (UST)

Configure File rotation
(kernel)

Configure File rotation
(ust)

Buffer Type - toggle
UST/kernel

Default UST Buffer Type

per PID UST Buffer
Type

2.3.0-TraceCompassTestCases - LTTng 2.0 - Control

For the tests below a Ubuntu machine with LTTng 2.2 installed
(with Ittng tools 2.2.x) is required. Either create a VM machine
yourself (e.g. on Virtualbox) or install it locally on your native
Ubuntu (if correct version). Make sure that the root session
daemon is running (sudo lttng list -k) and have one UST
process running (e.g. from Ittng-tools git repository under
tests/hello.cxx).

1) Create and select session and click right mouse button

2) Select menu item 'Enable Channel...' Verify after 3) that 'Channel Name' is set to metadata and
3) Select Checkbox 'Configure metadata channel' the correspondig textbox is disabled. Verify after 5) that
4) Update all text boxes metadata channel was created under the kernel domain.
5) Click on 'Ok’ Also verify in the properties view that all parameters are

set correctly when selecting the channel metadata.

Verify after 3) that 'Channel Name' is set to metadata and

the correspondig textbox is disabled. Verify after 5) that

metadata channel was created under the domain UST

global. Also verify in the properties view that all

parameters are set correctly when selecting the channel
1) Re-do 17.2 with a UST channel metadata.

1) Create and select session and click right mouse button
2) Select menu item 'Enable Channel...'
3) Fill in channel name

4) Fill in 1048576 in 'Maximum size of trace files' and also 'Sub

Buffer Size'

5) Fill in 2 in 'Maximum number of trace files'

6) Click on 'Ok’

7) Enable all kernel events After 8) verify on the trace node that trace files are not
8) Start, wait and stop tracing. bigger than 1048576 bytes

1) Create and select session and click right mouse button
2) Select menu item 'Enable Channel...'

3) Fill in channel name
4)

Select UST
5) Fill in 262144 in 'Maximum size of trace files' and also 'Sub
Buffer Size'
6) Fill in 2 in 'Maximum number of trace filesfiles'
7) Click on 'Ok’
8) Enable all UST events After 9) verify on the trace node that trace files are not
9) Start, wait and stop tracing. bigger than 262144 bytes
1) Create and select session and click right mouse button Verify after 2 and 4 that the radio buttons for the buffer
2) Select menu item 'Enable Channel..." type is disabled and the buffer type "Global shared
3) Select UST buffers" is selected which is the value for the kernel
4) Select Kernel tracer.
5) Slect cancel Verify after 3) that the radio buttons are enabled an no

buffer type is selected

1) Create and select session and click right mouse button
2) Select menu item 'Enable Channel...'

3) Select UST Verify after 5) that the default buffer type is configured for
4) Enter Channel Name that channel (see properties view). Note for LTTng Tools
5) Select 'Ok’ 2.2 the default is per-PID and for LTTng Tools 2.3 and

later it is per-UID

Prequisite: Multiple UST Applications need to run

1) Create and select session and click right mouse button
2) Select menu item 'Enable Channel...'

3) Select UST

4) Select 'Per PID buffers'

5) Enter Channel Name

6) Select 'Ok’

8) Enable all ust events Verify after 6) that the per-pid buffer type is configured for
9) Start, wait and stop tracing. that channel (see properties view). After 10) make sure
10) Import trace that for each UST application one trace is created
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Manual

Command is successful. However tracer doesn't create
metadata channel. Bug in LTTng http://bugs.lttng.

Manual orglissues/994

Manual

Manual

Manual

Manual
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17.9

18.1
18.2

18.3

18.4

18.5

18.6

18.7

18.8

18.9

18.10

18.11

18.12

191

20

per UID UST Buffer
Type

Snapshot Channel

(LTTng 2.3 features)
Preparation

Create Snapshot
Session

Enable Kernel Event

Start Session

Record snapshot

Create another snapshot

session
Enable UST Events
Start UST session

Record snapshot over
multiple sessions

Import traces

Stop and destroy
sessions

Network snapshot
session

Record snapshot when
session is inactive

Command Script

Execute command sript

Session Profiles

2.3.0-TraceCompassTestCases - LTTng 2.0 - Control

Prequisite: Multiple UST Applications need to run

1) Create and select session and click right mouse button
2) Select menu item 'Enable Channel..."

Select UST

Select 'Per UID buffers'

Enter Channel Name

Select 'Ok’

Enable all ust events

) Start, wait and stop tracing.

10) Import trace

)
)
)
)
)
)

EEEEE

Connect to a node with LTTng 2.3 installed

1) Click right mouse button on 'Sessions'

2) Select 'Create Session..." in the context sensitive menu

3) Enter session name 'MySession', keep 'Session Path' empty
4) Select checkbox 'Snapshot Mode'

5) Select 'Ok’

Enable all Kernel Tracepoint and syscall events

a) Select session and click on button 'Start'
b) Redo test with context sensitive menu item 'Start'

select session and record 2 snapshots: Once with button
'Record Snapshot' and once with context-sensitive menu item
'Record Snapshot'

session name ustSession (as described in 18.1)
Enable all UST events
see 18.3

Select kernel and ust session (see 18.1 and 18.5) and click on
‘Record snapshot' button

Open Import dialog (see 11.2)

Stop and destroy both sessions

1) Start relayd on Eclipse local machine (default settings: Ittng-
relayd)

2) Open Create Session Dialog box, select 'Snapshot Mode'and
select "Advanced >>>"

3) Enter session name, select net protocol and enter IP address
of Eclipse local machine in address field and press ok

4) Enable events (UST and Kernel), start tracing, and record a
few snapshots, stop tracing

5) Import traces to a existing tracing project

6) Destroy session

Create a command script to create a session with kernel and
ust events enabled.

Verify after 6) that the per-pid buffer type is configured for
that channel (see properties view). After 10) make sure
that only one trace is created even multiple UST
applications are running.

Verify that new session is added under the Session tree
node. Verify properties in Properties view (by selecting
the session in the Control view):

'Session name' (=MySession)

‘Snaphshot ID' (=1)

'Snapshot Name' (=snapshot-1)

'Session Path' (=/lhome/<user>/traces/MySession_<date
and time>) and 'State' (SINACTIVE)

Make sure that the button and menu item 'Record
Snapshot' is enabled

Verify that channel and events a successful enabled

Verify that Session icon changes to 'ACTIVE' icon. Verify
that property view shows 'ACTIVE' for the session state

Make sure that the button and menu item 'Record
Snapshot' is enabled. Also make sure that the Button and
menu item 'Import' is enabled.

Commands succeed without error

Make sure that snapshot session is created successfully
Verify that channel and events a successful enabled
see 18.3

Command succeeds without error

Verify that 4 snapshots are available (3 kernel and 1
UST). Verify that all snapshots are imported to the
selected tracing project

Verify that sessions are destroy successfully

Make sure that all steps were successfull. Also, import
the traces using the standard import instead of the remote
import

Make sure that each command of script is executed and
script execution is without errors
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Manual

Manual
Manual

Manual

Manual

Manual
Manual
Manual

Manual

Manual

Manual

Manual

SWTBot

While doing this | found a few bugs but it ended up working. See
https://bugs.eclipse.org/bugs/show_bug.cgi?id=469425 and https:
IIbugs.eclipse.org/bugs/show_bug.cgi?id=469424

Note that the session has to be started at least once otherwise the
command will fail.

Manual - Should provide a command script in test spec



20.1

20.2

20.3

20.4

20.5

20.6

20.7

20.8

20.9

20.10

20.11

20.12

21

211

212

213

Save session

Save session (2)
Save session (no force)

destroy all sessions

Load Session (local)

destroy all sessions

Load Session (remote)

Open preference (1)

Open preference (2)

Export profile

Export profile (redo)

Import profile

Import profile (redo)

Delete profile

Kernel Event Filtering
(LTTng 2.6)

Preparation

Enable Kernel Event on
session level

2.3.0-TraceCompassTestCases - LTTng 2.0 - Control

1) Create Tracing session

2) Select session and click right mouse button
3) Select Menu item "Save..."

4) Select 'OK'

1) Re-do 20.1 (use same session name)

1) Re-do 20.1
but deselect force button

1) Select group "Sessions" and click right mouse button
2) Select Menu item "Load..."

3) Select a existing profile (from Local)

4) Select 'OK'

1) Select group "Sessions" and click right mouse button
2) Select Menu item "Load..."

3) Select "Remote”

4) Select a existing profile (from Remote)

5) Select 'OK'

1) Select group "Sessions" and click right mouse button
2) Select Menu item "Load..."
3) Select "Manage..."

Open Preferences (Menu -> Preferences -> Tracing -> LTTng
Remote Profiles

1) Open Preference page (see 20.7)

2) Select multiple profiles

3) Click on "Export..."

3) Select destination directory and click on "OK"

Redo 20.8

1) Open Preference page (see 20.7)

2) Click on "Import..."

3) Select a profile on media and click on "OK"
1) Redo 20.8

1) Open Preference page (see 20.7)
2) Select multiple profiles

3) Click on "Delete..."

3) Confirm deletion

For the tests below a Ubuntu machine with LTTng 2.1 installed
(with Ittng tools 2.6.x) is required. Either create a VM machine
yourself (e.g. on Virtualbox) or install it locally on your native
Ubuntu (if correct version). Make sure that the root session
daemon is running (sudo lttng list -k) and have one UST
process running (e.g. from Ittng-tools git repository under
tests/hello.cxx)

1) Connect to remote host
2) Create new Session 'FilterSession’

1) Select session and click right mouse button

2) Select menu item 'Enable Events (default channel)...'
3) Select 'Kernel'

4) Select Radio button for 'Tracepoint Events'

5) Select one tracepoint

6) Enter filter expression on a event field

7) Click on 'Ok’

Make sure that the session is saved under ~/.
Ittng/sessions on the remote

Make sure that session is availabe in the workspace by
opening Window->Preferences -> Tracing -> LTTng
Remote Profiles

Make sure that the session is saved under ~/.
Ittng/sessions.

Make sure that session is availabe the user is prompted
to skip or overwrite the profile in the workspace

The save command will be rejected by LTTng Tools

Make sure that the session is created

Make sure that the session is created

Make sure that the LTTng Remote Profile preference
page opens
Make sure that the LTTng Remote Profile preference
page opens

Make sure profile is exported to the destination directory

Make sure that user is prompted about to overwrite or
skip existing profile

Make sure profile is imported and available in workspace

Make sure that user is prompted about to overwrite or
skip existing profile

Make sure profile(s) are delete from the workspace and
disk

Verify that default channel (channel0) is create under
domain 'Kernel' and that the corresponding event is
created under the channel with state ENABLED.

Verify that Properties view shows correct values for this
event (Event Type=TRACEPOINT, State=ENABLED,

Filter=with filter, Filter=the actual expression in LTTng 2.8

+)
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214

215

221

222

223

23

231

232

233

23.4

24

241

242

24.3

22

Enable Kernel Event
from provider

Create trace

LTTng UST Exclude
events (LTTng 2.5)

Preparation

Enable events with
exclude

LTTng UST per syscall
(LTTng 2.6)

Preparation

Enable selected syscalls

destroy session

Enable all syscalls

JUL, Log4J, Python
Logger

Configure JUL tracing
session (LTTng 2.6)
Configure Log4J tracing
session (LTTng 2.6)
Configure Python tracing
session (LTTng 2.7)

2.3.0-TraceCompassTestCases - LTTng 2.0 - Control

1) Execute 14.3

2) Select one Kernel Tracepoint event under Provider "Kernel"
3) click right mouse button

4) select menu item 'Enable Event...!

5) Select newly create session and channel
6) Enter filter expression on a event field

7) Click on 'Ok’

1) Start Tracing

2) Stop Tracing after a view seconds
Import Trace to Project

Open Trace

3)
4)
5) Destroy Session

For the tests below a Ubuntu machine with lttng tools 2.5.x is
required. Either create a VM machine yourself (e.g. on
Virtualbox) or install it locally on your native Ubuntu (if correct
version). Make sure that the root session daemon is running
(sudo lttng list -k) and have one UST process running (e.g. from
Ittng-tools git repository under tests/hello.cxx)

1) Connect to remote host

2) Create new Session 'FilterSession'

1) Open Enable Event Dialog, select UST
2) Use wildcards
3) Enter a event name to exclude

For the tests below a Ubuntu machine with Ittng tools 2.6.x is
required. Either create a VM machine yourself (e.g. on
Virtualbox) or install it locally on your native Ubuntu (if correct
version). Make sure that the root session daemon is running
(sudo lttng list -k) and have one UST process running (e.g. from
Ittng-tools git repository under tests/hello.cxx)

1) Connect to remote host

2) Create new Session 'MySession'

1) Open Enable Event Dialog, select Kernel

2) Select syscalls

3) In the tree, select selected syscalls

4) Select Ok

1) Open Enable Event Dialog, select Kernel
2) Select Syscalls

3) In the tree, select all syscalls

4) Select Ok

Configure JUL tracing session
using tree and event name
Configure Log4J tracing session
using tree and event name
Configure Python tracing session
using tree and event name

Verify that selected event is added under the selected
channel.

Verify that Properties view shows correct values for this
event (Event Type=TRACEPOINT, State=ENABLED,
Filter=with filter, Filter=the actual expression in LTTng 2.8

+)

Make sure that only events are shown in the events table
that met the condition in the filter expressions

Verify that event is added under the UST Domain and
relevant channel.

Verify that the Properties view shows the exclusion:
Exclusion=with Exclusion, for Exclusion the actual
expression in LTTng 2.8+

Verify that the selectetd syscalls are added added under
the Kernel Domain and relevant channel.

Verify that the selectetd syscalls are added added under
the Kernel Domain and relevant channel.

verify that session is configured correctly
verify that session is configured correctly

verify that session is configured correctly
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Section
Tracing RCP

Target: Windows 10 64 bit

Step
0

1

1.6

2.4

2.5

Test Case
Preparation

Pass

2.3.0-TraceCompassTestCases - RCP

Fail

Action

1. Download maven 3.3 or above

2. Use openJDK 1.8 or above

Verification

3. Use the command mvn clean install -Dmaven.test.skip=true -X tocompile the RCP without the tests (-X for the debug info)
4. You might need to use a proxy (adding a settings.xml file in the ~/.m2 folder)
5. Once everything is compiled, you can find the version of RCP for your OS in t racecompass-master/git/org.eclipse.tracecompass/rcp/org.eclipse.tracecompass.rcp.product/target/products/org.eclipse.

tracecompass.rcp/ folder
Start RCP

Start Tracing RCP

Start Tracing RCP with text
trace

Start Tracing RCP with
previously opened text trace
Start Tracing RCP with Kernel
CTF trace

Start Tracing RCP with
previously opened Kernel CTF
trace

Start Tracing RCP with new
trace with name conflict

Re-do 1.6

Start Tracing RCP with non-
trace file

File menu

Open Trace (File)

Open Trace (File) with
previously opened text trace

Open Trace (Directory)

Open Trace (Directory) with
previously opened Kernel CTF
trace

Open Trace File with name
conflict

Open RCP from command line or file explorer

Tracing RCP opens in default perspective

Open RCP from command line with --open <trace name with

absolute path>

Open RCP from command line with --open <trace name with

absolute path>. Use same trace than 1.2

Open RCP from command line with --open <kernel trace name

with absolute path>

Open RCP from command line with --open <kernel trace name

with absolute path>. Use same trace than 1.4

Open RCP from command line with --open <trace name with
absolute path>, where the name of trace is the same than 1.2,

Trace will be opened with auto-detected trace type

folder is opened and not a new trace entry is created

kernel analysis trace type is selected and trace is opened.

folder is opened and not a new trace entry is created

but the trace is located at a different location on disk suffix added.

Open RCP from command line with --open <kernel trace with
absolute path>, where name of trace is the same than 1.4, but

the trace is located at a different location on disk

Open file that is not a trace

new trace name has a integer number a suffix added.

Trace is imported (linked) however default icon (from Eclipse) is set

Use Menu "File -> Open Trace ..." In the file dialog select a text

trace and select open.

Use Menu "File -> Open Trace...". In the file dialog select a text

trace and select open. Use same trace than 2.1

Use "Menu File -> Open Trace ..." . In the file dialog select a file

of Kernel CTF trace directory and select open.

Trace will be opened with auto-detected trace type
folder is opened and not a new trace entry is created

analysis trace type is selected and trace is opened.

Use "Menu File -> Open Trace ..." . In the file dialog select a file

of Kernel CTF trace directory and select open. Use same trace

than 2.3

Use Menu "File -> Open Trace ..." In the file dialog select a text
trace and select open, where the name of trace is the same

folder is opened and not a new trace entry is created

than 2.1, but the trace is located at a different location on disk number a suffix added.

Verify that the same trace that was previously linked into the Traces

Tracing RCP is opened, the trace is linked to the Tracing project, the

Verify that the same trace that was previously linked into the Traces

Verify that a new trace is linked to the Tracing project and trace is

opened. Verify that the new trace name has a integer number a

Verify that a kernel trace is linked to the Tracing project, the kernel
analysis trace type is selected and trace is opened. Verify that the

Verify that the same trace that was previously linked into the Traces

Verify that the trace is linked to the Tracing project, the kernel

Verify that the same trace that was previously linked into the Traces

Verify that the new trace is linked to the Tracing project and the
trace is opened. Verify that the new trace name has a integer

To Do

Comment

| o [ o s

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Comment

Bruno : Not with this test case : If | open n traces, the folder "Traces
[n]" shows the number of traces opened. If i go in the Properties
view with the folder the title of the Properties view is Traces [n], now,
if | delete the n traces the title of the Properties view is still Traces
[n] instead of Traces [0]. Patrick: The Properties view updates itself
when the selection changes.

Bruno : Not with this test case but the delete key doesnt work on
Tracing project (we need to use the mouse right click). Bug 486505.

***(the real test case 1.1 passed)

The kernel trace opens in an editor but the editor of the first trace
gets activated. Bug 443461.
Bruno : Same bug happens with UST traces

should it open?



2.6

2.7

2.8
29

31

3.2

33

3.4

3.5

4.1
4.2

4.2

44

4.5

5.1
52

53
5.4

6.1

Re-do 2.5

Open file

Restart
Exit

Window Menu
Open Perspective

Open View
Preferences

2.3.0-TraceCompassTestCases - RCP

Use "Menu File -> Open Trace ..." . In the file dialog select a file

of Kernel CTF trace directory and select open, where the Verify that the kernel trace is linked to the Tracing project, the

name of trace is the same than 2.3, but the trace is located at a kernel analysis trace type is selected and trace is opened. Verify that

different location on disk the new trace name has a integer number a suffix added.

Open file that is not a trace Trace is imported (linked) however default icon (from Eclipse) is set
Verify that RCP is restarted with the previously open perspective

Use Menu File -> Restart and trace

Use Menu File -> Exit Tracing RCP exits

Use Menu Window -> Show Perspective -> Tracing Perspective Tracing perspective is opened

Use Menu Window -> Show View -> Select Tracing -> Sequence
Diagram Sequence diagram view is shown

Use Menu Window -> Preferences Preferences dialog is shown

Make changes of perspective by moving views and use menu
Window -> Save Perspective As. Enter a perspective name and

Save Perspective As select Ok Perspective with new name is stored

Make changes of perspective by moving views and use menu  After confirming the reset operation the perspective is reset to the
Reset Perspective Window -> Reset Perspective. default layout.
Help Menu
Help Contents Use Menu -> Help -> Help Contents Help content browser is opened. All Tracing related help is included
Help Contents (shortcut) Use key F1 Help content browser is opened. All Tracing related help is included

Use Menu -> Help -> Install New Software... to install new
Install new Software Eclipse feature Installation is successful

About dialog is opened all relevent information (e.g. version,
About Use Menu -> Help -> About copyright years etc) is up-to-date and correct.
Go over all tracing features and plug-ins and verify that all have the

Version + Copyright Use Menu -> Help -> About -> Installation details correct version and copyright years
Content
TMF presence Open Tracing perspective Tracing perspective opens
LTTng presence Open LTTng Kernel perspective LTTng Kernel perspective opens
PCAP Network analysis
presence Open Network Tracing perspective Network analysis perspectiv opens
BTF presence Open BTF trace BTF trace opens correctly
Upgrade
Upgrade from previous release Use Help -> Check For Updates RCP is upgraded
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Manual

Manual
Manual

Manual

Manual

Manual

Manual

Manual

Manual
Manual

Manual

Manual

Manual

Manual
Manual

Manual
Manual

Manual

should it open?

Trace Compass RCP Branding Plug-in has 2016 copyright year

Tested with RC3



Target:

Step

0

0.1

0.2

0.3
1

1.1
1.2

1.3

1.4

1.5

1.6

1.7
1.8

1.9

Section
Trace Synchronization

Test Case

Prerequisites

Import traces

Create experiment 1
Create experiment 2
View Management
Open Synchronization
View

Delete view

Open view

Open Experiment

Synchronize experiment

Open view when trace is
already loaded

Synchronize experiment
with constant offset

Open trace

Re-open experiment

Restart
Functionnalities

Open experiment 2

Go back to previous
experiment

Synchronize experiment

2.3.0-TraceCompassTestCases - TraceSynchronization

Pass
13

Action

Import the scp_dest and scp_src traces in the
synctraces.tar.gz file

Create an experiment containing those 2 traces
Create an experiment with any other trace

Use menu Window — Show View — Tracing —
Synchronization

Close the Synchronization View

Use menu Window — Show View — Tracing —
Synchronization

Open the experiment containing the 2
synchronizable traces

Right-click on the experiment and select
'Synchronize Traces'

1) Close Synchronization View
2) Load LTTng experiment
3) Open 'Synchronization' view

Try to offset a trace by a second
Open an Lttng Kernel trace

Open the experiment containing the 2
synchronized traces

Restart Eclipse

Open the experiment containing traces that do not
synchronize

Re-open the experiment with the synchronizable
traces

Right-click on the experiment and select
'Synchronize traces'

Fail

Verification

Verify that 'Synchronization' view is shown
Synchronization' view is removed from perspective

Synchronization' view is displayed and remains empty

Verify that the view is still empty

After a time, the view is populated with synchronization
result that say 'accurate'. And one of the original traces
has been replace by a trace with the same name, but
with an'_' at the end.

Verify that view is populated with synchronization data
from currently opened experiment

Visually verify that a synchronized trace is now offsetted
Synchronization view is empty

View shows synchronization data from the experiment

Verify that view is populated with synchronization data
from experiment

Verify that the 'Synchronization' view is empty

Verify that the 'Synchronization' view contains the data
from the experiment

After the syncronization job finishes, the synchronized
experiment is closed and experiment 2 is selected. The
synchronization view is empty.

To Do

Comment

| o | o s

Manual
Manual

Manual

Manual

Manual

Manual

Manual
Manual

Manual

Manual

Manual

Manual

Manual

Pass
Pass

Pass

Pass

Pass

Pass

Pass
Pass

Pass

Pass

Pass

Pass

Pass

Comment

This view should be in properties

The view also makes no sense to mere mortals.

Absent is not displayed, the view is empty. Patrick:
Updated the verification text

| agree



Target:

0.1

0.2

0.3
0.4

21

2.2
2.3

2.4

25

2.6

3.1

3.2

Section

LTTng 2.0 - Memory
Analysis

Ubuntu 14.04 64 bit
Test Case

Prerequisites

Download traces

Import trace with memory
event

Import trace without
memory event

Import non-UST trace

Project View
Check analysis can

execute

Verify help message when
applicable

Check analysis cannot
execute

Verify help message when
not applicable

Check analysis for another
trace type

View Management
Populate analysis's view

Open view
Close trace

Open trace

Close view

Re-open view

Mouse handling
Drag move time range

Zoom time range (mouse
wheel)

2.3.0-TraceCompassTestCases - LTTng 2.0 - Memory analysis

Download UST trace with memory events
from http://secretaire.dorsal.polymtl.
ca/~gbastien/traces/eclipse_mem_ust.tar.gz

Import the LTTng UST trace downloaded
above in Tracing project

Import one of the LTTng UST trace that
does not contain the memory events, for
example, the one used for the callstack view

Import one LTTng Kernel trace

open the trace that contains the memory
events. In the project explorer, expand the
trace that contains the memory events

In the project explorer, open and expand
the trace that contains the memory events,
right-click the memory analysis and select
Help

open the trace that contains the memory
events. In the project explorer, expand the
UST trace that does not contain memory
events

In the project explorer, open and expand
the UST trace that does not contain memory
events, right-click the memory analysis and
select Help

In the project explorer, expand a LTTng
Kernel trace

Open the UST trace with memory events
and expand the "UST Memory" analysis in
the project explorer

Double-click the UST Memory View under
the memory analysis

Close the trace

With the view already opened, open the
trace

Close the UST Memory Usage view
Double-click the UST Memory Usage view
under the memory analysis in project
explorer.

Drag move xy chart left and right with
middle button

Zoom with CTL + mouse wheel up and
down, cursor inside xy chart

Verification

"Ust Memory" analysis is present and "normal"

A generic help message appears with the name of the analysis.

"Ust Memory" analysis is present, but striked-out

The help message mentions the analysis is impossible to
execute and contains the requirement that is not fulfilled

"Ust Memory" analysis is not present

"Ust Memory Usage" View appears under the analysis

The UST Memory Usage view opens and triggers the memory
analysis. After the analysis, the XY chart is populated

The UST Memory Usage view is emptied.

The UST Memory Usage view is populated.

The view is closed.

The view opens and is automatically populated.

Time range is dragged. When mouse button is released, the
view refreshes with the new time range

Time range is zoomed in and out, relative to mouse cursor.
When mouse wheel is stopped for a short time, series are
updated and new time range is propagated to other views.

65

Manual

Manual

Manual

Manual

Manual

Manual

SWTBot
Manual

SWTBot

Manual

Manual

Manual

Manual

Pass

Pass

Pass

Pass

Pass

Pass

Pass
Pass

Pass

Pass

Pass

Pass

Pass

Comment

Comment

84702

84702

84702

View not populated. Bug 467751. JC: Works for
me

But while dragging, nothing visible happen



3.3

3.4

3.5

3.6

3.7

3.8

4.1

4.2

4.3

Drag select time range

Mouse hover

Drag mouse selection

Shift key selection

Drag mouse selection
(Status bar)

Shift key selection (Status
bar)

Synchronization

Preparation

Time synchronization

Time range synchronization

Time range selection
synchronisation

2.3.0-TraceCompassTestCases - LTTng 2.0 - Memory analysis

Drag select time graph with right button

Hover mouse in xy chart anywhere

Drag select xy chart with left button

Click select with left button (begin time),
press shift key and click select another time
(end time)

Drag select xy chart with left button

Click select with left button (begin time),
press shift key and click select another time
(end time)

Have the Histogram and UST Memory
Usage views both visible

Select a random time in another view

Select a new time range in UST Memory
Usage view or in Histogram view.

In any other view that supports range
synchronization, select a new range.

Selection highlighted. When mouse button is released, time
range is zoomed to selection, series are updated and new time
range is propagated to other views.

Tool tip shows values for each thread at the given timestamp

Selection highlighted. New selection is propagated to other
views

Selection highlighted. New selection is propagated to other
views

Selection highlighted. Status bar of Eclipse is updated with time
information: T, T1, T2 and delta, where T is the time of the
mouse position, T1 the first selected time, T2 the second
(draggged) selected time and delta the time difference between
T2-T1 (can be negative)

Selection highlighted. Status bar of Eclipse is updated with time
information: T, T1, T2 and delta, where T is the time of the
mouse position, T1 the first selected time, T2 the second
(draggged) selected time and delta the time difference between
T2-T1 (can be negative)

Selected time line is updated.

Time range is updated.

Selection range is highlighted.
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Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

i open the memory trace, then the view, drag
select with right button, works, drag select with
right button again, not working. But when i
navigate within the trace before 'drag select', it
works fine. (https:/bugs.eclipse.
org/bugs/show_bug.cgi?id=513013)

The tooltip is not aligned with the selection when
hovering multiple times

Bernd: | cannot reproduce this problem

What is the difference between 3.5 and 3.7?
Status bar is not updated. Note that the status
bar hasn't been implemented for XY charts. So
we should not test for it

Status bar not updated

time range is NOT updated to include the new
selection. The range update seems to not work
with UST traces. Patrick: Only time graph views
update their window range to ensure selection is
visible.

Ithink this test is for window range. | have this
exception : Exception in thread "Line chart
update" org.eclipse.swt.SWTException: Invalid
thread access

(Invalid Thread access bug: https:/bugs.eclipse.
org/bugs/show_bug.cgi?id=513013)

time range is NOT updated to include the new
selection. The range update seems to not work
with UST traces:

Patrick: Only time graph views update their
window range to ensure selection is visible.
(Invalid Thread access bug: https:/bugs.eclipse.
org/bugs/show_bug.cgi?id=513013)



Target:

Step

0
0.1
1

1.1

1.2

1.5

2.2
2.3
24
25

Section
LTTng 2.0 - CPU Analysis

Test Case

Prerequisites

Import traces

Project View

Check analysis can
execute

Verify help message when
applicable

Check analysis for another

trace type

View Management
Populate analysis's view
Open view

Close trace

Open trace
Close view

Re-open view
View selection

Select an entry

Select another entry
Mouse handling

Drag move time range

Zoom time range (mouse
wheel)

Mouse vertical scroll

Vertical scroll bar

Drag select time range

Mouse hover

2.3.0-TraceCompassTestCases - LTTng 2.0 - CPU analysis

Pass

Action

Import LTTng Kernel traces in Tracing project

In the project explorer and expand a LTTng
Kernel trace

In the project explorer, open and expand the
LTTng kernel trace, right-click the CPU usage
analysis and select Help

In the project explorer, expand a non-LTTng
Kernel trace

Open an LTTng kernel trace and expand the
"CPU usage" analysis in the project explorer

Double-click the CPU usage View under the
CPU usage analysis

Close the trace
With the view already opened, open the trace
Close the CPU Usage view

Double-click the CPU Usage view under the
CPU usage analysis in project explorer.

Select an entry in the tree viewer section

Select another entry from the tree viewer

Drag move xy chart left and right with middle
button and shift mouse wheel

Zoom with ctrl mouse wheel up and down,
cursor inside xy chart

Scroll with mouse wheel up and down, cursor
outside xy chart

Click and drag vertical scroll bar

Drag select time graph with right button in xy
chart

Hover mouse in xy chart region anywhere

Verification

"CPU usage" analysis is present and it's not crossed out

A generic help message appears with the name of the

analysis

"CPU usage" analysis is not present

"CPU Usage" View appears under the analysis

The CPU usage Usage view opens and triggers the cpu
analysis. After the analysis, both tree viewer and xy charts

are populated.

The CPU Usage view is emptied.
The CPU Usage view is populated.

The view is closed.

The view opens and is automatically populated.

A new series is added to the xy chart, corresponding to the

selected TID

A new series is added to the xy chart, and the previous TID's

Fail

series is not displayed anymore

Time range is dragged. When mouse button is released,
series are updated and new time range is propagated to other

views.

Time range is zoomed in and out, relative to mouse cursor.
When mouse wheel is stopped for a short time, series are
updated and new time range is propagated to other views,
including the tree viewer beside the chart. The selected
process remains the same.

Table scroll up and down. Selected process does not change.
Vertical scroll bar updated.

Tree viewer scrolls up and down. Selected process does not

change.

Selection highlighted. When mouse button is released, time
range is zoomed to selection, series are updated and new
time range is propagated to other views. Selected process

remains the same.

Tool tip shows the total and selected process (if any) cpu

usage at the time

Type To Do
0 0
Type

Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual

Comment
8

Comment

Sonia: The help message doesn't explain the
role of the view or how to use it. There should
be more details available

tooltip not align with the mouse position
Bernd: | cannot reproduce this problem on my
computer.

84702

84702



2.3.0-TraceCompassTestCases - LTTng 2.0 - CPU analysis

Selection highlighted and selection range is propagated to

works wit 1 kernel

4.7 Drag mouse selection Drag select xy chart with left button other views Manual
Click select with left button (begin time), press
shift key and click select another time (end Selection highlighted and selection rang is propagated to
4.8 Shift key selection time) other views Manual
Entries are sorted in ascending then descending order on the
4.9 Sort columns Click on column headers once then twice column value. Selected process does not change. Manual Column TID should use Integer sorting.
Selection highlighted. Status bar of Eclipse is updated with
time information: T, T1, T2 and delta, where T is the time of
] the mouse position, T_1 the first selected_tlme,_TZ the second Status bar is not updated. Note that the status
Drag mouse selection (draggged) selected time and delta the time difference bar hasn't been implemented for XY charts. So
4.10 (Status bar) Drag select xy chart with left button between T2-T1 (can be negative) Manual N/A we should not test for it
Selection highlighted. Status bar of Eclipse is updated with
time information: T, T1, T2 and delta, where T is the time of
Click select with left button (begin time), press the mouse position, T1 the first selected time, T2 the second
Shift key selection (Status  shift key and click select another time (end (draggged) selected time and delta the time difference
411 bar) time) between T2-T1 (can be negative) Manual N/A Status bar not updated
5 Keyboard handling
Keyboard navigation in tree  With focus on table, use UP, DOWN, HOME,  Selected process is changed. xy chart selection is updated.
5.1 viewer END keys Vertical scroll bar updated. Manual
6 Synchronization
Selected time line is updated. If selected time is outside
6.1 Time synchronization Select a random time in another view current range, time range is updated to include it. Manual
Select a new time range in CPU usage view or
6.2 Time range synchronization in Histogram view. Time range is updated. Manual
Selection is highlighted. If the most left time (T1) of
Time range selection In any other view that supports range selected time range is outside the current range, then time
6.3 synchronisation synchronization, select a new range. range is updated to include it Manual
Sonia : The cpu usage works only on
. experiments with one trace , it would be nice if
CPU usage works with it displays the CPU usage of two traces per
experiments Manual example in the same graph
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Section
Network Trace analysis

Target: Ubuntu 14.04 64 bit

Step

1.1

1.2

2.1

2.2

2.3
2.4

2.5

2.6

3.1

3.1

3.2

Test Case

Prerequisites
Import traces
Trace Import

Open the Network Tracing
perspective

Open trace
View management
Populate the views

Look up stream

Close the trace
Close view

Open view when trace is
already loaded

Open a non pcap trace
Stream List
Re-open trace

Create a filter from the
stream list

Apply filter

2.3.0-TraceCompassTestCases - Network Analysis

Pass
11

Action

Import the trace linked here

In the project Explorer, expand any LTTng
kernel trace

Double-click on the "TeamSpeak2.pcap" trace

Open the "TeamSpeak2.pcap”
Open the Stream List view

Close the trace
Close the Stream List view

Re-open the trace. Open The Stream List view

Close the trace

Ensure only "TeamSpeak2.pcap" is opened

Right click on stream 0, and select "Extract as
Filter"

In the events table, right click on an event and
select "Apply preset filter-> stream eth 00:0c:
29.."

Fail

Verification

Verify that the events view, the properties and
stream list are displayed

The trace is given a "network" icon. When openned,

the events view and histogram view is opened

The views are updated

One stream is available with endpoint A being 00:

0c:29:7c:ab:f9

The stream list is emptied
The view is closed

The view opens with the correct title and is
correctly populated.

The stream list is emptied

The trace is opened

A filter named "FILTER stream eth 00:0c:29..." is

created

24/24 events pass the filter

69

To Do
0

SWTBot |

SWTBot

SWTBot

Manual

Manual
Manual

Manual

Manual

Manual

Manual

Manual

Pass

Pass

Pass

Pass

Pass
Pass

Pass

Pass

Pass

Pass

Pass

Comment

0

Comment

In SWTBot other trace is used


http://wiki.wireshark.org/SampleCaptures?action=AttachFile&do=get&target=TeamSpeak2.pcap

Section
XML analysis

Target: Ubuntu 14.04 64 bit

Step

0.1

0.2

0.3

13

2.1

22

2.3

24

2.5
2.6
2.7
2.8
29

3.1

3.1

23

Test Case

Prerequisites
Import traces

Get a test XML file

Make sure the XML file does
not exists in the project

XML file handling
Verify analysis not present

Import XML file

Edit XML file

View management

Populate the views

Open the 'Xml Control Flow
View'

Open another XML view
Close view

Open view when trace is
already loaded

Close traces

Open trace

Open another trace

Open LTTng Kernel trace
View selection

Select an entry in the table

Select entry in time graph

Select state in time graph

2.3.0-TraceCompassTestCases - XMLanalysis

Pass
39

Action

Import LTTng kernel traces
Download the test XML file here: http://secretaire.

dorsal.polymtl.ca/~gbastien/Xml4Traces/Kernel.Linux.

xml

Open the Manage Xml Analyses menu and delete the

XML file if it exists (or The XML files are located in

<workspace directory>/.metadata/.plugins/org.eclipse.
tracecompass.tmf.analysis.xml.core/xml_files. Delete

the linux kernel XML file if it exists.)

In the project Explorer, expand any LTTng kernel trace

Right-click the Traces folder, select Manage XML
analyses.... In the opened dialog import the Kernel.
Linux.xml file and close the dialog.

Right-click the Traces folder, select Manage XML
analyses.... In the opened dialog, select Kernel.Linux
and click Edit

Open an LTTng kernel trace

Double-click the 'Xml Control Flow View' under the
analysis

Double-click the "Xml Resources View' under the
analysis

Close both XML view

Double-click one of the views under the analysis
Close all opened traces

Open an LTTng Kernel trace

Open a non-LTTng Kernel trace

Open an LTTng Kernel trace

Select an entry in the table

Select an entry in the time graph (empty region)

Select a state in the time graph

Fail

Verification

NOTE: XML haven't files haven't been update to latest Kernel tracepoints and
syscall changes. So, they only work with trace LTTng 2.5 and older

Verify that there is no 'Xml kernel State System' analysis

Verify that the 'Xml kernel State System' analysis is now present
under a LTTng kernel trace

Verify that the XML editor opens. The editor should have Design
and Source sub-tabs

The 'Xml kernel State System' analysis should have a + next to it,
expand it and there should be 2 views under it: 'Xml Control
Flow View' and 'Xml Resources View'

A view titled 'Xml Control Flow View' should open and it should
look quite similar to the Control Flow View

A view titled 'Xml Resources View' should open and it should
look quite similar to the Resources view's CPU entries. Both
XML views are opened.

The view are closed

The view opens with the correct title and is correctly populated.
The view is emptied.

The view is populated

The view is emptied.

The view is populated.

Same entry is highlighted in time graph.

Same entry is highlighted in table. Selected time line is updated.
Other views are synchronized to selected time.

Same entry is highlighted in table. State is highlighted in time
graph. Selected time line is updated. Other views are
synchronized to selected time.
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Type
0

To Do
0

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual
Manual
Manual
Manual
Manual

Manual

Manual

Manual

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass
Pass
Pass
Pass
Pass

Pass

Pass

Pass

Comment
6

Comment




4.1

4.2

4.3

44

4.5

4.6

4.7

4.8

4.9

4.10

4.11

5.1

‘Mouse handling

Drag move time range

Zoom time range (mouse
wheel)

Zoom time range (mouse
drag)

Mouse vertical scroll

Vertical scroll bar

Drag select time range

Double-click reset time range

Mouse hover (empty region)

Mouse hover (state)

Drag mouse seleection

Shift key selection

Keyboard handling

Keyboard navigation in table
(entry selection)

2.3.0-TraceCompassTestCases - XMLanalysis

Drag move time graph left and right with middle
button

Zoom with CTRL + mouse wheel up and down, cursor
inside time graph

Drag in time graph scale left and right with left button

Scroll with mouse wheel up and down, cursor outside
time graph

Click and drag vertical scroll bar

Drag select time graph with right button

Double-click left button on time scale

Hover mouse in time graph over empty region

Hover mouse in time graph over state

Drag select time graph with left button

Click select with left button (begin time), press shift

‘key and click select another time (end time)

With focus on table, use UP, DOWN, HOME, END
keys

Time range is dragged. When mouse button is released, states are
updated and new time range is propagated to other views.

Time range is zoomed in and out, relative to mouse cursor. When
mouse wheel is stopped for a short time, states are updated and
new time range is propagated to other views.

Time range is zoomed in and out. When mouse button is
released, states are updated and new time range is propagated to
other views.

Table and time graph scroll up and down and remain aligned.
Selected entry does not change. Vertical scroll bar updated.

Table and time graph scroll up and down and remain aligned.
Selected entry does not change.

Selection highlighted. When mouse button is released, time range
is zoomed to selection, states are updated and new time range is
propagated to other views.

Time range is reset to full range, states are updated and new time
range is propagated to other views.

Tool tip shows entry name only.

Tool tip shows entry name, state name, date, start time, end time,
duration.

Selection highlighted. Status bar of Eclipse is updated with time
information: T, T1, T2 and delta, where T is the time of the
mouse position, T1 the first selected time, T2 the second
(draggged) selected time and delta the time difference between
T2-T1 (can be negative)

Selection highlighted. Status bar of Eclipse is updated with time
information: T, T1, T2 and delta, where T is the time of the
mouse position, T1 the first selected time, T2 the second
(draggged) selected time and delta the time difference between

'T2-T1 (can be negative)

Selected process is changed. Time graph selection is updated.
Vertical scroll bar updated.
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Manual
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Manual

Manual

Manual

Manual

Manual

Manual

Manual

"the new window range"



52

5.4

6.1

6.2

6.3

6.4

6.5
6.6

6.7

7.1

7.2

7.3

Keyboard navigation in table
(tree expansion)

Keyboard navigation in time

graph (process selection)

Keyboard navigation in time
graph (state selection)

Tool bar handling

Show Legend

Reset Time Scale

Select Previous/Next Event

Select Previous/Next Process

Zoom In/Out
Filter Dialog

Filter Processes
Synchronization

Time synchronization

Time range synchronization

Time range selection
synchronisation

2.3.0-TraceCompassTestCases - XMLanalysis

With focus on table,
in Windows use LEFT, RIGHT keys while parent or
child process is selected

in Linux use SHIFT LEFT, RIGHT keys while parent
or child process is selected

With focus on time graph, use UP, DOWN, HOME,
END keys

“With focus on time graph, use LEFT, RIGHT keys

Click Show Legend button

Click Reset Time Scale button
Click Previous/Next Event button

Click Previous/Next interval button

Click Zoom In/Out button
Open Filter Dialog

1) Open Filter Dialog
2) Deselect several processes
3) Press Ok

Select a random time in another view

Select a new time range in Resources view or in
Histogram view.

In any other view that supports range synchronization,
select a new range.

For parent process, tree is expanded or collapsed. Time graph
item expansion is updated. Vertical scroll bar updated. For child
process, left changes selection to parent, time graph selection is
updated. Vertical scroll bar updated.

Selected process is changed. Table selection is updated. Vertical
scroll bar updated.

Previous or next state is selected. Selected time is updated in

other views.

The legend dialog is opened and can be closed.

Time range is reset to full range, states are updated and new time
range is propagated to other views.

Previous or next state is selected. Selected time is updated in
other views.

Selected interval (process/resource) is changed in table and time
graph. Vertical scroll bar updated.

Time range is zoomed in and out, relative to center of time range.
States are updated and new time range is propagated to other
views.

Verify that all buttons are working correctly

Verify that only selected entries are displayed in the view
Selected time line is updated. If selected time is outside current
range, time range is updated to include it.

Time range is updated.

Selection is highlighted. If begin time (T1) of selected time range
is outside the current range, then time range is updated to include
it

72

Manual
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Manual
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Manual

Manual

Manual

Manual

Passed on Linux.

Comment from 1.0 testing: Not all displayed
colors are in the legend

This is still a problem in 1.1 when using
traces generated with LTTng 2.6 and older

More filter buttons are available in cfv



2.3.0-TraceCompassTestCases - Critical Path

Section Pass Fail To Do Comment
Critical path 44 2 0 6
Target:
Step Test Case Verification Comment
0 Prerequisites
Import the 3
django traces from
0.1 Import traces the test traces
Create an
experiment with
0.2 Create experiment the 3 traces in it
Synchronize the
experiment, it
should be
accurate and 2 of
Synchronize the traces will be
0.3 experiment udpated
View
1 management

Expand the Views element under the trace.
The LTTng Kernel Exec Graph analysis is
Open any of the  there and "normal". The Critical Path
django traces in analysis is there and the Critical Flow view
1.1 Open trace Project Explorer  is available under it. Manual Pass

Expand the Views element under the trace.
The LTTng Kernel Exec Graph analysis is
Open the django  there and "normal”. The Critical Path
experiment in analysis is there and the Critical Flow view
1.2 Open experiment  Project Explorer is available under it. Manual Pass

Expand the Views
element, then the
Critical Path
analysis and click
on the Critical
1.3 Open view Flow View Critical Path view is opened and empty SWTBot Pass
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1.4

1.5

1.6

21

2.2

23

24

Close view

Unapplicable trace

Unapplicable

experiment

View population

Populate the view
with trace

Select worker in
time graph
Select state in

time graph

Select worker in
tree viewer

2.3.0-TraceCompassTestCases - Critical Path

Close the Critical
Flow View Critical Path view is closed Manual

Expand the Views element under the trace.
The LTTng Kernel Exec Graph analysis is
Open a trace that not there. The Critical Path analysis is there

isnotalLTTng and the Critical Flow view is available under
kernel trace it. Manual
Open an Expand the Views element under the trace.

experiment that The LTTng Kernel Exec Graph analysis is
does not contain  there, but striked out. The Critical Path
LTTng kernel analysis is there and the Critical Flow view

traces is available under it. Manual

With the django-

client trace and

the critical path

view opened, in

the control flow

view, find the

process named

python (TID 9496).

Right-click on the

process and select The LTTng kernel exec graph is executed
"Follow and at the end, the critical path view shows
python/9496" the interaction between 3 workers. SWTBot

Selectan empty  Same process is highlighted in table.
region in the time  Selected time line is updated. Other views
graph section are synchronized to selected time. Manual

Same process is highlighted in table. State
is highlighted in time graph. Selected time
Selecta state in  line is updated. Other views are
the time graph synchronized to selected time. Manual

Select a worker
from the tree
viewer section Same process is highlighted in time graph. Manual
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This should be re-teg

Done in SWBot with



2.5

255

26

2.7

2.8

3.1

3.2

Populate the view
with empty path

Select again

Re-opening

Populate the view
with experiment

Populate with
trace with time
selection

‘Mouse handling

Drag move time
range

Zoom time range
(mouse wheel)

2.3.0-TraceCompassTestCases - Critical Path

Repeat steps of
2.1, with django-
client trace and
process lttng-
sessiond (TID
9355)

Repeat steps of
2.1, and select

python/9496 again

Close the django-
client trace,
reopen it and
repeat steps of 2.1

Repeat steps of
2.1, but with the

django-experiment

instead
Re-open django-
client trace. In the

Control Flow View,

select a time after
the python
process exited,
then follow the
python/9496

process

Ctrl-Drag move

time graph left and

right with middle
button

Zoom with mouse
wheel up and
down, cursor
inside time graph
while holding the
Ctl button

The Critical Path View is emptied

The critical path should be the same as 2.1

The Critical Path View should be populated
like in step 2.1

The LTTng kernel exec graph is executed
and at the end, the critical path view is
populated with elements from the 3 traces.

The Critical Path View should be populated

like in step 2.1

Time range is dragged. When mouse button
is released, states are updated and new
time range is propagated to other views.

Time range is zoomed in and out, relative to
mouse cursor. When mouse wheel is
stopped for a short time, states are updated
and new time range is propagated to other
views.
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Manual

Manual

Manual

Manual

But there should be :

The critical path is n«

Because of the bug i



3.3

3.4

3.5

3.6

3.7

3.8

3.9

3.10

3.1

Zoom time range
(mouse drag)

Mouse vertical
scroll

Vertical scroll bar

Drag select time
range

Double-click reset
time range

Mouse hover
(empty region)

Mouse hover
(state)

Drag mouse
selection

‘Shift key selection

Keyboard
handling

2.3.0-TraceCompassTestCases - Critical Path

Drag in time graph
scale left and right

with left button

Scroll with mouse
wheel up and
down, cursor

outside time graph

Click and drag
vertical scroll bar

Drag select time
graph with right
button
Double-click left
button on time
scale

Hover mouse in
time graph over
empty region
Hover mouse in
time graph over
state

Drag select time
graph with left
button

Click select with
left button (begin
time), press shift
key and click
select another

‘time (end time)

Time range is zoomed in and out. When
mouse button is released, states are
updated and new time range is propagated
to other views.

Table and time graph scroll up and down
and remain aligned. Selected worker does
not change. Vertical scroll bar updated.

Table and time graph scroll up and down
and remain aligned. Selected process does
not change.

Selection highlighted. When mouse button
is released, time range is zoomed to
selection, states are updated and new time
range is propagated to other views.

Time range is reset to full range, states are
updated and new time range is propagated
to other views.

Tool tip shows process name only.

Tool tip shows worker name, state name, priority, date,
start time, end time, duration.

Selection highlighted. Status bar of Eclipse is updated with
time information: T, T1, T2 and delta, where T is the time
of the mouse position, T1 the first selected time, T2 the
second (dragged) selected time and delta the time
difference between T2-T1 (can be negative)

Selection highlighted. Status bar of Eclipse is updated with
time information: T, T1, T2 and delta, where T is the time
of the mouse position, T1 the first selected time, T2 the
second (dragged) selected time and delta the time

'difference between T2-T1 (can be negative)
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4.1

4.2

4.3

4.4

5.1

52

5.3

5.4

55

5.6

Keyboard
navigation in table
(process selection)

Keyboard
navigation in table
(tree expansion)

Keyboard
navigation in time
graph (process
selection)

Keyboard
navigation in time
graph (state

selection)

Tool bar handling '

Align views

Show Legend

Reset Time Scale

Select
Previous/Next
Event

Select Previous/Next
Element

Zoom In/Out

2.3.0-TraceCompassTestCases - Critical Path

With focus on
table, use UP,
DOWN, HOME,
END keys

With focus on table,

in Windows use LEFT,
RIGHT keys while trace
or worker is selected

in Linux use SHIFT
LEFT, RIGHT keys while
trace or worker is
selected

With focus on time
graph, use UP,
DOWN, HOME,
END keys

With focus on time
graph, use LEFT,
RIGHT keys

Click on the Align View
Button, with another time
graph view, eg the
Control Flow view
opened above or under

Click Show
Legend button

Click Reset Time
Scale button
Click
Previous/Next
Event button
Click
Previous/Next
Element button

Click Zoom In/Out
button

Selected process is changed. Time graph
selection is updated. Vertical scroll bar
updated.

For trace, tree is expanded or collapsed. Time graph item
expansion is updated. Vertical scroll bar updated. For
workers, it does nothing.

Selected worker is changed. Table selection is updated.
Vertical scroll bar updated.

Previous or next state is selected. Selected

‘time is updated in other views.

When it is pressed, moving the line between tree viewer
and time graph will move the line of the other view. If not
pressed, the line can be moved without affecting the other
views

The legend dialog is opened and can be
closed.

Time range is reset to full range, states are
updated and new time range is propagated
to other views.

Previous or next state is selected. Selected
time is updated in other views.

Selected worker is changed in table and
time graph. Vertical scroll bar updated.

Time range is zoomed in and out, relative to
center of selection or window. States are
updated and new time range is propagated
to other views.
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Manual

Manual

Tested in Linux



5.7

5.8

5.9

5.11
5.12

6.1

6.2

6.3

Add Bookmark

Next/Previous marker

Delete bookmark

Do not show markers

_Show markers

Synchronization

Time
synchronization

Window range
synchronization

Selection range
synchronization

2.3.0-TraceCompassTestCases - Critical Path

Select a time, and click
on the Add Bookmark
button

Add more bookmarks,
then click on the
next/previous marker
buttons

With next/previous
marker, when on a
bookmark, click the
delete bookmark button

Click on the down arrow
at the extreme right of
the view, then expand
Show markers and
uncheck the Bookmarks
box

Same as above, recheck

_the Bookmarks box

Select a random
time in another
view

Select a new window
range in another view
In any other view
that supports
selection range
synchronization,
select a new
range.

With a critical path
displayed, select a
time in another view
that is not in the range

of the process being
displayed in the critical

6.4 Out of region selection path view

The bookmark is added and is displayed in the other views
as well (if enabled)

The time graph view navigate between the bookmarks,
States are updated and time selection is propagated to
other views. When on a bookmark, the Add bookmark
buttons changes to Delete bookmark

The bookmark is deleted from all views

All remaining bookmarks disappear from the view, but
remain in other views where the they are enabled

_The bookmarks come back

Selected time line is updated. If selected
time is outside current range, time range is
updated to include it.

Window range is updated.

Selection is highlighted. If the left time (T1)
of selected time range is outside the current
range, then window range is updated to
include it

Selected time is updated and the critical path view is
synced with the other
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2.3.0-TraceCompassTestCases - LTTng 2.0 - I/O analysis

Section Comment

LTTng 2.0-1/0
Analysis 9
Target:
Test Case Action Verification Comment
0 Prerequisites
Import LTTng
Kernel traces in
0.1 Import traces Tracing project
1 Project View
Bruno : In the
'Views' tree item,
there is a
Input/Output item,
but im not sure
what it means to be
"Input/Output” ‘normal’
In the project  analysis is Genevieve: normal
is not striked-out
explorer, present and (added it to the
Check analysis expand a LTTng "normal" (not verif step), it is a
1.1 can execute Kernel trace striked-out) SWTBot _ Pass pass
In the project
explorer, open
and expand the
LTTng kernel A generic help
trace, right-click message
Verify help the Input/Output appears with Bruno : The help
message when analysis and the name of the message doesn't
1.2 applicable select Help analysis Manual _ Pass  explain much
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1.5

2.1

2.2

23

24

Check analysis
for another

trace type

View
Management

Populate
analysis's view

Open view

Close trace

Open trace

2.3.0-TraceCompassTestCases - LTTng 2.0 - I/O analysis

In the project
explorer,
expand a non-
LTTng Kernel

trace

Open an LTTng
kernel trace and
expand the
"Input/Output”
analysis in the
project explorer

Double-click the
Disk I/O Activity
View under the
Input/Output
analysis

Close the trace

With the view
already opened,
open the trace

"Input/Output”
analysis is not

_ present | SWTBot

"Disk 1/10

Activity" View

appears under

the analysis SWTBot

The Disk 1/0

Activity view

opens and

triggers the

input/output

analysis. After

the analysis, the

Xy charts is

populated. Manual

The Disk 1/0
Activity view is
emptied. Manual

The Disk /0O
Activity view is
populated. Manual
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Bruno : Not really a
bug, when opening
the trace the zoom
is so small that the
I/O graph seems
empty Geneviéve:
it is the same time
range as other
views, so if no
read/write was
done in that time, it
is normal that it
looks empty

84702



2.3.0-TraceCompassTestCases - LTTng 2.0 - I/O analysis

Close the Disk  The view is
2.5 Close view I/O Activity view closed. Manual
Double-click the
Disk 1/0 Activity
view under the The view opens
Input/Output and is
analysis in automatically
2.6 Re-open view  project explorer. populated. Manual
3 View selection |
Mouse
4 handling
Time range is
dragged. When
mouse button is
released, series
Drag move xy  are updated and
chart left and new time range
Drag move time right with middle is propagated to
4.1 range button other views. Manual
Time range is
zoomed in and
out, relative to
Mmouse Cursor.
When mouse
wheel is
stopped for a
short time,
Zoom with series are
mouse wheel up updated and
Zoom time and down, new time range
range (mouse  cursorinside xy is propagated to
4.2 wheel) chart other views. Manual
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4.3

4.4

4.5

4.6

Drag select time
range

Mouse hover

Drag mouse
selection

Shift key
selection

2.3.0-TraceCompassTestCases - LTTng 2.0 - I/O analysis

Drag select time
graph with right
button in xy
chart

Hover mouse in
xy chart region
anywhere

Drag select xy
chart with left
button

Click select with
left button
(begin time),
press shift key
and click select
another time
(end time)

Selection
highlighted.
When mouse
button is
released, time
range is
zoomed to
selection, series
are updated and
new time range
is propagated to
other views.

Tool tip shows
the puntual disk
activity, with
units in <unit>/s

Selection
highlighted and
selection range
is propagated to
other views

Selection
highlighted and
selection rang is
propagated to
other views
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Manual

Manual

Bruno : The tool tip
is showing but is
not folowing the
mouse, so the infos
are updated but the
black box remain at
the original place.



4.70

Drag mouse
selection
(Status bar)

2.3.0-TraceCompassTestCases - LTTng 2.0 - I/O analysis

Drag select xy
chart with left
button

Selection
highlighted.
Status bar of
Eclipse is
updated with
time
information: T,
T1, T2 and
delta, where T
is the time of
the mouse
position, T1 the
first selected
time, T2 the
second
(draggged)
selected time
and delta the
time difference
between T2-T1
(can be
negative) Manual
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Status bar is not
updated. Note that
the status bar
hasn't been
implemented for
XY charts. So we
should not test for it



2.3.0-TraceCompassTestCases - LTTng 2.0 - I/O analysis

Click select with
left button
(begin time),
press shift key

Selection
highlighted.
Status bar of
Eclipse is
updated with
time
information: T,
T1, T2 and
delta, where T
is the time of
the mouse
position, T1 the
first selected
time, T2 the
second
(draggged)
selected time
and delta the
time difference

Shift key and click select between T2-T1
selection another time (can be
4.8 (Status bar) (end time) negative) Manual
| |
Keyboard
5 handling
6 Synchronization
Selected time
line is updated.
If selected time
is outside
current range,
Select a random time range is
Time time in another updated to
6.1 synchronization view include it. Manual

84

Status bar not
updated




Time range

6.2 synchronization
Time range
selection

6.3 synchronisation

Disk I/O Activity
works with
6.4 experiments

2.3.0-TraceCompassTestCases - LTTng 2.0 - I/O analysis

Select a new
time range in
Disk I/O Activity
view or in
Histogram view.

In any other
view that
supports range
synchronization
, select a new
range.

Time range is
updated. Manual

Selection is
highlighted. If
the most left
time (T1) of
selected time
range is outside
the current
range, then
time range is
updated to
include it Manual

Manual
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Bruno : Did not
work when
zooming out, "An
internal error
occurred during:
" dialog popup
Geneviéve: It
randomly works or
not (didn't work on
an experiment | just
opened, apeared to
work on the already

opened experiment seems to show i/o

when opening trace data for the 1st
compass) Matthew: trace and not the
worked for me! others



2.3.0-TraceCompassTestCases - LTTng 2.0 - VM analysis

Section Comment

LTTng 2.0-VM
Analysis

Target:

Test Case Action Verification Comment

0 Prerequisites

Download
traces here:
https:
//secretaire.
dorsal.polymtl.
ca/~gbastien/tra
cingSummit201
4/mpi_traces.
tgz and import
the 3 kernel
traces in the
0.1 Import traces vmnet directory

Create an
Create experiment with
0.2 experiment the 3 traces in it JC:This experients b

Synchronize the
experiment, it
should be
accurate and 2
Synchronize of the traces will
0.3 experiment be udpated
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0.4

1.1

1.2

1.3

1.4

Set experiment

type

View
management

Analysis
present

Open
experiment

Open view

Close view

2.3.0-TraceCompassTestCases - LTTng 2.0 - VM analysis

Right-click the
experiment,
click "Select
experiment
type..." and
select "Virtual
Machine

'Experiment"

Expand the
Views element
of the
experiment

Open the vm
experiment in
Project Explorer

Expand the
Views element,
then the Virtual
Machine
analysis and
click on the
Virtual CPU
View

Close the
Virtual CPU
View

The Virtual
Machine
Analysis is
present
Expand the
Views element
under the trace,
then the Virtual
Machine
Analysis
element. The
Virtual CPU
view is present

Virtual CPU
view is opened,
the virtual
machine
analysis is
triggered and
the view gets
filled

Virtual CPU
view is closed
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1.6

21

2.2

23

Unapplicable
experiment

Populate the
view with
experiment

View guest's
threads

VM specific
states

2.3.0-TraceCompassTestCases - LTTng 2.0 - VM analysis

Open an
experiment that
is not of Virtual
Machine
Experiment type

With the VM
experiment,
open the Virtual
CPU View

Expand the

Expand the
Views element
under the trace.
There is no
Virtual Machine
Analysis.

The view is
populated with
the VM element
as the only
parent and 2
virtual guests
having 3
VCPUs each
and a collapsed
Threads entries

A list of
processes is
shown, in
numerical order
and their time

Threads entry of graph viewer

a guest

Zoom in the
VCPUs time
graph around
the "interesting"
region, where
there is more
action (around
the second half
of the trace)

part is filled

2 new states
are easily
recognizable:
WAIT_VMM
and
VCPU_PREEM
PTED

88

Manual

Manual

Manual

Manual




24

3.1

Preempted
thread states

Re-opening

Drag move time
range

2.3.0-TraceCompassTestCases - LTTng 2.0 - VM analysis

Select a region
with the
CPU_PREEMP
TED state and
scroll down the
threads entries
to around 405-
406: mpi-
imbalance
processes

Close the VM
experiment,
reopen it

Ctrl-Drag move
time graph left
and right with
middle button

We can observe
alpha'ed states
corresponding
to the cpu
preempted
states

The view is
populated again

Time range is
dragged. When

mouse button is
released, states
are updated and
new time range

is propagated to
other views.
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3.2

3.3

3.4

Zoom time
range (mouse
wheel)

Zoom time
range (mouse
drag)

Mouse vertical
scroll

2.3.0-TraceCompassTestCases - LTTng 2.0 - VM analysis

Zoom with
mouse wheel up
and down,
cursor inside
time graph while
holding the Ctl
button

Drag in time
graph scale left
and right with
left button

Scroll with
mouse wheel up
and down,
cursor outside
time graph

Time range is
zoomed in and
out, relative to
Mouse Cursor.
When mouse
wheel is
stopped for a
short time,
states are
updated and
new time range
is propagated to
other views.
Time range is
zoomed in and
out. When
mouse button is
released, states
are updated and
new time range
is propagated to
other views.
Table and time
graph scroll up
and down and
remain aligned.
Selected worker
does not
change. Vertical
scroll bar
updated.
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3.5

3.6

3.7

3.8

3.9

Vertical scroll
bar

Drag select time
range

Double-click
reset time range

Mouse hover
(empty region)

Mouse hover
(state)

2.3.0-TraceCompassTestCases - LTTng 2.0 - VM analysis

Click and drag
vertical scroll
bar

Drag select time
graph with right
button

Double-click left
button on time
scale

Hover mouse in
time graph over
empty region
Hover mouse in
time graph over
state

Table and time
graph scroll up
and down and
remain aligned.
Selected
process does
not change.

Selection
highlighted.
When mouse
button is
released, time
range is
zoomed to
selection, states
are updated and
new time range
is propagated to
other views.

Time range is
reset to full
range, states
are updated and
new time range
is propagated to
other views.

Tool tip shows
process name
only.

Tool tip shows entry
name, state name,
date, start time, end
time, duration.
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3.10

3.1

4.1

Drag mouse
selection

Shift key
selection

Keyboard
navigation in
table (process
selection)

2.3.0-TraceCompassTestCases - LTTng 2.0 - VM analysis

Drag select time
graph with left
button

Click select with
left button
(begin time),
press shift key
and click select
another time
(end time)

With focus on
table, use UP,
DOWN, HOME,
END keys

Selection highlighted.
Status bar of Eclipse
is updated with time
information: T, T1, T2
and delta, where T is
the time of the mouse
position, T1 the first
selected time, T2 the
second (dragged)
selected time and
delta the time
difference between
T2-T1 (can be
negative)

Selection highlighted.
Status bar of Eclipse
is updated with time
information: T, T1, T2
and delta, where T is
the time of the mouse
position, T1 the first
selected time, T2 the
second (dragged)
selected time and
delta the time
difference between
T2-T1 (can be
negative)

Selected entry
is changed.
Time graph
selection is
updated.
Vertical scroll
bar updated.
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4.2

4.3

4.4

5.1

5.2

Keyboard
navigation in
table (tree
expansion)

Keyboard
navigation in
time graph
(process
selection)

Keyboard
navigation in
time graph

(state selection) |

Tool bar
handling

Align views

Show Legend

2.3.0-TraceCompassTestCases - LTTng 2.0 - VM analysis

With focus on table,
in Windows use
LEFT, RIGHT keys
while expandable
element is selected

in Linux use SHIFT
LEFT, RIGHT keys
while expandable
element is selected
With focus on
time graph, use
UP, DOWN,
HOME, END
keys

With focus on
time graph, use
LEFT, RIGHT
keys

Click on the Align
View Button, with
another time graph
view, eg the Control
Flow view opened
above or under

Click Show
Legend button

For expandable
element, tree is
expanded or
collapsed. Time
graph item expansion
is updated. Vertical
scroll bar updated.
For other entries, it
does nothing.

Selected entry is
changed. Table
selection is updated.
Vertical scroll bar
updated.

Previous or next
state is
selected.
Selected time is
updated in other

views.

When it is pressed,
moving the line
between tree viewer
and time graph will
move the line of the
other view. If not
pressed, the line can
be moved without
affecting the other
views

The legend
dialog is opened
and can be
closed.
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5.3

54

5.5

5.6

5.7

Reset Time
Scale

Select
Previous/Next
Event

Select Previous/Next
Element

Zoom In/Out

Add Bookmark

2.3.0-TraceCompassTestCases - LTTng 2.0 - VM analysis

Click Reset
Time Scale
button

Click
Previous/Next
Event button

Click
Previous/Next
Element button

Click Zoom
In/Out button

Select a time, and
click on the Add
Bookmark button

Time range is
reset to full
range, states
are updated and
new time range
is propagated to
other views.

Previous or next
state is
selected.
Selected time is
updated in other
views.

Selected entry
is changed in
table and time
graph. Vertical
scroll bar
updated.

Time range is
zoomed in and
out, relative to
center of
selection or
window. States
are updated and
new time range
is propagated to
other views.

The bookmark is
added and is
displayed in the other
views as well (if
enabled)
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5.8

5.9

5.11

5.12

6.1

6.2

Next/Previous marker

Delete bookmark

Do not show markers

Show markers

Synchronization-

Time
synchronization

Window range
synchronization

2.3.0-TraceCompassTestCases - LTTng 2.0 - VM analysis

Add more
bookmarks, then click
on the next/previous
marker buttons

With next/previous
marker, when on a
bookmark, click the
delete bookmark
button

Click on the down
arrow at the extreme
right of the view, then
expand Show
markers and uncheck
the Bookmarks box

Same as above,
recheck the
Bookmarks box

Select a random
time in another
view

Select a new window
range in another view

The time graph view
navigate between the
bookmarks, States
are updated and time
selection is
propagated to other
views. When on a
bookmark, the Add
bookmark buttons
changes to Delete
bookmark

The bookmark is
deleted from all views

All remaining
bookmarks disappear
from the view, but
remain in other views
where the they are
enabled

The bookmarks come

back

Selected time
line is updated.
If selected time
is outside
current range,
time range is
updated to
include it.

Window range
is updated.

95

Manual

Manual

Manual

Manual

Manual

Manual




6.3

2.3.0-TraceCompassTestCases - LTTng 2.0 - VM analysis

In any other
view that
supports

selection range
synchronization,

Selection range select a new
synchronization range.

Selection is
highlighted. If
the left time (T1)
of selected time
range is outside
the current
range, then
window range is
updated to

include it Manual
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Section

Flame Graph

Target: Windows 7 64 bit

Step
0
1

Test Case

Download the test resources

Preparation

Open TMF Flame Graph View

Import generic trace

Import cyg-profile trace

Import cyg-profile-fast trace

Manage View

Pass
19

Fail

Action
Download this

Use menu
Window — Show
View — Tracing
— Flame Graph

Import a trace
that does not have
any call stack
information, like
a standard kernel
trace

Import the trace
in the "trace"

directory of the
downloaded zip

Import a trace in
the "trace-fast"
directory of the
downloaded zip

Verification

Verify that 'Flame
Graph View' view
is shown

Verify that
nothing is shown
in the view

Verify that the
Flame Graph
View is populated
with some
callers/callees
information.

Verify that the
Flame Graph
View is populated
with some
callers/callees
information.

2.3.0-TraceCompassTestCases - FlameGraphView

To Do
11 0
SWTBot Pass
SWTBot Pass
SWTBot Pass
SWTBot Pass

Comment

Comment


https://drive.google.com/file/d/0BxUCnNTRLr5pWUdXd0JJV3hyeEk/edit?usp=sharing

2.1

2.2

23

24

2.5

2.6

2.3.0-TraceCompassTestCases - FlameGraphView

Close view

Open view

Open Trace

Open view when trace is already
loaded

Open Experiment

Restart

Close the 'Flame
Graph' View

Use menu
Window — Show
View — Other ...
— Tracing —
Flame Graph

Flame Graph'
view is removed
from perspective

Flame Graph'
view is displayed
and re-populated

Verify that view

is populated with
Open "trace(- callers/callees
fast)" trace information
1) Close 'Flame
Graph' view
2) Open
"glxgears-cyg-
profile(-fast)"
trace located in ~ Verify that view
the git in ctf'test  is populated with
3) Open 'Flame  callers/callees
Graph' view information
Open Experiment Verify that view
with 2 or is populated with
moreFlame Graph all callers/callees
traces. information
(You can use both (separated by
traces) trace).

Verify that view
Restart Eclipse is populated with

with Flame Graph callers/callees

trace opened

from trace
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2.3.0-TraceCompassTestCases - FlameGraphView

Verify that Flame
Close traces and ~ Graph view is
experiment one  cleared after
by one from the  closing the last
2.7 Close all traces editor tab trace Manual

Open a trace
multiple Flame
Graph thread or
open experiment
with 2 or
moreFlame Graph
traces. Then
select 'Sort The view is
threads by thread sorted by thread
3.1 Thread name sorting name' name. Manual

Open a trace
multiple Flame
Graph thread or
open experiment
with 2 or
moreFlame Graph
traces. Then

select 'Sort The view is
threads by thread sorted by thread
3.2 Thead id sorting id' id. Manual

Select arandom  Selected time line
time in another  is not updating.
4.1 Time synchronization view Nothing happen. Manual
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4.2 Go to maximum

43 Go to minimum

Function name import

1. Open the 'Call
Stack' View

2. In the 'Flame
Graph' view,
right-click on a
random entry in
the graph

3. Select 'go to
maximum'

1. Open the 'Call
Stack' View

2. In the 'Flame
Graph' view,
right-click on a
random entry in
the graph

3. Select 'go to
minimum'

1. Open the 'Call
Stack' view with
the 'Flame Graph'
view and the cyg-
profile trace
opened

2. Import 'cyg-
profile-mapping.
txt' as mapping
text file

2.3.0-TraceCompassTestCases - FlameGraphView

- The 'Call Stack'
view is populated
- The call stack
view is
synchronised to
the range of the
maximum call
duration of the
'Flame Graph'
selected entry

- The 'Call Stack'
view is populated
- The call stack
view is
synchronised to
the range of the
minimum call
duration of the
'Flame Graph'
selected entry

Manual

Manual

Both 'Call Stack'
and 'Flame Graph'
views display
function name
instead of
function address.

SWTBot
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5.1

2.3.0-TraceCompassTestCases - FlameGraphView

Mouse hover (empty region)

Mouse hover (state)

Hover mouse in

time graph over Tool tip shows

empty region depth only
Tool tip shows
Total time and

Hover mouse in self times with

time graph over standard

state statistics.
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Target: Ubuntu 14.04 64

Step

0
0.1

0.2

11
12

22
23
2.4

25
2.6

3.1
3.2
33

3.4
35
3.6
3.7

4.1
4.2
4.3

4.4

4.5
4.6

Section

est Case

Prerequisites
Import traces

Download analysis
stubs

Custom
external
analysis

Add all stubs
analysis

Actions availables

Actions avaliables

Delete analysis

Run analysis
Reports

Reports node

Same name report
Delete node
Open a report

Open the same
report again

Multiple report
Result Table
Prerequisites
Hide table
Show table

Sorting

Colum Resizing
Multiple selection
Unselect selection
Bar Chart
Create

Series dialog add
Series dialog
remove

Creat chart

Selection

Multi selection

Action

any trace since we use stub for the result

https://bugs.eclipse.org/bugs/attachment.cgi?id=263946
from bug: https://bugs.eclipse.org/bugs/show_bug.cgi?id=493941

Create the following analysis ($name, $command):

analysisEmpty, analysisEmpty

ow, ow

ilarRow, analysi ow
analysisOneRow, analysisOneRow
multipleReports, multipleReports
invalidAnalysis, invalidAnalysis
errorResult, errorResult
clone, analysisOneRow

Right click on "External Analyses" node

Click the "add" action

Insert $name

Insert "fullpath/$executable” which is the full path to the stub executable.
ex:"/tmp/stub/stubAnalysis" where stubAnalysis is the stub executable
The path do NOT support ~ or relative path

Right click on a non-strikethrough custom analysis.
Right click on a strikethrough custom analysis.

Right click on the tuple (clone, invalidAnalysis)
Select the delete action for the node

Launch remaining analysis via righ-click and run action

Expand the "Reports" node under the Project Explorer

Execute the "analysisOneRow" analysis again.
Right click on the duplicate "analysis OneRow" node and click on the delete action

Right click on any report and select the "open” action

Right click again on the same report to open it
Open the "multipleReports" report.

Open the "analysisMultipleRowReport"
Click the "Toggle" button in the right corner of the result table
Click the "Toggle" button in the right corner of the result table

Sort all column by clicking on the column name. Clicking multiple time on the name should change the ordering

sorter.

Resize the column

Select multiple rows by holding ctrl and clicking on multiple unselected rows of the table Multiple selections are highlighted in the table

Deselect multiple rows by holding ctrl and clicking on multiple selected rows of the table The clicked row should not be selected anymore

Use the menu on the upper right of the result table and select "create bar chart"

Select any x and any y click add
Remove all newly created series via the delete button
Select any x and y and click add and "ok"

Click on any bar inside the chart

Ctrl+click on other unselected bar

2.3.0-TraceCompassTestCases - Lami

Verification

All new external analysis are present under the "External Analysis"
node in the Project explorer view.

All new elements do NOT have the strikethrough text style applied
EXCEPT for the tuple (invalidAnalysis, invalidAnalysis)

The run action can be clicked and in enabled text mode.
The run action CANNOT be clicked and is in disabled text mode.

The analysis does not appear in the list anymore.

analysisEmpty should return a message to the user regarding the emptiness of the report.
errorResult should return an error message to the user and display the result of the comm|
All other one have result and should result in a new table and new report node under the 1

The "Reports" node under the Project Explorer should contain 4
report:

analysisMultipleRow Report

analysisMultipleSimilarRow Report

analysisOneRow Report

multipleReports

An additional node should be present under the "Reports" node:
analysisOneRow Report #2

Note: This behaviour is subject to change in the following year but
still an action will be taken on same name report creation.

The node reports is not present anymore

A new panel should open with the result table of the analysis

A new panel should open with the result table of the analysis

Validate that a user is able to navigate between sub tab of a report

The result table is hidden

The result table is shown

Validate that the order make sense

Validate that the resize works

Note: a bar chart does NOT perform agregation of categories values

Series are added to the series list

User should be able to delete series

A bar chart should be created

Note: a bar chart does NOT perform agregation of categories values
The corresponding row should be selected in the table and the chart
should highlight the selected bar

Selections should be highlighted in the result table and the chart
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Comment

Comment

Bug https://bugs.eclipse.org/bugs/show_bug.cgi?id=508406
Proposed fix: https://git.eclipse.org/r/#/c/85973/



2.3.0-TraceCompassTestCases - Lami

The clicked bar should be removed from selection and the result
4.7 Deselection Ctrl+click on other selected bar table update with the current selections

Y axis should be in log scale mode

Note: check for zero value and negative handling since log scale do

4.8 Y axis Recreate the same graph but with the y log scale option enabled not support zero and negative

Keep the chart
4.9 open Keep the chart open

Hide the table
4.10 results Hide the table results

5 Scatter Chart
5.1 Create Use the menu on the upper right of the result table and select "create scatter chart"
A scatter chart should be created

52 Creat chart Select any x and y and click add and "ok"
53 Selection Should be the same behaviour as the bar chart Should be the same behaviour as the bar chart
5.4 Multi selection Should be the same behaviour as the bar chart Should be the same behaviour as the bar chart
55 Deselection Should be the same behaviour as the bar chart Should be the same behaviour as the bar chart
5.6 Mouse hovering Hover mouse in the graph On mouse hovering a cross should snap to the nearest point
57 Full deselection Click in the chart when no hovering cross is present All selected objects should be deselected
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2.3.0-TraceCompassTestCases - Bug Reports

Section
Bug Reports

Test Case Bug Title

[TMF] Sequence Diagram Overview feature
Sequence Diagram 5.23 not working well on recent platform versions

LTTng 2 - Memory
Analysis 3.7, 3.8, CPU
Analysis 4.10, 4.11

LTTng 2 - Memory
Analysis 4.3, CPU
Analysis 6.3,
XmlAnalysis 7.3

[TMF] Status bar is not updated when
selecting time range in XY charts

[TMF] Time range selection outside current
range should update current range in time
graph views

LTTng 2 - Memory
Analysis 4.1, CPU
Analysis 6.1

[TMF] Time selection outside current range
should update current range in xy charts

[TMF] Original experiment reappears after

Project View 6.5 rename and copy

[Ittng rcp] Opening a second trace with --open

RCP 1.4 activates the wrong editor

Sequence diagram interaction tooltip is hard to

Sequence Diagram 3.1 read on Ubuntu

Button gets disabled in print dialog of
Sequence Diagram 5.24 sequence diagram after clicking on it

[TMF] XY chart view is cleared after being
filled when restarting or opening a trace

Memory analysis 2.4/

CPU Analysis
Control view 17.9 NPE trying to destroy a session

SWTException widget is disposed trying to

Control view 17.9 import trace from Control view
Project view

Time Chart 2.3

Import to experiment will swallow exceptions
IOException in FlatArray.insert

Deleting a project with the delete key does not

Project Explorer 3.21 work

LTTng 2.0 - Memory
Analysis 3.3, 4.2, 4.3,
4.4

UST Memory Usage view causes SWT invalid
thread access when navigating in trace

# Bug Reports

14

Found Bug Report

0.1.0

0.1.0

0.1.0

0.1.0

0.1.0

0.1.0

0.1.0

0.1.0

0.1.0
1.0.0

1.0.0
1.1.0
1.1.0

2.0.0

2.3.0
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https://bugs.eclipse.org/bugs/show

bug.cqi?id=436442

https://bugs.eclipse.org/bugs/show

bug.cqi?id=436853

https://bugs.eclipse.org/bugs/show

bug.cqi?id=436855

https://bugs.eclipse.org/bugs/show

buqg.cqi?id=436861

https://bugs.eclipse.org/bugs/show

bug.cqi?id=436888

https://bugs.eclipse.org/bugs/show

bug.cqi?id=443461

https://bugs.eclipse.org/bugs/show

bug.cqi?id=455523

https://bugs.eclipse.org/bugs/show

bug.cqi?id=455546

https://bugs.eclipse.org/bugs/show

bug.cqi?id=467751

https://bugs.eclipse.org/bugs/show

bug.cqi?id=469424

https://bugs.eclipse.org/bugs/show

bug.cqi?id=469425

https://bugs.eclipse.org/bugs/show

bug.cqi?id=476475

https://bugs.eclipse.org/bugs/show

bug.cqi?id=476487

https://bugs.eclipse.org/bugs/show

bug.cqi?id=486505

https://bugs.eclipse.org/bugs/show_bug.cgi?id=513013

# Open # Fixed

13

1

Status

Open

Open

Open

Open
Open
Open
Open
Open

Open
Open

Open
Open
Open

Open

. Fixed

Enhancemer


https://bugs.eclipse.org/bugs/show_bug.cgi?id=436442
https://bugs.eclipse.org/bugs/show_bug.cgi?id=436853
https://bugs.eclipse.org/bugs/show_bug.cgi?id=436855
https://bugs.eclipse.org/bugs/show_bug.cgi?id=436861
https://bugs.eclipse.org/bugs/show_bug.cgi?id=436888
https://bugs.eclipse.org/bugs/show_bug.cgi?id=443461
https://bugs.eclipse.org/bugs/show_bug.cgi?id=455523
https://bugs.eclipse.org/bugs/show_bug.cgi?id=455546
https://bugs.eclipse.org/bugs/show_bug.cgi?id=467751
https://bugs.eclipse.org/bugs/show_bug.cgi?id=469424
https://bugs.eclipse.org/bugs/show_bug.cgi?id=469425
https://bugs.eclipse.org/bugs/show_bug.cgi?id=476475
https://bugs.eclipse.org/bugs/show_bug.cgi?id=476487
https://bugs.eclipse.org/bugs/show_bug.cgi?id=486505
https://bugs.eclipse.org/bugs/show_bug.cgi?id=513013

